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Link Tests to Requirements

In this section...
“Requirements Traceability Considerations” on page 1-2
“Establish Requirements Traceability for Testing” on page 1-3

Since requirements specify behavior in response to particular conditions, you can develop
test inputs, expected outputs, and assessments from the model requirements.

Requirements Traceability Considerations

Consider the following limitations working with requirements links in test harnesses:

• Some blocks and subsystems are recreated during test harness rebuild operations.
Requirements linking is not supported for these blocks and subsystems in a test
harness:

• Conversion subsystems between the component under test and the sources or
sinks

• Test Sequence blocks that schedule function calls
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• Blocks that drive control input signals to the component under test
• Blocks that drive Goto or From blocks that pass component under test signals
• Data Store Read and Data Store Write blocks

• If you use external requirements storage, performing the following operations
requires reestablishing requirements links to model objects inside test harnesses:

• Cut/paste or copy/paste a subsystem with a test harness
• Clone a test harness
• Move a test harness from a linked block to the library block

Establish Requirements Traceability for Testing

If you have a Simulink Test and a Simulink Requirements™ license, you can link
requirements to test harnesses, test sequences, and test cases. Before adding links,
review “Supported Requirements Document Types” (Simulink Requirements).

Requirements Traceability for Test Harnesses

When you edit requirements links to the component under test, the links immediately
synchronize between the test harness and the main model. Other changes to the
component under test, such as adding a block, synchronize when you close the test
harness. If you add a block to the component under test, close and reopen the harness to
update the main model before adding a requirement link.

To view items with requirements links, select Analysis > Requirements Traceability
> Highlight Model.

Requirements Traceability for Test Sequences

In test sequences, you can link to test steps. To create a link, first find the model item,
test case, or location in the document you want to link to. Right-click the test step, select
Requirements Traceability, and add a link or open the link editor.

To highlight or unhighlight test steps that have requirements links, toggle the

requirements links highlighting button  in the Test Sequence Editor toolstrip.
Highlighting test steps also highlights the model block diagram.
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Requirements Traceability for Test Cases

If you use many test cases with a single test harness, link to each specific test case to
distinguish which blocks and test steps apply to it. To link test steps or test harness
blocks to test cases,

1 Open the test case in the Test Manager.
2 Highlight the test case in the test browser.
3 Right-click the block or test step, and select Requirements Traceability > Link to

Current Test Case.

Requirements Traceability Example

This example demonstrates adding requirements links to a test harness and test
sequence. The model is a component of an autopilot roll control system. This example
requires Simulink Test and Simulink Requirements.

1 Open the test file, the model, and the harness.

open AutopilotTestFile.mldatx,
open_system RollAutopilotMdlRef,
sltest.harness.open('RollAutopilotMdlRef/Roll Reference',...
'RollReference_Requirement1_3')

2 In the test harness, select Analysis > Requirements Traceability > Highlight
Model.

The test harness highlights the Test Sequence block, component under test, and Test
Assessment block.
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3 Add traceability to the Discrete Derivative block.

a Right-click the Discrete Derivative block and select Requirements
Traceability > Open Link Editor.

b In the Requirements tab, click New.
c Enter the following to establish the link:

• Description: DD link
• Document type: Text file
• Document: RollAutopilotRequirements.txt
• Location: 1.3 Roll Hold Reference

d Click OK. The Discrete Derivative block highlights.
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4 To trace to the requirements document, right-click the Discrete Derivative block, and
select Requirements Traceability > DD Link. The requirements document opens
in the editor and highlights the linked text.

5 Open the Test Sequence block. Add a requirements link that links the
InitializeTest step to the test case.

a In the Test Manager, highlight Requirement 1.3 Test in the test browser.
b Right-click the InitializeTest step in the Test Sequence Editor. Select

Requirements Traceability > Link to Current Test Case.

When the requirements link is added, the Test Sequence Editor highlights the
step.
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See Also

Related Examples
• “Organize Test Sequences” on page 3-8
• “Reuse Test Assessments” on page 3-67
• “Requirements-Based Testing for Model Development”
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Test Harness

• “Test Harness and Model Relationship” on page 2-2
• “Considerations and Limitations” on page 2-7
• “Test Harness Construction for Specific Model Elements” on page 2-9
• “Select Test Harness Properties” on page 2-13
• “Test Harness Parameters and Signals” on page 2-18
• “Refine, Test, and Debug a Subsystem” on page 2-20
• “Manage Test Harnesses” on page 2-28
• “Customize Test Harnesses” on page 2-40
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Test Harness and Model Relationship
In this section...
“Test Harness Description” on page 2-2
“Harness — Model Relationship for a Model Component” on page 2-3
“Harness — Model Relationship for a Top-Level Model” on page 2-4
“Resolving Parameters” on page 2-5

Test Harness Description

A test harness is a model block diagram that you can use to develop, refine, or debug a
Simulink model or component. In the main model, you associate a harness with a model
component or the top-level model. The test harness contains a separate model workspace
and configuration set, yet it persists with the main model and can be accessed via the
model canvas.

You build the test harness model around the component under test, which links the
harness to the main model. If you edit the component under test in the harness, the main
model updates when you close the harness. You can generate a test harness for:

• A model component, such as a subsystem. The test harness isolates the component,
providing a separate simulation environment from the main model.

• A top-level model. The component under test is a Model block referencing the main
model.
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Harness — Model Relationship for a Model Component

When you associate a test harness with a model component, the harness model
workspace contains copies of parameters associated with the component.

This example shows a test harness for a component that contains a Gain block. The
harness model workspace contains a copy of the parameter g because g defines a part of
the component.

The parameter h is the gain of a gain block in the harness, outside the component under
test (CUT). h exists only in the harness model workspace.
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Harness — Model Relationship for a Top-Level Model

When you associate a harness with the top level of the main model, the harness model
workspace does not contain copies of parameters relevant to the component. The
component under test is a Model block referencing the main model, and parameters
remain in the main model workspace. In this example, the component under test
references the main model, and the variable g exists in the main model workspace. The
variable h is the value of the Gain block in the harness. It exists only in the harness
model workspace.
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Resolving Parameters

Parameters in the test harness resolve to the most local workspace. Parameters resolve
to the harness model workspace, then the system model workspace, then the base
MATLAB® workspace.
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See Also

More About
• “Componentization Guidelines” (Simulink)
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Considerations and Limitations
In this section...
“Test Harness” on page 2-7
“Test Sequence Block” on page 2-7

Consider these behaviors and limitations when working with a test harness or Test
Sequence block.

Test Harness
• You can open only one test harness at a time per main model.
• Do not comment out the component under test in the test harness. Commenting out

the component under test can cause unexpected behavior.
• If a subsystem has a test harness, you cannot expand the subsystem. Delete all test

harnesses before expanding the subsystem.
• Test harnesses are not supported for blocks underneath a Stateflow® object.
• Upgrade advisor and XML differencing are not supported for test harness models.
• A test harness with a Signal Builder block source does not support:

• Frame-based signals
• Complex signals
• Variable-dimension signals

• For a test harness with a Test Sequence block source, all inputs to the component
under test must operate with the same sample time.

Test Sequence Block
• HDL code generation is not supported for the Test Sequence block.
• The Test Sequence Editor changes the following syntax automatically:

• Duplicate test step names. For example, if step_1 exists, and you change another
step name to step_1, the step name you change automatically changes to step_2.

• Increment and decrement operations to use MATLAB as the action language, such
as a++ and a--. For example, a++ is changed to a=a+1.
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• Assignment operations to use MATLAB as the action language, such as a+=expr,
a–=expr, a*=expr, and a/=expr. For example, a+=b is changed to a=a+b.

• Evaluation operations to use MATLAB as the action language, such as a!=expr
and !a. For example, a!=b is changed to a~=b.

• The editor inserts explicit casts for literal constant assignments. For example, if y
is defined as type single, then y=1 is changed to y=single(1).
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2-8



Test Harness Construction for Specific Model Elements
A test harness consists of one or more source blocks that drive the component under test,
which drives one more sink blocks. The test harness construction process configures
signal attributes, function calls, data stores, and execution semantics. When possible, the
test harness matches signal attributes at the sources, sinks, and component interface.

Signal Conversion
Signal conversion subsystems adapt the signal interface of the source and sink blocks to
the graphical interface of the component. The graphical interface of the component
includes input signals, output signals, and action, trigger, or enable inputs. The test
harness compiles the main model to determine signal attributes: data type, dimensions,
and complexity of each signal. Signal attributes are adapted to the sources during
harness construction in one of two ways:

1 Source blocks that can generate signals with the compiled attributes are configured
to do so.

2 If a source block cannot generate signals with the compiled attributes, signal
attribute blocks in the signal conversion subsystem adapt the output of the source
blocks. Signal attribute blocks include Reshape, Rate Transition and Data Type
Conversion blocks.

Function-call Drivers
A Test Sequence block source generates function-call inputs to the component, even if
you select a different source during harness creation. To override this behavior and
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connect function-call inputs to your selected source type, create the test harness with the
sltest.harness.create function, and set ’DriveFcnCallWithTestSequence' to
false. For example:

sltest.harness.create('Model/FcnCallSubsystem','Source','From File',...
’DriveFcnCallWithTestSequence',false)

Physical Signal Connections

Components that accept or output physical signals are supported during harness
construction, but sources and sinks are not generated. You can add physical modeling
blocks to the test harness after construction.

Bus Signals

Test harnesses configuration for bus inputs and outputs depends on the bus connection
ability of the source or sink blocks:

1 Sources and sinks that can accept a bus signal are directly connected to the
component without modification.

2 If a source cannot output a bus signal, bus signals are automatically constructed
from individual bus elements in the signal conversion subsystem.

3 If a sink cannot accept a bus signal, bus signal elements are expanded from the bus
signal in the signal conversion subsystem.

Non-Graphical Connections

In addition to the graphical interface of a component, Simulink supports several non-
graphical connections. Test harness construction also supports non-graphical
connections:

• Goto–From connections – Goto-From block pairs that cross the component boundary
are considered component inputs or outputs.

• A From block without a corresponding Goto block in the component is considered a
component input signal. The test harness includes a source block with a
corresponding Goto block.
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• A Goto block without the corresponding From block in the component is considered
a component output signal. The test harness includes a sink block with a
corresponding From block.

• Data store memory – Data Store Read and Data Store Write blocks require a complete
data store definition in the test harness:

• If a Data Store Read or Data Store Write block lacks a corresponding Data Store
Memory block in the component, the test harness adds a Data Store Memory
block.

• For a component containing only Data Store Read blocks, the test harness adds a
source block driving a Data Store Write block.

• For a component containing only Data Store Write blocks, the test harness adds a
Data Store Read block driving a sink block.

• Simulink Function Definitions – If the component calls a Simulink Function that is
not defined in the component, the test harness adds a stub Simulink Function block
matching the function call signature.

Export Function Models
Test harnesses contain a function-call scheduler for components that use the export
function modeling style. The scheduler is a Test Sequence block. Use the Test Sequence
block as a starting point to complete the scheduler in the test harness.

The scheduler Test Sequence block includes a step containing:

• A catalog of globally scoped Simulink Function blocks in the component.
• A list of function-call triggers accessible at the component interface.

Harness construction honors periodic function-call triggers with appropriate decimation
of the function-call event in the Test Sequence block.

Test harnesses include Initialize, Terminate and Reset steps for models that
contain Initialize, Terminate and Reset event subsystems. You can include
Initialize, Terminate and Reset steps for other export-function models using the
'ScheduleInitTermReset' property of sltest.harness.create.

Execution Semantics
The execution behavior of a component depends on factors such as computed sample
times, solver settings, model configuration, and parameter settings. Execution behavior
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also depends on run-time events such as function-call triggers and asynchronous events.
To handle these execution semantics, test harness construction:

1 Copies configuration parameter settings from the main model into the test harness.
2 Copies required parameter definitions from the main model workspace into the test

harness model workspace.
3 Copies data dictionary settings from the main model into the test harness.
4 Honors a limited subset of sample time settings using explicit source block

specifications and Rate Transition blocks.

Other factors, such as additional blocks in the harness and solver heuristics, can cause
test harness execution to differ from the main model. The graphical and compiled
interface of the component takes precedence over other execution semantics.

Sample Time Specification

Simulink supports an array of sample times, including types that are derived during
model compilation. Test harness construction supports periodic discrete, continuous, and
fixed-in-minor-step sample times with these considerations:

• Source blocks that support the desired rate are configured to do so, and the signal
conversion subsystem contains a Signal Specification block with the rate specification.

• Test harness construction does not configure source blocks that cannot support the
desired rate.

• If the desired rate is periodic discrete or fixed-in-minor-step, the test harness
contains a Rate Transition block in the signal conversion subsystem.

• If the desired rate is continuous, the execution semantics are determined by the
solver. The signal conversion subsystem does not contain a Rate Transition block.

Other sample time specifications are ignored during test harness construction. In
those cases, solver settings determine execution behavior.

See Also
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Select Test Harness Properties

In this section...
“Create a Test Harness” on page 2-13
“Considerations for Selecting Test Harness Properties” on page 2-13
“Harness Name” on page 2-14
“Save Test Harnesses Externally” on page 2-14
“Choosing Sources and Sinks” on page 2-14
“Add Separate Assessment Block” on page 2-15
“Open Harness After Creation” on page 2-15
“Create without compiling the model” on page 2-15
“Post-create callback method” on page 2-15
“Rebuild harness on open” on page 2-15
“Update Configuration Parameters and Model Workspace data on rebuild” on page 2-
16
“Post-rebuild callback method” on page 2-16
“Synchronization Mode” on page 2-16
“Initialize/Terminate/Reset Behavior” on page 2-16
“Verification Modes” on page 2-17
“Change Harness Properties” on page 2-17

Create a Test Harness

To create a test harness for the top-level model, select Analysis > Test Harness >
Create for Model. To create a test harness for a subsystem, select the subsystem and
select Analysis > Test Harness > Create for <subsystem name>. Set test harness
properties using the Create Test Harness dialog box.

Considerations for Selecting Test Harness Properties

Before selecting test harness properties, consider the following:

• What data source you want to use for your test case input
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• How you want to view or store test output
• Whether you want to copy parameters and workspaces from the main model to the

harness
• Whether you plan to edit the component under test
• How you want to synchronize changes between the test harness and model

Except for sources and sinks, you can change harness properties later using the harness
properties dialog box. To change sources and sinks after harness creation, manually
remove the blocks from the test harness and replace them with new sources and sinks.

Harness Name

Test harnesses must use valid MATLAB filenames.

Save Test Harnesses Externally

This option controls how the model stores test harnesses. A model stores all its test
harnesses either internally or externally. If a model already has test harnesses, this item
states the harness storage type as Harnesses saved <internally|externally>.

• When cleared, the model saves test harnesses as part of the model SLX file.
• When selected, the model saves test harnesses in separate SLX files to the current

working folder, and adds a harness information XML file to the model folder. The
harness information file must remain in the same folder as the model.

See “Manage Test Harnesses” on page 2-28.

Choosing Sources and Sinks

In the Create Test Harness dialog box, under Sources and Sinks, select the source and
sink from the respective menus. The menus provide common sources and sinks, and you
can also use custom sources and sinks from the Simulink Sources or Sinks library. Select
Custom source or sink, and enter the path to the custom block, such as:

simulink/Sources/Sine Wave

simulink/Sinks/Terminator

Custom sources and sinks build the test harness with one block per port.
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Add Separate Assessment Block

Select Add separate assessment block to include a separate Test Assessment block in
the test harness.

A Test Assessment block is a separate Test Sequence block configured with properties
commonly used for verifying the component under test. If you use a Test Sequence block
source, you can also author assessments directly in the Test Sequence block. See “Reuse
Test Assessments” on page 3-67.

Open Harness After Creation

Clear Open Harness After Creation to create the test harness without opening it. This
can be useful creating multiple test harnesses in succession.

Create without compiling the model

When you select this property, the main model does not compile when generating the test
harness. The test harness does not contain conversion subsystems, configuration
parameters, or model workspace data for the component under test. The test harness can
require additional modification for it to compile, such as adding signal conversion blocks.

Post-create callback method

You can customize your test harness using a post-create callback, which is a function
that runs after the harness is created. For example, your callback can set up signal
logging, add custom blocks, or change the harness simulation times. For more
information, see “Customize Test Harnesses” on page 2-40.

Rebuild harness on open

When you select this property, the test harness rebuilds every time you open it. For
details on the rebuild process, see “Synchronize Changes Between Test Harness and
Model” on page 2-54.
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Update Configuration Parameters and Model Workspace data on
rebuild

When you select this property, configuration parameters and model workspace data
update when you rebuild the harness. For details on the rebuild process, see
“Synchronize Changes Between Test Harness and Model” on page 2-54.

Post-rebuild callback method

You can customize your test harness using a post-rebuild callback, which is a function
that runs after the harness is rebuilt. For example, your callback can set up signal
logging, add custom blocks, or change the harness simulation times. For more
information, see “Customize Test Harnesses” on page 2-40.

Synchronization Mode

Synchronization mode controls when changes to the component under test are synced to
the main model, and when changes to the harness owner are synced into a test harness.

• On harness open — The component in the test harness is updated when the harness
opens. Synchronizing on harness open is useful if you update the design in the main
model.

• On harness close — The component in the main model is updated when the harness
closes. Synchronizing on harness close is useful if you make design changes in the test
harness. Avoid synchronizing on harness close if you want to prevent inadvertent
changes to the component in the main model.

• During push — Synchronization occurs manually, by selecting Analysis > Test
Harness > Push Component and Parameters to Main Model.

• During rebuild — Synchronization occurs manually, by selecting Analysis > Test
Harness > Rebuild Harness from Main Model.

Initialize/Terminate/Reset Behavior
Generate scheduler for Initialize, Reset, and Terminate tasks

Testing a model with initialize, terminate, or reset behavior can require calling Initialize,
Terminate, or Reset subsystems to set the desired state. You can use the Test Sequence
block to schedule function calls using the send() command and function-call outputs.

2 Test Harness

2-16



You can automatically create a Test Sequence block configured to schedule function calls
to Initialize, Terminate, or Reset inputs. When you create a test harness, select
Generate scheduler for Initialize, Reset, and Terminate tasks in the Advanced
Properties tab of the create harness dialog box. After test harness creation, the Test
Sequence block contains template function calls for use in your test sequence.

Verification Modes

The test harness verification mode determines the type of block generated in the test
harness.

• Normal: A Simulink block diagram.
• Software-in-the-Loop (SIL): The component under test references generated

code, operating as software-in-the-loop. Requires Embedded Coder®.
• Processor-in-the-Loop (PIL): The component under test references generated

code for a specific processor instruction set, operating as processor-in-the-loop.
Requires Embedded Coder.

Note Keep the SIL or PIL code in the test harness synchronized with the latest
component design. If you select SIL or PIL verification mode without selecting Rebuild
harness on open, your SIL or PIL block code might not reflect recent updates to the
main model design. Regenerate code for the SIL or PIL block in the test harness by
selecting Analysis > Test Harness > Rebuild Harness from Main Model.

Change Harness Properties

Click the badge  in the test harness block diagram and click Test harness
properties to open the harness properties dialog box.

See Also
Test Sequence | “Synchronize Changes Between Test Harness and Model” on page 2-54
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Test Harness Parameters and Signals
In this section...
“Test Harness Generation Without Compilation” on page 2-18
“Signal Conversion Subsystem” on page 2-18

Test Harness Generation Without Compilation
You can generate a test harness without compiling the main model. For example, this
option can be useful if you are prototyping a design that cannot yet compile. If the main
model is not compiled when generating a test harness:

• Parameters are not copied to the test harness workspace.
• The main model configuration is not copied to the test harness.
• The test harness does not contain conversion subsystems.

To execute these processes, you can rebuild the harness when you are ready to compile
the main model. For more information, see “Synchronize Changes Between Test Harness
and Model” on page 2-54.

Signal Conversion Subsystem

A signal conversion subsystem

• Contains signal specification blocks to check signal properties to and from the
component under test. These properties include data type, sample time, bus
properties, dimension, and complexity.
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• Contains blocks that simplify signal routing in the test harness block diagram, such
as Goto and Function-Call Split blocks.

Signal types must match the signal specification for test harnesses to compile. If you get
a compile error related to the signal conversion subsystem, check the signal properties
and consider modifying the test harness design. For example:

• Add conversion blocks to your test harness outside the conversion subsystem.
• Edit the conversion subsystem. The subsystem is locked by default. To unlock it,

right-click the subsystem, select Block Parameters, then set Read/Write
permissions to ReadWrite.

Note When you rebuild the test harness, the signal conversion subsystems are
rebuilt. If you modify a conversion subsystem, disable automatic test harness rebuild
to avoid losing your modifications when you open the test harness. See “Select Test
Harness Properties” on page 2-13.
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Refine, Test, and Debug a Subsystem
In this section...
“Model and Requirements” on page 2-20
“Create a Harness for the Controller” on page 2-22
“Inspect and Refine the Controller” on page 2-24
“Add Test Inputs and Test the Controller” on page 2-24
“Debug the Controller” on page 2-25

Test harnesses provide a development and testing environment that leaves the main
model design intact. You can test a functional unit of your model in isolation without
altering the main model. This example demonstrates refining and testing a controller
subsystem using a test harness. The main model is a controller-plant model of an air
conditioning/heat pump unit. The controller must operate according to several simple
requirements.

Model and Requirements
1 Access the model. Enter

cd(fullfile(docroot,'toolbox','sltest','examples'))
2 Copy this model file and supporting files to a writable location on the MATLAB path:

sltestHeatpumpExample.slx
sltestHeatpumpBusPostLoadFcn.mat
PumpDirection.m

3 Open the model.

open_system('sltestHeatpumpExample')
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In the example model:

• The controller accepts the room temperature and the set temperature inputs.
• The controller output is a bus with signals controlling the fan, heat pump, and the

direction of the heat pump (heat or cool).
• The plant accepts the control bus. The heat pump and the fan signals are Boolean,

and the heat pump direction is specified by +1 for cooling and -1 for heating.
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The test covers four temperature conditions. Each condition corresponds to one operating
state with fan, pump, and pump direction signal outputs.

Temperature condition System
state

Fan
command

Pump
command

Pump
direction

|Troom - Tset| < DeltaT_fan idle 0 0 0
DeltaT_fan <= |Troom - Tset| <
DeltaT_pump

fan only 1 0 0

|Troom - Tset| >= DeltaT_pump
and Tset < Troom

cooling 1 1 -1

|Troom - Tset| >= DeltaT_pump
and Tset > Troom

heating 1 1 1

Create a Harness for the Controller
1 Right-click the Controller subsystem and select Test Harness > Create for

‘Controller’.
2 Set the harness properties:

In the Basic Properties tab:

• Name: devel_harness_1
• Clear Save test harness externally
• Sources and Sinks: None and Scope
• Clear Add separate assessment block
• Select Open harness after creation
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3 Click OK to create the test harness.
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Inspect and Refine the Controller

1 In the test harness, double-click Controller to open the subsystem.
2 Connect the chart to the Inport blocks.

3 In the test harness, click the Save button to save the test harness and model.

Add Test Inputs and Test the Controller

1 Navigate to the top level of devel_harness_1.
2 Create a test input for the harness with a constant Tset and a time-varying Troom.

Connect a Constant block to the Tset input and set the value to 75.
3 Add a Sine Wave block to the harness model to simulate a temperature signal.

Connect the Sine Wave block to the conversion subsystem input Troom_in.
4 Double-click the Sine Wave block and set the parameters:

• Amplitude: 15
• Bias: 75
• Frequency: 2*pi/3600
• Phase (rad): 0
• Sample time: 1
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• Select Interpret vector parameters as 1–D.
5 Connect Inport blocks to the Data Store Write inputs.

6 In the Configuration Parameters dialog box, in the Data Import/Export pane,
select Input and enter u. u is an existing structure in the MATLAB base workspace.

7 In the Solver pane, set Stop time to 3600.
8 Open the scope in the test harness and change the layout to show three plots.
9 Click Run to simulate.

Debug the Controller
1 Observe the controller output. fan_cmd is 1 during the IDLE condition where |

Troom - Tset| < DeltaT_fan.

This is a bug. fan_cmd should equal 0 at IDLE. The fan_cmd control output must be
changed for IDLE.
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2 In the harness model, open the Controller subsystem.
3 Open controller_chart.
4 In the IDLE state, fan_cmd is set to return 1. Change fan_cmd to return 0. IDLE is

now:

IDLE
entry:
fan_cmd = 0;
 pump_cmd = 0;
 pump_dir = 0;

5 Simulate the harness model again and observe the outputs.
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6 fan_cmd now meets the requirement to equal 0 at IDLE.

See Also

Related Examples
• “Test a Model Component Using Signal Functions” on page 3-57
• “Test Downshift Points of a Transmission Controller” on page 3-60
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Manage Test Harnesses

In this section...
“Internal and External Test Harnesses” on page 2-28
“Manage External Test Harnesses” on page 2-28
“Convert Between Internal and External Test Harnesses” on page 2-30
“Preview and Open a Test Harness” on page 2-31
“Find Test Cases Associated with a Test Harness” on page 2-32
“Export Test Harnesses to Separate Models” on page 2-32
“Clone and Export a Test Harness to a Separate Model” on page 2-33
“Delete Test Harnesses Programmatically” on page 2-35
“Move and Clone Test Harnesses” on page 2-37

Internal and External Test Harnesses

You can save test harnesses internally as part of your model SLX file, or externally in
separate SLX files. A model stores all test harnesses either internally or externally; it is
not possible to use both types of harness storage in one model. You select internal or
external test harness storage when you create the first test harness. If your model
already has test harnesses, you can convert between the harness storage types.

If you store your model in a change control system, consider using external test
harnesses. External test harnesses enable you to create or change a harness without
changing the model file. If you plan to share your model often, consider using internal
test harnesses to simplify file management. Creating or changing an internal test
harness changes your model SLX file. Both internal and external test harnesses offer the
same synchronization, push, rebuild, and badge interface functionality.

See “Select Test Harness Properties” on page 2-13.

Manage External Test Harnesses

Harnesses stored externally use a separate SLX file for each harness, and a
<modelName>_harnessInfo.xml file containing metadata linking the model and the
harnesses. Changing test harnesses can change the harnessInfo.xml file.
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Follow these guidelines for external test harnesses:

Warning Do not delete the harnessInfo.xml file. Deleting the harnessInfo.xml file
terminates the relationship between the model and harnesses, which cannot be
regenerated from the model.

• Keep the harnessInfo.xml file in the same folder as the main model. If the
harnessInfo.xml file and the model are in separate folders, the main model opens
but does not present the test harnesses.

• Directories containing test harness SLX files must be on the MATLAB path.
• If you convert internal test harnesses to external test harnesses, the new SLX files

save to the current working folder.
• If you convert external test harnesses to internal test harnesses, the external SLX

files can be anywhere on the MATLAB path.
• If your model uses external test harnesses, only create a copy of your model using

File > Save As from the model menu. Using File > Save As copies external test
harnesses to the destination folder of the new model and keeps the harness
information current.

Copying the model file on disk will not copy external harnesses associated with the
model.

• Only change or delete test harnesses using the Simulink UI or commands:

• To delete test harnesses, use the thumbnail UI or the sltest.harness.delete
command.

• To rename test harnesses, use the harness properties UI or the
sltest.harness.set command.

• To make a copy of an externally saved test harness, use the
sltest.harness.clone command or save the test harness to a new name using
File > Save As.

Deleting or renaming harness files outside of Simulink causes an inaccurate
harnessInfo.xml file and problems loading test harnesses.
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Convert Between Internal and External Test Harnesses

You can change how your model stores test harnesses at different phases of your model
lifecycle. For example:

• Develop your model using internal test harnesses so that you can more easily share
the model for review. When you complete your design and place the model under
change control, convert to external harnesses.

• Use the change-controlled model as the starting point for a new design. Test the
existing model with external harnesses to avoid modifying it. Then, create a copy of
the existing model. Convert to internal harnesses for the new development phase.

To change the test harness storage to external (or internal):

1 Navigate to the top of the main model.
2 Select Analysis > Test Harness > Convert To External (Internal) Harnesses.
3 A dialog box provides information on the conversion procedure and the affected test

harnesses. Click Yes to continue.

The harnesses are converted.
4 The conversion to external test harnesses creates an SLX file for each test harness

and a harness information XML file <modelName>_harnessInfo.xml.
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Inversely, conversion to internal test harnesses moves the test harness SLX files and
the harnessInfo.xml file.

Preview and Open a Test Harness

When a model component has a test harness, a badge appears in the lower right of the
block. Click the badge to preview test harnesses, and click a thumbnail image to open the
harness.

When a model block diagram has a test harness, click the pullout icon in the model
canvas to preview the test harnesses. To open the harness, click a thumbnail.
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Find Test Cases Associated with a Test Harness

To list open test cases that refer to the test harness, click the badge  in the test
harness canvas. You can click a test case name and navigate to the test case in the Test
Manager.

Export Test Harnesses to Separate Models

You can export test harnesses to separate models, which is useful for archiving test
harnesses or sharing a test harness design without sharing the model.

• To export an individual test harness:
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1 From the test harness menu, select Analysis > Test Harness > Detach and
Export Harness.

2 A dialog box confirms the harness export. Click OK.
3 Enter a file name for the separate model.

The harness converts to a separate model. Converting removes the harness from
the main model and breaks the relationship to the main model.

• To export all harnesses in a model:

1 Navigate to the top level of the test harness.
2 Select no blocks.
3 From the model menu, select Analysis > Test Harness > Detach and Export

Harnesses.
4 A dialog box confirms the harness export. Click OK.

The harnesses convert to separate models. Converting removes the harnesses
from the main model and breaks the relationships to the main model.

See sltest.harness.export.

Clone and Export a Test Harness to a Separate Model

This example demonstrates cloning an existing test harness and exporting the cloned
harness to a separate model. This can be useful if you want to create a copy of a test
harness as a separate model, but leave the test harness associated with the model
component.

High-level Workflow

1 If you don't know the exact properties of the test harness you want to clone, get them
using sltest.harness.find. You need the harness owner ID and the harness name.

2 Clone the test harness using sltest.harness.clone.
3 Export the test harness to a separate model using sltest.harness.export. Note that

there is no association between the exported model and the original model. The
exported model stands alone.
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Open the Model and Save a Local Copy

model = 'sltestTestSequenceExample';
open_system(model)

Save the local copy in a writable location on the MATLAB path.

Get the Properties of the Source Test Harness

properties = sltest.harness.find([model '/shift_controller'])

properties = 

  struct with fields:

                  model: 'sltestTestSequenceExample'
                   name: 'controller_harness'
            description: ''
                   type: 'Testing'
            ownerHandle: 14.0024
          ownerFullPath: 'sltestTestSequenceExample/shift_controller'
              ownerType: 'Simulink.SubSystem'
                 isOpen: 0
            canBeOpened: 1
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               lockMode: 0
       verificationMode: 0
         saveExternally: 0
          rebuildOnOpen: 0
       rebuildModelData: 0
    postRebuildCallback: ''
              graphical: 0
                origSrc: 'Test Sequence'
               origSink: 'Test Assessment'
    synchronizationMode: 0

Clone the Test Harness

Clone the test harness using sltest.harness.clone, the ownerFullPath and the name
fields of the harness properties structure.

sltest.harness.clone(properties.ownerFullPath,properties.name,'ControllerHarness2')

Save the Model

Before exporting the harness, save changes to the model.

save_system(model)

Export the Test Harness to a Separate Model

Export the test harness using sltest.harness.export. The exported model name is
ControllerTestModel.

sltest.harness.export([model '/shift_controller'],'ControllerHarness2',...
    'Name','ControllerTestModel')

clear('model')
clear('properties')
close_system('sltestTestSequenceExample',0)

Delete Test Harnesses Programmatically

This example shows how to delete test harnesses programmatically. Deleting with % the
programmatic interface can be useful when your model has multiple test harnesses at
different hierarchy levels. This example demonstrates creating four test harnesses, then
deleting them.
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1. Open the model

open_system('sltestCar');

2. Create two harnesses for the transmission subsystem, and two harnesses for the
transmission ratio subsystem.

sltest.harness.create('sltestCar/transmission');
sltest.harness.create('sltestCar/transmission');
sltest.harness.create('sltestCar/transmission/transmission ratio');
sltest.harness.create('sltestCar/transmission/transmission ratio');

3. Find the harnesses in the model.

test_harness_list = sltest.harness.find('sltestCar')

test_harness_list = 

  1x5 struct array with fields:

    model
    name
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    description
    type
    ownerHandle
    ownerFullPath
    ownerType
    isOpen
    canBeOpened
    lockMode
    verificationMode
    saveExternally
    rebuildOnOpen
    rebuildModelData
    postRebuildCallback
    graphical
    origSrc
    origSink
    synchronizationMode

4. Delete the harnesses.

for k = 1:length(test_harness_list)
     sltest.harness.delete(test_harness_list(k).ownerFullPath,...
     test_harness_list(k).name)
end

close_system('sltestCar',0);

Move and Clone Test Harnesses

Simulink Test gives you the ability to move/clone test harnesses from a source owner to a
destination owner without having to compile the model. You can move or clone:

• Subsystem harnesses across subsystems. The destination subsystem could also be in a
different model.

• Harnesses for library components across libraries.

To move or clone harnesses, right-click the Simulink canvas and select Test Harness >
Manage Test Harnesses. The Manage Test Harness dialog box opens and lists the test
harnesses associated with the subsystem/block specified in Filter by harness owner.
Click Actions to access the Move and Clone options.
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Select the destination path and name your test harness.

See Also
Functions
sltest.harness.clone | sltest.harness.create | sltest.harness.delete |
sltest.harness.export | sltest.harness.find | sltest.harness.load |
sltest.harness.move | sltest.harness.open
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Customize Test Harnesses
In this section...
“Callback Function Definition and Harness Information” on page 2-41
“How to Display Harness Information struct Contents” on page 2-43
“Customize a Test Harness to Create Mixed Source Types” on page 2-43
“Test Harness Callback Example” on page 2-45

You can customize a test harness by using a function that runs after creating or
rebuilding the test harness. In the function, script the commands to customize your test
harness. For example, the function can

• Connect custom source or sink blocks.
• Add a plant subsystem for closed-loop testing.
• Change the configuration set.
• Enable signal logging.
• Change the simulation stop time.

The test harness customization function runs as a test harness post-create callback or
post-rebuild callback. To customize a test harness using a callback function:

1 Create the callback function.
2 In the function, use the Simulink programmatic interface to script the commands to

customize the test harness. For more information, see the functions listed in “Model
Editing Fundamentals” (Simulink).

3 Specify the function as the post-create or post-rebuild callback:

• For a new test harness,

• If you are using the UI, enter the function name in the Post-create callback
method or Post-rebuild callback method in the Advanced Properties of
the harness creation dialog box.

• If you are using sltest.harness.create, specify the function as the
PostCreateCallback or PostRebuildCallback value.

• For an existing test harness,

• If you are using the UI, enter the function name in Post-rebuild callback
method in the harness properties dialog box.
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• If you are using sltest.harness.set, specify the function as the
PostRebuildCallback value.

For more information on test harness properties, see “Select Test Harness
Properties” on page 2-13.

Callback Function Definition and Harness Information
The callback function declaration is
function myfun(x)

where myfun is the function name and myfun accepts input x. x is a struct of information
about the test harness automatically created when the test harness uses the callback.
You can choose the function and argument names.

For example, define a harness callback function harnessCustomization.m:
function harnessCustomization(harnessInfo)

% Script commands here to customize your test harness.

end

In this example, harnessInfo is the struct name and harnessCustomization is the
function name. When the create or rebuild operation calls harnessCustomization,
harnessInfo is populated with information about the test harness, including handles to
the test harness model, main model, and blocks in the test harness.

For example, using harnessCustomization as a callback for the following test harness:
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populates harnessInfo with handles to three sources, one sink, the main model,
harness model, harness owner, component under test, and conversion subsystems:

harnessInfo = 

  struct with fields:

                    MainModel: 2.0001
                 HarnessModel: 1.1290e+03
                        Owner: 17.0001
                   HarnessCUT: 201.0110
              DataStoreMemory: []
                DataStoreRead: []
               DataStoreWrite: []
                         Goto: []
                         From: []
                      GotoTag: []
       SimulinkFunctionCaller: []
         SimulinkFunctionStub: []
                      Sources: [1.1530e+03 1.1540e+03 1.1550e+03]
                        Sinks: 1.1630e+03
              AssessmentBlock: []
     InputConversionSubsystem: 1.1360e+03
    OutputConversionSubsystem: 1.1560e+03
                   CanvasArea: [215 140 770 260]

Use the struct fields to customize the test harness. For example:

• To add a Constant block named ConstInput to the test harness, get the name of the
test harness model, then use the add_block function.

harnessName = get_param(harnessInfo.HarnessModel,'Name');
block = add_block('simulink/Sources/Constant',[harnessName '/ConstInput']);

• To get the port handles for the component under test, get the 'PortHandles'
parameter for harnessInfo.HarnessCUT.

CUTPorts = get_param(harnessInfo.HarnessCUT,'PortHandles');
• To get the simulation stop time for the test harness, get the 'StopTime' parameter

for harnessInfo.HarnessModel.

st = get_param(harnessInfo.HarnessModel,'StopTime');
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• To set a 16 second simulation stop time for the test harness, set the 'StopTime'
parameter for harnessInfo.HarnessModel.

set_param(harnessInfo.HarnessModel,'StopTime','16');

How to Display Harness Information struct Contents

To list the harness information for your test harness:

1 In the callback function, add the line

disp(harnessInfo)
2 Create or rebuild a test harness using the callback function.
3 When you create or rebuild the test harness, the harness information structure

contents are displayed on the command line.

Customize a Test Harness to Create Mixed Source Types

This example harness callback function connects a Constant block to the third
component input of this example test harness.

The function follows the procedure:

1 Get the harness model name.
2 Add a Constant block.
3 Get the port handles for the Constant block.
4 Get the port handles for the input conversion subsystem.
5 Get the handles for lines connected to the input conversion subsystem.
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6 Delete the existing Inport block.
7 Delete the remaining line.
8 Connect a new line from the Constant block to input 3 of the input conversion

subsystem.

function harnessCustomization(harnessInfo)

% Get harness model name:
harnessName = get_param(harnessInfo.HarnessModel,'Name');

% Add Constant block:
constBlock = add_block('simulink/Sources/Constant',[harnessName '/ConstInput']);

% Get handles for relevant ports and lines:
constPorts = get_param(constBlock,'PortHandles');
icsPorts = get_param(harnessInfo.InputConversionSubsystem,'PortHandles');
icsLineHandles = get_param(harnessInfo.InputConversionSubsystem,'LineHandles');

% Delete the existing Inport block and the adjacent line:
delete_block(harnessInfo.Sources(3));
delete_line(icsLineHandles.Inport(3));

% Connect the Constant block to the input conversion subsystem:
add_line(harnessInfo.HarnessModel,constPorts.Outport,icsPorts.Inport(3),'autorouting','on');

end
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Test Harness Callback Example

This example shows how to use a post-create callback to customize a test harness. The
callback changes one harness source from an Inport block to Constant block and enables
signal logging in the test harness.

The Model

Create a test harness for the Roll Reference subsystem.

open_system('RollAutopilotMdlRef')

The Callback Function

The function harnessSourceLogCustomization changes the third source block, and
enables signal logging on the inputs and outputs to the component under test.
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type(fullfile(matlabroot,'examples','simulinktest','main',...
    'harnessSourceLogCustomization.m'));

function harnessSourceLogCustomization(harnessInfo)

%% Customize Test Harness Sources and Logging

%% Add a Constant Source Block to One Input

% Get harness model name:
    harnessName = get_param(harnessInfo.HarnessModel,'Name');
% Add Constant block:
    constBlock = add_block('simulink/Sources/Constant',[harnessName '/ConstInput']);
% Get handles for relevant ports and lines:
    constPorts = get_param(constBlock,'PortHandles');
    icsPorts = get_param(harnessInfo.InputConversionSubsystem,'PortHandles');
    icsLineHandles = get_param(harnessInfo.InputConversionSubsystem,'LineHandles');

% Delete the existing Inport block and the adjacent line:
    delete_block(harnessInfo.Sources(3));
    delete_line(icsLineHandles.Inport(3));

% Connect the Constant block to the input conversion subsystem:
    add_line(harnessInfo.HarnessModel,constPorts.Outport,icsPorts.Inport(3),'autorouting','on');

%% Enable signal logging for all inputs and outputs to the component under test

% Get port handles for the component under test
    CUTPorts = get_param(harnessInfo.HarnessCUT,'PortHandles');
        % Get CUT port handles
    ICSPorts = get_param(harnessInfo.InputConversionSubsystem,'PortHandles');
        % Get ICS port handles

% Enable signal logging on the outputs of the CUT
    numOut = length(CUTPorts.Outport);
    for j = 1:numOut
        set_param(CUTPorts.Outport(j),'DataLogging','on');
    end
    
% Enable signal logging on the outputs of the input conversion subsystem,
% which are the same as the inputs to the CUT. Logging must be done on
% output handles only.
    numIn = length(ICSPorts.Outport);
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    for k = 1:numIn
        set_param(ICSPorts.Outport(k),'DataLogging','on');
    end
    
end

Test Harness Information for the Callback

The callback function uses an argument. The argument is a struct listing test harness
information. The information includes handles to blocks in the test harness, including:

• Component under test
• Input subsystems
• Sources and sinks
• The harness owner in the main model

For example, if you define your callback function as harnessBlockAdd(harnessInfo),
harnessInfo.Sources will list the handles to the test harness source blocks.

Create the Test Harness and Customize it with the Callback

1. Copy the harness callback function to the temporary working directory.

cbFile = which('harnessSourceLogCustomization.m');
copyfile(cbFile,tempdir);
cd(tempdir);

2. In the RollAutopilotMdlRef model, right-click the Roll Reference subsystem
and select Test Harness > Create for Roll Reference.

3. In the harness creation dialog box, for Post-create callback method, enter
harnessSourceLogCustomization.

4. Click OK to create the test harness. The harness shows the signal logging and
simulation stop time specified in the callback function.

You can also use the sltest.harness.create function to create the test harness,
specifying the callback function with the 'PostCreateCallback' name-value pair.

sltest.harness.create('RollAutopilotMdlRef/Roll Reference',...
    'Name','LoggingHarness','PostCreateCallback','harnessSourceLogCustomization');

sltest.harness.open('RollAutopilotMdlRef/Roll Reference','LoggingHarness');
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close_system('RollAutopilotMdlRef',0);

See Also
sltest.harness.create | sltest.harness.set

Related Examples
• “Select Test Harness Properties” on page 2-13
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Create Test Harnesses from Standalone Models

In this section...
“Test Harness Import Workflow” on page 2-49
“Harness Import Considerations” on page 2-50
“Import a Standalone Model as a Simulink® Test™ Harness” on page 2-51

For testing, a common model architecture uses a Signal Builder block to pass test inputs
to a copy of a subsystem or a Model block referencing your main model. This architecture
is an example of a standalone model designed for testing. Standalone test models include
models created by Simulink Coverage™, Simulink Design Verifier™, or custom models.

You can simplify testing by importing standalone models to your main model as Simulink
Test test harnesses. Importing standalone models as test harnesses enables
synchronization and management features, allowing you to

• Iterate on your design, using model – harness synchronization to update your design.
• Manage test harnesses, using the UI and programmatic interface.
• Establish clear ownership of a test harness by a model, subsystem, or library being

tested.

Test Harness Import Workflow

Before importing a model as a test harness, determine:

• The model or component to associate the test harness with, which can be a top-level
model, a subsystem, or a linked block.

• The path to the model to be imported.
• In the model to be imported, the component that is tested. In the new test harness,

this component links to the owner component in the main model. You can synchronize
design changes when the test harness is open or closed.

For example, this model uses a Signal Builder block to pass test inputs to the
Controller subsystem, and a subsystem to verify the Controller output. The
Controller subsystem is tested.
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Harness Import Considerations
You cannot create a test harness by importing

• Libraries
• Models that have existing test harnesses
• Models with unsaved changes. Save open models before importing.

When importing, consider the block type in the main model and the standalone model:

• For a user-defined function block in the main model (such as an S-Function block), the
tested component in the standalone model must be the same block type.

• For a top-level main model, the tested component in the standalone model can be a
Model block or a subsystem.
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• For a subsystem in the main model, the tested component in the standalone model
can be a subsystem, Model block, or user-defined function block.

• For a Model block in the main model, the tested component in the standalone model
can be a Model block or a subsystem.

Import a Standalone Model as a Simulink® Test™ Harness
This example shows how to import a standalone test model to create a test harness in
Simulink Test.

The Main Model and the Harness Model

The main model sltestBasicCruiseControl is a simple cruise control system, with
root import and output blocks.

The standalone test model contains a Signal Builder block driving a copy of the
Controller subsystem, with a subsystem verifying that the throttle output goes to 0 if
the brake is applied for three consecutive time steps.
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Create a Test Harness from the Standalone Model

1. In the main model, right click the Controller subsystem and select Test Harness >
Import for 'Controller'.

2. Set the following harness properties:

• Name: VerificationSubsystemHarness
• Clear Save test harness externally
• Simulink model to import: Click Browse and select

sltestCruiseControlHarnessModel.
• Component under Test in imported model: Controller
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Click OK.

A test harness is created from the standalone model, owned by the Controller
subsystem in the main model Click the badge to preview the test harness.

See Also
sltest.harness.import
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Synchronize Changes Between Test Harness and Model
In this section...
“Set Synchronization for a New Test Harness” on page 2-54
“Change Synchronization of an Existing Test Harness” on page 2-55
“Synchronize Configuration Set and Model Workspace Data” on page 2-55
“Check for Unsynchronized Component Differences” on page 2-56
“Rebuild a Test Harness” on page 2-56
“Push Changes from Test Harness to Model” on page 2-57
“Check Component and Push Parameter to Main Model” on page 2-57

A test harness provides an isolated environment to test design changes. You can
synchronize changes from the test harness to the main model, or from the main model to
the test harness. Synchronization includes these model elements:

• The component under test
• Block parameters
• Optionally, the model or test harness configuration set.
• Optionally, the model workspace parameters

You do not need to synchronize base workspace data because it is available to both test
harness and main model.

Set Synchronization for a New Test Harness
When creating a test harness, you specify when changes in the test harness are
synchronized with the main model. Synchronization can occur automatically or
manually. If you plan to try out different component designs in the test harness, use
manual synchronization to avoid overwriting the component in the main model.
Depending on the type of component under test in your harness, you can select from
several synchronization options, which are combinations of the following actions:

• On harness open — The component in the test harness is updated when the harness
opens. Synchronizing on harness open is useful if you update the design in the main
model.

• On harness close — The component in the main model is updated when the harness
closes. Synchronizing on harness close is useful if you make design changes in the test
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harness. Avoid synchronizing on harness close if you want to prevent inadvertent
changes to the component in the main model.

• During push — Synchronization occurs manually, by selecting Analysis > Test
Harness > Push Component and Parameters to Main Model.

• During rebuild — Synchronization occurs manually, by selecting Analysis > Test
Harness > Rebuild Harness from Main Model.

Programmatically, set the SynchronizationMode property with
sltest.harness.create.

Note If you create a test harness in SIL or PIL mode for a Model block, the block mode in
the test harness is changed to SIL or PIL, respectively. This mode is not updated to the
main model when you close the test harness.

Maintain SIL or PIL Block Fidelity If you use a software-in-the-loop (SIL) or processor-in-
the-loop (PIL) block in the test harness, consider setting the test harness to rebuild every
time it opens. Regularly rebuilding the test harness ensures that the generated code
referenced by the SIL/PIL block reflects the main model.

Change Synchronization of an Existing Test Harness
To change a test harness synchronization mode:

1 Close the test harness.
2 In the main model, click the harness badge on the block or the Simulink canvas.
3 In the test harness thumbnail preview, click the Harness operations icon and

select Properties.
4 Change the Synchronization Mode in the properties dialog box.

Programmatically, set the SynchronizationMode property with
sltest.harness.set.

Synchronize Configuration Set and Model Workspace Data
To synchronize the configuration set and workspace parameters bewteen the test harness
and main model, select Update Configuration Parameters and Model Workspace
data on rebuild in the harness creation or harness properties dialog box.
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Check for Unsynchronized Component Differences

If your test harness does not automaticfally synchronize changes, you can check for
unsynchronized component differences between the test harness and main model.
Checking for unsynchronized differences can be useful if:

• You are making tentative design changes in the test harness and want to check that
the main model component is not overwritten.

• You have made design changes to the main model and want to check which test
harnesses must be rebuilt.

From the test harness window, select Analysis > Test Harness > Check to check for
differences. If the component differs, you can push changes from the test harness to the
main model, or rebuild the test harness from the main model. Also see the
sltest.harness.check function.

Consider these conditions when checking for unsynchronized differences:

• sltest.harness.check only includes the block diagram, block parameters, and
mask parameters in the comparison between the test harness and main model. Port
options, compiled attributes, hidden parameters, and model reference data logging
parameters are not included in the comparison.

• If the component contains a Simscape™ Solver Configuration block, the check result
always shows that the component differs between the test harness and main model.
The Solver Configuration block is affected by Simscape blocks outside the component,
and therefore always differs between the test harness and main model.

Rebuild a Test Harness

Rebuild a test harness to reflect the latest state of the main model. In the test harness,
select Analysis > Test Harness > Rebuild Harness from Main Model. In addition to
updating the component under test and block parameters, this operation rebuilds
harness conversion subsystems. If the test harness does not have conversion subsystems,
rebuilding adds them.

Rebuilding can disconnect signal lines. For example, if signal names changed in the main
model, signal lines in the test harness can be disconnected. If lines are disconnected,
reconnect signal lines to the component under test or conversion subsystems.
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For more information, see “Select Test Harness Properties” on page 2-13 and
sltest.harness.rebuild.

Push Changes from Test Harness to Model
After changing your system in the test harness, you can push changes to the main model.
In the test harness, select Analysis > Test Harness > Push Component and
Parameters to Main Model. This process overwrites the component in the main model.

Check Component and Push Parameter to Main Model
This example shows a basic workflow of updating a parameter in a test harness, checking
the synchronization between the test harness and main model, and pushing the
parameter change from the test harness to the main model.

This example also includes programmatic steps.

Open the model sltestCar. The model includes a transmission shift controller
algorithm and simplified powertrain and vehicle dynamics.
open_system('sltestCar');
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Update the Mask Parameter in the Test Harness

1. Open the test harness. Click the badge on the shift_logic chart and select the
ShiftLogic_InportHarness test harness. The test harness is set to synchronize only
when you push to or rebuild from the main model.

sltest.harness.open('sltestCar/shift_logic','ShiftLogic_InportHarness');

2. Double-click the shift_logic subsystem. For Delay before gear change (tick),
enter 4. Click OK.

shiftLogicMask = Simulink.Mask.get('ShiftLogic_InportHarness/shift_logic');
maskParamValue = shiftLogicMask.Parameters.Value;
shiftLogicMask.Parameters.Value = '4';   % Set the new parameter value

Check Synchronization between Test Harness and Main Model

On the command line, run the sltest.harness.check function.

[comparison,details] = sltest.harness.check('sltestCar/shift_logic',...
    'ShiftLogic_InportHarness');

The results show that the component under test is different in the test harness due to the
updated mask parameter.

comparison

comparison =

  logical

   0
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details

details = 

  struct with fields:

     overall: 0
    contents: 1
      reason: 'The contents of harnessed component and the contents of the component in the main model are same, but they differ in terms of block or mask parameters.'

Update the Parameter to the Main Model

1. In the test harness, select Analysis > Test Harness > Push Component and
Parameters to Main Model.

2. In the main model, double-click the shift_logic subsystem. The parameter value is
updated.

sltest.harness.push('sltestCar/shift_logic','ShiftLogic_InportHarness')

Re-check Synchronization between Test Harness and Main Model

On the command line, update the main model and test harness. Then, run the
sltest.harness.check function.

set_param('sltestCar','SimulationCommand','update');
set_param('ShiftLogic_InportHarness','SimulationCommand','update');

[comparison,details] = sltest.harness.check('sltestCar/shift_logic',...
    'ShiftLogic_InportHarness');

The results show that the component under test is the same between the test harness
and the main model.

comparison

comparison =

  logical

   1
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details

details = 

  struct with fields:

     overall: 1
    contents: 1
      reason: 'The checksum of the harnessed component and the component in the main model are same.'

close_system('sltestCar',0);

See Also
sltest.harness.check | sltest.harness.push | sltest.harness.rebuild

Related Examples
• “SIL Verification for a Subsystem” on page 4-2
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Test Library Blocks

In this section...
“Library Testing Workflow” on page 2-61
“Library and Linked Subsystem Test Harness” on page 2-62
“Edit Library Block from a Test Harness” on page 2-63

You can use a library subsystem to help facilitate component reuse. Design and test
workflows can require testing of a reusable component source and each instance of the
component. For libraries, you can set up tests for the library subsystem during your
design. Once the library subsystem meets your requirements, you can create linked
blocks in larger models and test the subsystem instances.

Library Testing Workflow

Library testing broadly divides between testing the source library subsystem, and testing
each instance of the library subsystem. Testing the library subsystem checks the design
in isolation, while testing each instance checks the component in the context of the larger
system. Test harnesses can move from the source to the instance and the instance to the
source.

This procedure outlines an example workflow for testing library subsystems and linked
subsystems.

1 Create a test case and a test harness for the library subsystem. Use this test case to
perform requirements-based tests.

2 Test the library subsystem. If it fails your requirements, edit the model and run the
test case again.

3 Lock the library after the subsystem meets the requirements.
4 In your model, create a linked subsystem and retain the library test harnesses.
5 Compare the output of the linked instance to that of the library block using an

equivalence test case.
6 Create additional test cases and test harnesses for the linked instance.
7 Promote a test harness from the linked subsystem to the library if you want to

include the test harness with future linked subsystems.
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Library and Linked Subsystem Test Harness

A test harness for a library subsystem has specific properties, compared to test harnesses
for a subsystem in a model.

• Libraries do not compile, so a test harness for a library subsystem does not contain
compiled attributes.

• A test harness for a library subsystem does not generate conversion subsystems for
the block inputs and outputs.

• A library subsystem test harness does not use push or rebuild operations, because
libraries do not use configuration parameters.

When you create a linked subsystem from a library subsystem, test harnesses copy to the
linked instance. If you do not need the test harnesses, you can delete them. For
instructions on deleting all test harnesses from a model, see “Manage Test Harnesses” on
page 2-28.

When you create a test harness for a linked subsystem, the harness associates with the
linked subsystem, not the library subsystem. You can move a test harness from a linked
subsystem to the library subsystem. This linked subsystem has three test harnesses. To
move the Requirements_Tests1 test harness,

1 On the linked subsystem, click the harness badge.
2 Click the Harness Operations  icon on the test harness you want to promote.
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3 Select Move to Library.
4 A dialog box informs you that moving the harness removes it from the linked

subsystem.
5 After confirmation, the harness appears on the library subsystem.

Edit Library Block from a Test Harness

You can apply an iterative design and test workflow to libraries by testing a library block
in a test harness and updating the component under test. Changes to the component
under test synchronize to the library when you close the test harness.

If you have a library block whose design is complete, set your test harnesses to prevent
changes to the component under test. You can set this property when you create the test
harness or after harness creation. See “Select Test Harness Properties” on page 2-13.
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See Also

Related Examples
• “Testing a Library and a Linked Block”
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Test Sequences and Assessments

• “Introduction to Test Sequences” on page 3-2
• “Organize Test Sequences” on page 3-8
• “Test Sequence Editor” on page 3-11
• “Test Sequence Action and Transition Operations” on page 3-17
• “Generate Function-Based Test Signals” on page 3-28
• “Assess Simulation Using Logical Statements” on page 3-32
• “Programmatically Create a Test Sequence” on page 3-39
• “Syntax for Test Sequences and Assessments” on page 3-45
• “Debug a Test Sequence” on page 3-54
• “Test a Model Component Using Signal Functions” on page 3-57
• “Test Downshift Points of a Transmission Controller” on page 3-60
• “Reuse Test Assessments” on page 3-67
• “View Graphical Results From Model Verification Library” on page 3-72
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Introduction to Test Sequences
In this section...
“Structure of a Test Sequence” on page 3-2
“Test Sequence Hierarchy” on page 3-2
“Step Transitions” on page 3-3
“Create a Basic Test Sequence” on page 3-3

You can use the Test Sequence block to specify test steps, actions, and transitions. With
timeseries inputs, you supply time-defined test vectors. However, the test sequences you
create can react to signal and temporal conditions. You can also use them to assess
simulation.

Structure of a Test Sequence

A test sequence consists of test steps arranged in a hierarchy. You can use transitions to
define the test sequence progression within a hierarchy level.

A test step contains actions and transitions you define using MATLAB as the action
language. Actions execute at the beginning of the step. You use actions to define
commands for each test step, such as setting signal levels, verifying logical conditions, or
setting variables. You use test step transitions to define conditions that determine when
the test sequence exits the current step and enters another step.

A standard transition occurs on a condition that you specify. Once the step exits, the next
step that you specify executes.

Test Sequence Hierarchy

Arrange the test sequence hierarchy using parent steps and substeps. Substeps can
activate only if the parent step is active. A group of steps in the same hierarchy level
shares a common transition type. When you create a test step, the step becomes a
transition option for other steps in the same group.
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Step Transitions

In a test sequence, the top hierarchy level uses a standard transition. Test sequence
execution begins with the top step in the group, and proceeds according to the transition
conditions and next steps.

You can change lower-level groups to switch between steps based on signal conditions
defined in the step. This switching condition is called a When decomposition. In this case,
the parent step evaluates, and then the substeps execute based on their associated
conditions. The conditions determine the order in which the substeps execute. For
example, the first substep in the table does not necessarily execute first. If multiple steps
in a When decomposition group have conditions that are true, the highest step with the
true condition is active.

Create a Basic Test Sequence

In this example, you create a simple test sequence for a transmission shift logic
controller.

1 Open the model. At the command line, enter

sltestTestSequenceExample
2 Right-click the shift_controller subsystem and select Test Harness > Create

for ‘shift_controller’.
3 In the Create Test Harness dialog box, under Sources and Sinks, change Inport

to Test Sequence.

The schematic displays the closed-loop configuration between the Test Sequence
block and the component under test.
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4 Click OK. The test harness for the shift_controller subsystem opens. Double-
click the Test Sequence block.

The Test Sequence Editor opens and displays action and transition tips. Click the X
to close the tips. The first line in a Step cell defines the step name.

5 Create the test sequence.

a Rename the first step Accelerate and add the step actions:

speed = 10*ramp(et);
throttle = 100;

b Add a second step Stop and add the step actions:
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throttle = 0;
speed = 0;

c Right-click Accelerate and select Add sub-step. Create a total of four
substeps for Accelerate.

These steps check the component under test during the test sequence.
d Add a constant to the block. In the Symbols pane, hover over Constant and

click Add. Enter Limit for the constant name.
e Hover over Limit and click Edit. In the Initial value field, enter 2. Click OK.
f In the Transition column, enter the transition condition for Accelerate. This

condition uses the duration operator and transitions to the next step when the
system is in fourth gear for 2 seconds.

duration(gear == 4) >= Limit

In the Next Step column, select Stop.
g Change the Accelerate group to a When decomposition sequence. Right-click

Accelerate and select When decomposition.
h Enter the names and actions for the substeps.

Check1st when gear == 1
verify(speed < 45)

Check2nd when gear == 2
verify(speed < 75)

Check3rd when gear == 3
verify(speed < 105)

Else

The fourth step Else takes no action. Else handles conditions that make no
other when statement valid.
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6 Add a scope to the harness and connect the speed, throttle, and gear signals to
the scope.

7 Set the model simulation time to 15 seconds and simulate the test harness.
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See Also
“Test Sequence Editor” on page 3-11 | “Syntax for Test Sequences and Assessments” on
page 3-45 | Test Sequence

Related Examples
• “Programmatically Create a Test Sequence” on page 3-39
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Organize Test Sequences
Compared to using timeseries data, using the Test Sequence block to define your test
inputs has these advantages:

• You can organize test scenarios in test step groups, and use hierarchy levels to isolate
test scenario execution.

• You can isolate model functionality by separating signal commands into distinct test
steps.

• Steps can execute in response to the model, using logical conditions.
• You can author assessments for specific test conditions.
• You can concisely express signal patterns, such as waveforms, using output

commands.

Before creating test steps, consider the test sequence organization. Clear organization
helps communicate the test sequence intent and structure.

Consider the case of verifying a simple subsystem. The subsystem consists of a switch
controlled by the Engage signal.

The goal of the test is to complete a simple verification of the switch function. The test
does not cover all objectives for full verification, but covers a simple design check. Check
that the output equals Input 1 when the control is engaged, and Input 2 when the
control is not engaged. You organize a test sequence into an initialization step and two
test scenarios. Each scenario sets Input 1 and Input 2, then sets Engage, then
assesses the switch output:

1 Initialize the signals
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2 Scenario 1

a Set the signal levels
b Engage the control
c Assess the result

3 Scenario 2

a Set the signal levels
b Engage the control
c Assess the result

In the test sequence editor, the step hierarchy follows the hierarchy of the scenario
outline:
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Note To execute test steps sequentially without using a logical transition condition, use
the condition true. true moves the sequence to the next step after the current step.
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Test Sequence Editor

Input, Output, and Data Management

Manage inputs, outputs, and data objects using the Symbols sidebar of the Test

Sequence Editor. Click the symbols sidebar button  on the toolbar to show or hide the
sidebar. To add a symbol, mouse over the symbol type and click Add. To edit or delete a
data symbol, mouse over the data symbol and click Edit or Delete.

If you add a symbol to the test sequence block, you can access that symbol from test steps
at any hierarchy level. For information on using messages, see “Test Sequence Action
and Transition Operations” on page 3-17.

Symbol Type Description Procedure for Adding
Input Inputs can be data or

messages.
Click Add in the sidebar
and enter the input name.

Output Outputs can be data,
messages, or function calls.

Click Add in the sidebar
and enter the output name.
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Symbol Type Description Procedure for Adding
Local Local data entries are

available inside the test
sequence block in which
they are defined.

Add a local variable in the
sidebar and initialize the
local variable in the first
test step.

Constant Constants are read-only
data entries available inside
the test sequence block in
which they are defined.

Add a constant in the
sidebar. Click Edit and
enter the constant value in
the dialog box, in the
Initial Value field.

Parameter Parameters are data
available inside and outside
the Test Sequence block.

Using the Model Explorer,
add a parameter in the
workspace of the model
containing the Test
Sequence block. Then add
the parameter name to the
Parameter symbols.

Data Store Memory Data Store Memory entries
are available inside and
outside the Test Sequence
block.

Using the Model Explorer,
add a Simulink.signal entry
in the workspace of the
model containing the Test
Sequence block.
Alternatively, add a Data
Store Memory block to the
model. Then add the data
store memory name to the
Data Store Memory
symbols.

Add and Delete Test Steps

To add a test step, right-click a step in the editor. Select Add step before or Add step
after. Select Add sub-step to create a test step in a lower hierarchy level.

To delete a test step, right-click the step. Select Delete step. If the sequence contains
only one test step, you cannot delete it. You can delete the contents by selecting Erase
last step content.
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Copy Test Steps

You can cut or copy test steps, and paste them before or after another step. You can also
paste them in a hierarchy below another step. Right-click the test step and select Cut
step or Copy step. To paste, right-click another test step and select Paste step > Paste
before step or Paste step > Paste after step. To paste in a lower hierarchy, select
Paste step > Paste sub-step.

You can also use Ctrl+X, Ctrl+C, and Ctrl+V shortcuts.

Reorder Test Steps and Transitions

You can reorder test steps from the editor. Hover over the icon to the left of the step
name. Click and drag the icon to reorder the test step. Test steps can be reordered within
the same hierarchy level. Sub-steps are also moved with the test step.

You can reorder step transitions within the same test step. Hover over the transition
number. Click and drag the number to reorder the transition. The corresponding next
step is maintained.

Change Test Step Hierarchy

Change a test step's hierarchy level by indenting or outdenting the test step. Right-click
the test step, and select Indent step to move it to a lower level, or Outdent step to
move it to a higher level.

• Movign to a lower hierarchy level (indenting) requires a preceding step at the same
hierarchy level. You cannot indent the first test step in a sequence or the first step in
a hierarchy group.
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• Only the last step in a hierarchy group can be moved to a higher level (outdented).

Test Step Transition Behavior

Standard Transition

In a standard transition, the default step is the first step listed in the sequence. The
sequence progresses according to the transition conditions and next steps. To create a
sequence using standard transitions:

• Add new steps to the sequence.
• Define outputs and assessments in the Step cell. For example, this code sets on_off

to false and verifies that the FanOn signal is true.

on_off = false;
verify(FanOn == true);

• For each step that requires a transition, hover over the Transition cell and click Add
transition. Define the step exit conditions in the transition. For example, this code
transitions to another step after the current step has been active for 20 seconds.

after(20,sec)
• Choose the next test step in the Next Step cell.
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When Decomposition Transition

In a When decomposition sequence, steps activate based on a signal condition defined
on the same line as the test step name, preceded by the when operator. For example, a
step named OverSpeed2 activates when the signal gear is 2:

OverSpeed2 when gear == 2

A When decomposition requires a parent step. To change to a When decomposition
sequence, right-click the parent step and select When decomposition. The parent step
displays the When decomposition icon . Add substeps to define the when conditions.

At each time step, the when statements evaluate from top to bottom, and the first step
with a valid statement executes. The final step in a When decomposition cannot include a
when condition. The final step handles situations in the simulation which do not match
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another when condition in the sequence. Conceptually, this is analogous to including an
Else condition in an if-then-else construct.

See Also
Test Sequence | Test Assessment | “Syntax for Test Sequences and Assessments” on
page 3-45

Related Examples
• “Programmatically Create a Test Sequence” on page 3-39
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Test Sequence Action and Transition Operations
In this section...
“Transition Between Steps Using Temporal or Signal Conditions” on page 3-17
“Link a Test Assessment to an Active Test Sequence Step” on page 3-18
“Temporal Operators” on page 3-19
“Transition Operators” on page 3-21
“Use Messages in Test Sequences” on page 3-22

Transition Between Steps Using Temporal or Signal Conditions
The Test Sequence block uses MATLAB as the action language. You can transition
between test steps by evaluating the component under test. You can use conditional logic,
temporal operators, and event operators.

Consider a simple test sequence that outputs a sine wave at three frequencies. The test
sequence transitions between steps:

• From Initialize to Sine when Switch changes
• From Sine to Sine8 when Switch changes from the value 1
• From Sine8 to Sine16 when Switch changes to the value 13.344
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Link a Test Assessment to an Active Test Sequence Step

If you use a separate Test Assessment block, you can link test assessments to the active
test step in a Test Sequence block. You link the two blocks with data monitoring the
active step:

1 Open the Model Explorer by selecting View > Model Explorer > Model Explorer.
2 Select the Test Sequence block in the Model Hierarchy.
3 In the properties, select Create data to monitor the active step.

This creates a new enumerated data output. Enter a name for the enumeration.

4 Create a data input for the Test Assessment block.

a Open the Test Assessment block.
b In the Symbols sidebar, next to Input, click the Add data icon. Name the

input.
5 In the test harness, connect the Test Sequence block step output to the Test

Assessment block step input.
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6 In the test assessments, use the enumeration in actions and transitions.

For example, this Test Assessment block verifies that when the test step down_4_3
is active, gear ~= 2.

Temporal Operators

To create an expression that evaluates the simulation time, use temporal operators.
Variables used in signal conditions must be inputs, parameters, or constants in the Test
Sequence block.
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Operator Syntax Description Example
et et(TimeUnits) The elapsed time of the

test step in TimeUnits.
Omitting TimeUnits
returns the value in
seconds.

The elapsed time of the test
sequence step in milliseconds:

et(msec)

t t(TimeUnits) The elapsed time of the
simulation in
TimeUnits. Omitting
TimeUnits returns the
value in seconds.

The elapsed time of the
simulation in microseconds:

t(usec)

after after(n,
TimeUnits)

Returns true if n
specified units of time
in TimeUnits elapse
since the beginning of
the current test step.

After 4 seconds:

after(4,sec)

before before(n,
TimeUnits)

Returns true until n
specified units of time
in TimeUnits elapse,
beginning with the
current test step.

Before 4 seconds:

before(4,sec)

duration ElapsedTime =
duration
(Condition,
TimeUnits)

Returns ElapsedTime
in TimeUnits for
which Condition has
been true.
ElapsedTime is reset
when the test step is re-
entered or when
Condition is no longer
true.

Return true if the time in
milliseconds since Phi > 1 is
greater than 550:

duration(Phi>1,msec) > 550

Syntax in the table uses these arguments:

TimeUnits

The units of time

Value: sec|msec|usec
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Examples:

msec

Condition

Logical expression triggering the operator. Variables used in duration can be inputs,
parameters, or constants, with at most one local or output data.

Examples:

u > 0
x <= 1.56

Transition Operators

To create expressions that evaluate signal events, use transition operators. Common
transition operators include:
Operator Syntax Description Example
hasChanged hasChanged(u) Returns true if u

changes in value
since the beginning
of the test step,
otherwise returns
false.

u must be an input
data symbol.

Transition when h
changes:

hasChanged(h)

hasChangedFrom hasChangedFrom(u,A) Returns true if u
changes from the
value A, otherwise
returns false.

u must be an input
data symbol.

Transition when h
changes from 1:

hasChangedFrom(h,1)
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Operator Syntax Description Example
hasChangedTo hasChangedTo(u,B) Returns true if u

changes to the value
B, otherwise returns
false.

u must be an input
data symbol.

Transition when h
changes to 0:

hasChangedTo(h,0)

Use Messages in Test Sequences
Messages carry data between Test Sequence blocks and other blocks such as Stateflow®
charts. Messages can be used to model asynchronous events. A message is queued until
you evaluate it, which removes it from the queue. You can use messages and message
data inside a test sequence. The message remains valid until you forward it, or the time
step ends. For more information, see Messages in the Stateflow® documentation.

Receive Messages and Access Message Data

If your Test Sequence block has a message input, you can use queued messages in test
sequence actions or transitions. Use the receive command before accessing message
data or forwarding a message.

To create a message input, hover over Input in the Symbols sidebar, click the add
message icon, and enter the message name.

receive(M) determines whether a message is present in the input queue M, and
removes the message from the queue. receive(M) returns true if a message is in the
queue, and false if not. Once the message is received, you can access the message data
using the dot notation, M.data, or forward the message. The message is valid until it is
forwarded or the current time step ends.

The order of message removal depends on the queue type. Set the queue type using the
message properties dialog box. In the Symbols sidebar, click the edit icon next to the
message input, and select the Queue type. For more information see Queuing Behavior
of Stateflow Messages.
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Send Messages

To send a message, create a message output and use the send command. To create a
message output, hover over Output in the Symbols sidebar, click the add message icon,
and enter the message name.

You can assign data to the message using the dot notation M.data, where M is the
message output of the Test Sequence block. send(M) sends the message.

Forward Messages

You can forward a message from an input message queue to an output port. To forward a
message:

1 Receive the message from the input queue using receive.
2 Forward the message using the command forward(M,M_out) where M is the

message input queue and M_out is the message output.

Compare Test Sequences Using Data and Messages

This example demonstrates message inputs and outputs, sending, and receiving a
message. The model compares two pairs of test sequences. Each pair is comprised of a
sending and receiving test sequence block. The first pair sends and receives data, and the
second sends and receives a message.

Set the following path and model name variables.

filePath = fullfile(matlabroot,'examples','simulinktest');
model = 'sltest_testsequence_data_vs_message';

Open the model.

open_system(fullfile(filePath,model))

 Test Sequence Action and Transition Operations

3-23



Test Sequences Using Data

The DataSender block assigns a value to a data output M.

The DataReceiver block waits 3 seconds, then transitions to step S2. Step S2 transitions
to step S3 using a condition comparing M to the expected value, and does the same for S3
to S4.
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Test Sequences Using Messages

The MessageSender block assigns a value to the message data of a message output
M_out, then sends the message to the MessageReceiver block.

The MessageReceiver block waits 3 seconds, then transitions to step S2. Step S2's
transition evaluates the queue M with receive(M), removing the message from the
queue. receive(M) returns true since the message is present. M.data == 3.5
compares the message data to the expected value. The statement is true, and the
sequence transitions to step S3.
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When step S3's transition condition evaluates, no messages are present in the queue.
Therefore, S3 does not transition to S4.

Run the test and observe the output comparing the different behaviors of the test
sequence pairs.

open_system([model '/Scope'])
sim(model)
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See Also
“Syntax for Test Sequences and Assessments” on page 3-45 | Test Sequence

Related Examples
• “Generate Function-Based Test Signals” on page 3-28
• “Assess Simulation Using Logical Statements” on page 3-32

 See Also
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Generate Function-Based Test Signals
The Test Sequence block uses MATLAB as the action language. You can use functions to
generate signal outputs to the component under test.

1 Define an output data symbol in the Data Symbols pane.
2 Use the output name with a signal generation function in the test step action.

In this test sequence, the step Sine outputs a sine wave with a period of 10 seconds,
specified by the argument et*2*pi/10. The step Random outputs a random number in
the interval -0.5 to 0.5.

You can also define a function in a script on the MATLAB path, and call the function in
the Test Sequence block. In this test sequence, the ReducedSine step reduces
SignalOut using the function Attenuate.

function[y] = Attenuate(x)
y = 0.65*x;
end
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Output Functions

Generate test signals using output functions. Some output functions use the temporal
operator et, which is the elapsed time of the test step in seconds.

Note Function outputs are not constrained to provide a defined pattern. Scaling,
rounding, and other approximations of argument values can affect function outputs.

Common output functions include:
Function Syntax Description Example
square square(x) Represents a square wave

output with a period of 1
and range –1 to 1.

Within the interval 0 <=
x < 1, square(x)
returns the value 1 for 0
<= x < 0.5and –1 for
0.5 <= x < 1.

Output a square wave
with a period of 10 sec:

square(et/10)
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Function Syntax Description Example
sawtooth sawtooth(x) Represents a sawtooth

wave output with a period
of 1 and range –1 to 1.

Within the interval 0 <=
x < 1, sawtooth(x)
increases.

Output a sawtooth wave
with a period of 10 sec:

sawtooth(et/10)

triangle triangle(x) Represents a triangle
wave output with a period
of 1 and range –1 to 1.

Within the interval 0 <=
x < 0.5, triangle(x)
increases.

Output a triangle wave
with a period of 10 sec:

triangle(et/10)

ramp ramp(x) Represents a ramp signal
of slope 1, returning the
value of the ramp at time
x.

ramp(et) effectively
returns the elapsed time
of the test step.

Ramp one unit for every 5
seconds of test step
elapsed time:

ramp(et/5)

heaviside heaviside(x) Represents a heaviside
step signal, returning 0
for x < 0 and 1 for x >=
0.

Output a heaviside signal
after 5 seconds:

heaviside(et-5)

latch latch(x) Saves the value of x at the
first time latch(x)
evaluates in a test step,
and subsequently returns
the saved value of x.
Resets the saved value of
x when the step exits.
Reevaluates latch(x)
when the step is next
active.

Latch b to the value of
torque:

b = latch(torque)

3 Test Sequences and Assessments

3-30



Function Syntax Description Example
sin sin(x) Returns the sine of x,

where x is in radians.
A sine wave with a period
of 10 sec:

sin(et*2*pi/10)
cos cos(x) Returns the cosine of x,

where x is in radians.
A cosine wave with a
period of 10 sec:

cos(et*2*pi/10)
rand rand Uniformly distributed

pseudorandom number.
Generate values from the
uniform distribution on
the interval [a, b].

a + (b-a)*rand
randn randn Normally distributed

pseudorandom number.
Generate values from a
normal distribution with
mean 1 and standard
deviation 2.

1 + 2*randn(100,1)
exp exp(x) Returns the natural

exponential function, e
x .

An exponential signal
progressing at one tenth
of the test step elapsed
time:

exp(et/10)

See Also
“Syntax for Test Sequences and Assessments” on page 3-45 | Test Sequence

Related Examples
• “Test Sequence Action and Transition Operations” on page 3-17
• “Assess Simulation Using Logical Statements” on page 3-32
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Assess Simulation Using Logical Statements
In this section...
“verify” on page 3-32
“assert” on page 3-34
“Assessment Statements” on page 3-35
“Logical Operators” on page 3-36
“Relational Operators” on page 3-37

A verify statement sends results to the Test Manager and allows simulation to run
even when the logical condition fails. An assert statement stops simulation. You can
use verify and assert statements to assess your model.

verify

The verify keyword assesses a logical expression inside a Test Sequence or Test
Assessment block. Optional arguments label results in the Test Manager and diagnostic
viewer. The keyword and arguments constitute a verify statement. Use the logical
expression to define a verification constraint on the system under test.

For each simulation step, the verify statement reports whether the logical expression
fails, passes, or is untested. For an overall test, a verify statement returns an overall
fail, pass, or untested result. Any failure at a simulation step results in an overall
failure. If the verify statement does not fail, and at any simulation time step the
statement passes, the overall result passes. Otherwise, the statement is not tested, and
the overall result is untested. Review results in the Verify Statements section of the
Test Manager.

Syntax

A verify statement uses syntax of these forms

verify(expression)
verify(expression,errorMessage)
verify(expression,identifier,errorMessage)

The simplest verify statement uses only a logical expression. To make results easier to
interpret, use additional arguments to define an error message and a statement
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identifier. Error messages display in the diagnostic viewer. You can use error messages
to display key values at the time the statement fails.

For example, if verify evaluates an expression containing variables x and y, you can
display the values of x and y using the string:

'x and y values are %d, %d',x,y

An identifier labels the verify results in the Test Manager. The identifier uses a string
of the form 'prefix:suffix'. prefix and suffix are alphanumeric strings. For
example:

'SimulinkTest:x_equals_y'

Continuous-Time Considerations

verify is not supported in Test Sequence blocks that use continuous-time updating.
Test Sequence block data can depend on factors such as the solver step time. Continuous-
time updating can cause differences in when block data and verify statements update,
which can lead to unexpected verify statement results.

If your model uses continuous time and you use verify statements in a Test Sequence
or Test Assessment block, consider explicitly setting a discrete block sample time.

Example

In this comparison of two values, the parent step uses verify statements to assess two
local variables x and y during the simulation. The substeps set two conditions.

• verify(x >= y) passes overall because it is true for the entire test sequence.
• verify(x == y) and verify(x ~= y) fail because they fail in step_1_2 and

step_1_1, respectively.
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The Test Manager displays the results.

assert

assert evaluates a logical argument, but unlike verify, assert stops simulation.
assert does not return fail, pass, or untested results. Failures appear as errors.
Consider using assert statements to avoid executing a bad test. For example, if a
component under test outputs two signals h and k, and the test requires h and k
initialized to 0, use assert to stop the test if the signals do not initialize.
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To make results easier to interpret, add an optional message that evaluates when the
assertion fails. This example demonstrates an assert statement that returns a message
if the logical condition fails.

Code is not generated for assert statements in the Test Sequence block.

Assessment Statements

To verify simulation, stop simulation, and return verification results, use assessment
statements.
Keyword Statement Syntax Description Example
verify verify(expression)

verify(expression,
errorMessage)

verify(expression,
identifier,
errorMessage)

Assesses a logical
expression.
Optional
arguments label
results in the Test
Manager and
diagnostic viewer.

verify(x > y,...
'SimulinkTest:greaterThan',...
'x and y values are %d, %d',x,y)

assert assert(expression)

assert(expression,
errorMessage)

Evaluates a
logical expression.
Failure stops
simulation and
returns an error.
Optional
arguments return
an error message.

assert(h == 0 && k == 0,...
'h and k must initialize to 0')

Syntax in the table uses these arguments:
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expression

Logical statement assessed

Examples:

h > 0 && k == 0

identifier

Label applied to results in the Test Manager

Value: String of the form aaa:bbb:...:zzz, with at least two colon-separated MATLAB
identifiers aaa, bbb, and zzz.

Examples:

'SimulinkTest:greaterThan'

errorMessage

Label applied to messages in the diagnostic viewer

Value: String

Examples:

'x and y values are %d, %d',x,y

Logical Operators

You can use logical connectives in actions, transitions, and assessments. In these
examples, p and q represent Boolean signals or logical expressions.
Operation Syntax Description Example
Negation ~p not p verify(~p)
Conjunction p && q p and q verify(p && q)
Disjunction p || q p or q verify(p || q)
Implication ~p || q if p, q. Logically

equivalent to
implication p → q.

verify(~p || q)
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Operation Syntax Description Example
Biconditional (p && q) || (~p

&& ~q)
p and q, or not p and
not q. Logically
equivalent to
biconditional p ↔ q.

verify((p && q)
|| (~p && ~q))

Relational Operators

You can use relational operators in actions, transitions, and assessments. In these
examples, x and y represent numeric-type variables.

Using == or ~= operators in a verify statement returns a warning when comparing
floating-point data. Consider the precision limitations associated with floating-point
numbers when implementing verify statements. See “Floating-Point Numbers”
(MATLAB). If you use floating-point data, consider defining a tolerance for the
assessment. For example, instead of verify(x == 5), verify x within a tolerance of
0.001:

verify(abs(x-5) < 0.001)

Operator and Syntax Description Example
x > y Greater than verify(x > y)
x < y Less than verify(x < y)
x >= y Greater than or equal to verify(x >= y)
x <= y Less than or equal to verify(x <= y)
x == y Equal to verify(x == y)
x ~= y Not equal to verify(x ~= y)

See Also
“Syntax for Test Sequences and Assessments” on page 3-45 | Test Sequence

Related Examples
• “Test Sequence Action and Transition Operations” on page 3-17
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• “Generate Function-Based Test Signals” on page 3-28
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Programmatically Create a Test Sequence
This example shows how to create a test sequence programmatically. You create a Test
Sequence block, and author a test sequence to verify two safety requirements of a cruise
control system.

Create a Test Harness Containing a Test Sequence Block

1. Open the cruise control project, and open the model. This creates a working copy of the
project in your MATLAB folder.

slVerificationCruiseStart;
open_system simulinkCruiseAddReqExample.slx

Initializing: Project Path
Identifying shadowed project files

2. Create and open the test harness.

sltest.harness.create('simulinkCruiseAddReqExample','Name','SafetyTestHarness',...
    'Source','Test Sequence')
sltest.harness.open('simulinkCruiseAddReqExample','SafetyTestHarness')
set_param('SafetyTestHarness','StopTime','15');
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Author the Test Sequence

1. Add a local variable endTest, which you use to transition between test steps.

sltest.testsequence.addSymbol('SafetyTestHarness/Test Sequence','endTest',...
    'Data','Local');

2. Change the name of the step Run to Initialize1.

sltest.testsequence.editStep('SafetyTestHarness/Test Sequence','Run',...
    'Name','Initialize1');

3. Add a step BrakeTest to test that the cruise control disengages when the brake is
applied. Also add substeps defining the test scenario actions and verification.

sltest.testsequence.addStepAfter('SafetyTestHarness/Test Sequence',...
    'BrakeTest','Initialize1','Action','endTest = false;')

    % Add a transition from |Initialize1| to |BrakeTest|.
    sltest.testsequence.addTransition('SafetyTestHarness/Test Sequence',...
        'Initialize1','true','BrakeTest')

    % This sub-step enables the cruise control and sets the speed.
    % |SetValuesActions| is the actions for BrakeTest.SetValues.
    setValuesActions = sprintf('CruiseOnOff = true;\nSpeed = single(50);');
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    sltest.testsequence.addStep('SafetyTestHarness/Test Sequence',...
        'BrakeTest.SetValues','Action',setValuesActions)

    % This sub-step engages the cruise control.
    setCCActions = sprintf('CoastSetSw = true;');
    sltest.testsequence.addStepAfter('SafetyTestHarness/Test Sequence',...
        'BrakeTest.Engage','BrakeTest.SetValues','Action',setCCActions)

    % This step applies the brake.
    brakeActions = sprintf('CoastSetSw = false;\nBrake = true;');
    sltest.testsequence.addStepAfter('SafetyTestHarness/Test Sequence',...
        'BrakeTest.Brake','BrakeTest.Engage','Action',brakeActions)

    % This step verifies that the cruise control is off.
    brakeVerifyActions = sprintf('verify(engaged == false)\nendTest = true;');
    sltest.testsequence.addStepAfter('SafetyTestHarness/Test Sequence',...
        'BrakeTest.Verify','BrakeTest.Brake','Action',brakeVerifyActions)

    % Add transitions between steps.
    sltest.testsequence.addTransition('SafetyTestHarness/Test Sequence',...
        'BrakeTest.SetValues','true','BrakeTest.Engage')
    sltest.testsequence.addTransition('SafetyTestHarness/Test Sequence',...
        'BrakeTest.Engage','after(2,sec)','BrakeTest.Brake')
    sltest.testsequence.addTransition('SafetyTestHarness/Test Sequence',...
        'BrakeTest.Brake','true','BrakeTest.Verify')

4. Add a step Initialize2 to initialize component inputs again, and add a transition
from BrakeTest to Initialize2.
init2Actions = sprintf(['CruiseOnOff = false;\n'...
    'Brake = false;\n'...
    'Speed = single(0);\n'...
    'CoastSetSw = false;\n'...
    'AccelResSw = false;']);
sltest.testsequence.addStepAfter('SafetyTestHarness/Test Sequence',...
    'Initialize2','BrakeTest','Action',init2Actions)
sltest.testsequence.addTransition('SafetyTestHarness/Test Sequence',...
    'BrakeTest','endTest == true','Initialize2')

5. Add a step LimitTest to test cruise control disengagement when the vehicle speed
exceeds the high limit. Also, add a transition from the Initialize2 step, and add sub-
steps to define the scenario actions and verification.
sltest.testsequence.addStepAfter('SafetyTestHarness/Test Sequence',...
    'LimitTest','Initialize2')
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sltest.testsequence.addTransition('SafetyTestHarness/Test Sequence',...
    'Initialize2','true','LimitTest')

    % Add a step to enable cruise control and set the speed.
    setValuesActions2 = sprintf('CruiseOnOff = true;\nSpeed = 60;');
    sltest.testsequence.addStep('SafetyTestHarness/Test Sequence',...
        'LimitTest.SetValues','Action',setValuesActions2)

    % Add a step to engage the cruise control.
    setCCActions = sprintf('CoastSetSw = true;');
    sltest.testsequence.addStepAfter('SafetyTestHarness/Test Sequence',...
        'LimitTest.Engage','LimitTest.SetValues','Action',setCCActions)

    % Add a step to ramp the vehicle speed.
    sltest.testsequence.addStepAfter('SafetyTestHarness/Test Sequence',...
        'LimitTest.RampUp','LimitTest.Engage','Action','Speed = Speed + ramp(5*et);')

    % Add a step to verify that the cruise control is off.
    highLimVerifyActions = sprintf('verify(engaged == false)');
    sltest.testsequence.addStepAfter('SafetyTestHarness/Test Sequence',...
        'LimitTest.VerifyHigh','LimitTest.RampUp','Action',highLimVerifyActions)

    % Add transitions between steps. The speed ramp transitions when the
    % vehicle speed exceeds 90.
    sltest.testsequence.addTransition('SafetyTestHarness/Test Sequence',...
        'LimitTest.SetValues','true','LimitTest.Engage')
    sltest.testsequence.addTransition('SafetyTestHarness/Test Sequence',...
        'LimitTest.Engage','true','LimitTest.RampUp')
    sltest.testsequence.addTransition('SafetyTestHarness/Test Sequence',...
        'LimitTest.RampUp','Speed > 90','LimitTest.VerifyHigh')

Double-click the Test Sequence block to open the editor and view the created test
sequence.
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Close the Test Harness and Model

sltest.harness.close('simulinkCruiseAddReqExample','SafetyTestHarness');
close_system('simulinkCruiseAddReqExample.slx',0);
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Syntax for Test Sequences and Assessments

In this section...
“Assessment Statements” on page 3-45
“Temporal Operators” on page 3-47
“Transition Operators” on page 3-48
“Output Functions” on page 3-49
“Logical Operators” on page 3-52
“Relational Operators” on page 3-52

This topic describes syntax used in Test Sequence and Test Assessment block actions,
transitions, and assessments. You can also work with Test Sequence blocks using the
test sequence API, which provides functions to create, read, edit, and delete test
sequence steps, transitions, and data symbols. See the functions listed in the Test
Sequence Programming section on the “Test Sequences and Assessments” page.

Within test step actions, transitions, and assessments, Test Sequence and Test
Assessment blocks use MATLAB as the action language. In addition to the MATLAB
language, the block includes keywords and operators to create action, transition, and
assessment statements. For example:

• Output a square wave with a period of 10 sec:

square(et/10)
• Transition when h changes to 0:

hasChangedTo(h,0)
• Verify that x is greater than y:

verify(x > y)

Assessment Statements

To verify simulation, stop simulation, and return verification results, use assessment
statements.
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Keyword Statement Syntax Description Example
verify verify(expression)

verify(expression,
errorMessage)

verify(expression,
identifier,
errorMessage)

Assesses a logical
expression.
Optional
arguments label
results in the Test
Manager and
diagnostic viewer.

verify(x > y,...
'SimulinkTest:greaterThan',...
'x and y values are %d, %d',x,y)

assert assert(expression)

assert(expression,
errorMessage)

Evaluates a
logical expression.
Failure stops
simulation and
returns an error.
Optional
arguments return
an error message.

assert(h == 0 && k == 0,...
'h and k must initialize to 0')

Syntax in the table uses these arguments:

expression

Logical statement assessed

Examples:

h > 0 && k == 0

identifier

Label applied to results in the Test Manager

Value: String of the form aaa:bbb:...:zzz, with at least two colon-separated MATLAB
identifiers aaa, bbb, and zzz.

Examples:

'SimulinkTest:greaterThan'

errorMessage

Label applied to messages in the diagnostic viewer
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Value: String

Examples:

'x and y values are %d, %d',x,y

Temporal Operators

To create an expression that evaluates the simulation time, use temporal operators.
Variables used in signal conditions must be inputs, parameters, or constants in the Test
Sequence block.
Operator Syntax Description Example
et et(TimeUnits) The elapsed time of the

test step in TimeUnits.
Omitting TimeUnits
returns the value in
seconds.

The elapsed time of the test
sequence step in milliseconds:

et(msec)

t t(TimeUnits) The elapsed time of the
simulation in
TimeUnits. Omitting
TimeUnits returns the
value in seconds.

The elapsed time of the
simulation in microseconds:

t(usec)

after after(n,
TimeUnits)

Returns true if n
specified units of time
in TimeUnits elapse
since the beginning of
the current test step.

After 4 seconds:

after(4,sec)

before before(n,
TimeUnits)

Returns true until n
specified units of time
in TimeUnits elapse,
beginning with the
current test step.

Before 4 seconds:

before(4,sec)
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Operator Syntax Description Example
duration ElapsedTime =

duration
(Condition,
TimeUnits)

Returns ElapsedTime
in TimeUnits for
which Condition has
been true.
ElapsedTime is reset
when the test step is re-
entered or when
Condition is no longer
true.

Return true if the time in
milliseconds since Phi > 1 is
greater than 550:

duration(Phi>1,msec) > 550

Syntax in the table uses these arguments:

TimeUnits

The units of time

Value: sec|msec|usec

Examples:

msec

Condition

Logical expression triggering the operator. Variables used in duration can be inputs,
parameters, or constants, with at most one local or output data.

Examples:

u > 0
x <= 1.56

Transition Operators

To create expressions that evaluate signal events, use transition operators. Common
transition operators include:
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Operator Syntax Description Example
hasChanged hasChanged(u) Returns true if u

changes in value
since the beginning
of the test step,
otherwise returns
false.

u must be an input
data symbol.

Transition when h
changes:

hasChanged(h)

hasChangedFrom hasChangedFrom(u,A) Returns true if u
changes from the
value A, otherwise
returns false.

u must be an input
data symbol.

Transition when h
changes from 1:

hasChangedFrom(h,1)

hasChangedTo hasChangedTo(u,B) Returns true if u
changes to the value
B, otherwise returns
false.

u must be an input
data symbol.

Transition when h
changes to 0:

hasChangedTo(h,0)

Output Functions

Generate test signals using output functions. Some output functions use the temporal
operator et, which is the elapsed time of the test step in seconds.

Note Function outputs are not constrained to provide a defined pattern. Scaling,
rounding, and other approximations of argument values can affect function outputs.

Common output functions include:
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Function Syntax Description Example
square square(x) Represents a square wave

output with a period of 1
and range –1 to 1.

Within the interval 0 <=
x < 1, square(x)
returns the value 1 for 0
<= x < 0.5and –1 for
0.5 <= x < 1.

Output a square wave
with a period of 10 sec:

square(et/10)

sawtooth sawtooth(x) Represents a sawtooth
wave output with a period
of 1 and range –1 to 1.

Within the interval 0 <=
x < 1, sawtooth(x)
increases.

Output a sawtooth wave
with a period of 10 sec:

sawtooth(et/10)

triangle triangle(x) Represents a triangle
wave output with a period
of 1 and range –1 to 1.

Within the interval 0 <=
x < 0.5, triangle(x)
increases.

Output a triangle wave
with a period of 10 sec:

triangle(et/10)

ramp ramp(x) Represents a ramp signal
of slope 1, returning the
value of the ramp at time
x.

ramp(et) effectively
returns the elapsed time
of the test step.

Ramp one unit for every 5
seconds of test step
elapsed time:

ramp(et/5)

heaviside heaviside(x) Represents a heaviside
step signal, returning 0
for x < 0 and 1 for x >=
0.

Output a heaviside signal
after 5 seconds:

heaviside(et-5)

3 Test Sequences and Assessments

3-50



Function Syntax Description Example
latch latch(x) Saves the value of x at the

first time latch(x)
evaluates in a test step,
and subsequently returns
the saved value of x.
Resets the saved value of
x when the step exits.
Reevaluates latch(x)
when the step is next
active.

Latch b to the value of
torque:

b = latch(torque)

sin sin(x) Returns the sine of x,
where x is in radians.

A sine wave with a period
of 10 sec:

sin(et*2*pi/10)
cos cos(x) Returns the cosine of x,

where x is in radians.
A cosine wave with a
period of 10 sec:

cos(et*2*pi/10)
rand rand Uniformly distributed

pseudorandom number.
Generate values from the
uniform distribution on
the interval [a, b].

a + (b-a)*rand
randn randn Normally distributed

pseudorandom number.
Generate values from a
normal distribution with
mean 1 and standard
deviation 2.

1 + 2*randn(100,1)
exp exp(x) Returns the natural

exponential function, e
x .

An exponential signal
progressing at one tenth
of the test step elapsed
time:

exp(et/10)
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Logical Operators

You can use logical connectives in actions, transitions, and assessments. In these
examples, p and q represent Boolean signals or logical expressions.
Operation Syntax Description Example
Negation ~p not p verify(~p)
Conjunction p && q p and q verify(p && q)
Disjunction p || q p or q verify(p || q)
Implication ~p || q if p, q. Logically

equivalent to
implication p → q.

verify(~p || q)

Biconditional (p && q) || (~p
&& ~q)

p and q, or not p and
not q. Logically
equivalent to
biconditional p ↔ q.

verify((p && q)
|| (~p && ~q))

Relational Operators

You can use relational operators in actions, transitions, and assessments. In these
examples, x and y represent numeric-type variables.

Using == or ~= operators in a verify statement returns a warning when comparing
floating-point data. Consider the precision limitations associated with floating-point
numbers when implementing verify statements. See “Floating-Point Numbers”
(MATLAB). If you use floating-point data, consider defining a tolerance for the
assessment. For example, instead of verify(x == 5), verify x within a tolerance of
0.001:

verify(abs(x-5) < 0.001)

Operator and Syntax Description Example
x > y Greater than verify(x > y)
x < y Less than verify(x < y)
x >= y Greater than or equal to verify(x >= y)
x <= y Less than or equal to verify(x <= y)
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Operator and Syntax Description Example
x == y Equal to verify(x == y)
x ~= y Not equal to verify(x ~= y)

See Also

Related Examples
• “Assess Simulation Using Logical Statements” on page 3-32
• “Test Sequence Action and Transition Operations” on page 3-17
• “Generate Function-Based Test Signals” on page 3-28
• “Programmatically Create a Test Sequence” on page 3-39
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Debug a Test Sequence
In this section...
“View Test Step Execution During Simulation” on page 3-54
“Set Breakpoints to Enable Debugging” on page 3-54
“View Data Values During Simulation” on page 3-55
“Step Through Simulation” on page 3-56

You can debug a test sequence using tools in the test sequence editor. Debugging involves
setting breakpoints to stop simulation, observing data and test sequence progression, and
manually stepping through test steps. You can try these features using the model
sltestTestSeqDebuggingExample. To open the model, enter

cd(fullfile(docroot,'toolbox','sltest','examples'))
open_system('sltestTestSeqDebuggingExample')

Save a copy of the model to a writable location on the MATLAB path. Double-click the
Test Sequence block to open the test sequence editor.

View Test Step Execution During Simulation
By default, simulation animates the test sequence by highlighting active steps and
transitions. Observing test step execution can help you debug, particularly when
manually stepping through the test sequence. Adjust the animation speed using the

Change Animation Speed button  in the toolbar.

Animation speed affects simulation speed. If you slow down animation speed for
debugging, return the speed to Fast or Lightning Fast when you finish debugging to
avoid slowing your simulation. If you do not need the test step highlights and want the
fastest simulation, choose None.

Set Breakpoints to Enable Debugging
You enable debugging for a test sequence by adding one or more breakpoints.
Breakpoints halt simulation every time the test step is evaluated. Therefore, breakpoints
on some test steps, such as When decomposition parent steps, halt simulation
repeatedly because the step is evaluated repeatedly. When simulation halts, you can
view data used in the test sequence to investigate the sequence simulation behavior.
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You can add breakpoints to test step actions or transitions:

• To add a breakpoint to a test step action, right-click the test step and select Break
while executing step.

• To add a breakpoint to a test step transition, right-click the test step transition and
select Break when transition taken.

The editor displays a breakpoint marker. After adding breakpoints, simulate the test
sequence by clicking Run.

View Data Values During Simulation

If the simulation pauses (for example, at a breakpoint), you can view the status of data
used in a test step by hovering over the test step. The data values at the current
simulation time display next to the test sequence cell.

Note If you advance the simulation to another stop (for example, using the keyboard
shortcuts), the data display does not update. Move off the test step and then hover over
the step again to refresh the values.
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Step Through Simulation

When simulation halts, you can step through the test sequence using the toolbar buttons.
Also see “Debugging and Breakpoints Keyboard Shortcuts” (Simulink).
Objective Details Toolbar Button
Simulate until
breakpoint

Simulation runs until
the next breakpoint

Step forward
through simulation
time

Simulation advances one
simulation step

Step forward
through test step
actions and
transitions

Simulation advances by
each step of a test
sequence, with pauses at
actions and transitions.
Does not step into a
function call.

Step in to a test step
group or called
function

Simulation advances
into the substeps of a
parent step and executes
each action and
transition. Steps into a
function call.

Step out of a test
step group or called
function

Simulation advances
through the remaining
substeps of a parent step
and then out to the
parent step hierarchy
level. Also finishes
execution of a function
call.

See Also
“Test Sequence Editor” on page 3-11 | Test Sequence
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Test a Model Component Using Signal Functions
In this section...
“Create a Test Sequence” on page 3-57
“Simulate the Test Harness” on page 3-58

Using the Test Sequence block, you can define a set of input functions to test your
component, and conditionally switch the function based on component signals. See Test
Sequence for more information.

This example demonstrates building and simulating a test sequence using ramp and
square wave signals. The test initializes at constant temperature, ramps down to a limit,
and executes a square-wave temperature cycle.

Create a Test Sequence
1 Access the model. Enter

cd(fullfile(docroot,'toolbox','sltest','examples'))
2 Copy this model file and supporting files to a writable location on the MATLAB path:

sltestSignalFunctionExample.slx
sltestHeatpumpBusPostLoadFcn.mat
PumpDirection.m

3 Open the model, and open the harness.

open_system('sltestSignalFunctionExample');
sltest.harness.open('sltestSignalFunctionExample/Controller',...
'RampSquareHarness')

4 Double-click the Test Sequence block to open the test sequence editor.
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5 Rename the first and second steps. Delete the default names and replace them with
const_90 and ramp_down.

6 Add a third step to the table. Right-click the ramp_down line, and select Add step
after. Name the third step temp_step.

7 Add output conditions and transition fields to the steps. Copy and paste the listings
from the table.
Step Transition Next step
const_90
Tset = 75;
Troom_in = 90;

after(120,sec) ramp_down

ramp_down
Tset = 75;
Troom_in = 90-ramp(et)/8;

Troom_in <= 60 temp_step

temp_step
Tset = 75;
Troom_in = 75+15*square(et/90);

  

Simulate the Test Harness
1 Set the simulation time to 720 sec.
2 Simulate the Test Harness. Observe the Troom_in signal in the scope.
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See Also
Blocks
Test Sequence
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Test Downshift Points of a Transmission Controller
This example demonstrates how to test a transmission shift logic controller using test
sequences and test assessments.

The Model and Controller

This example uses a simplified drivetrain system arranged in a controller-plant
configuration. The objective of the example is to test the transmission controller in
isolation, ensuring that it downshifts correctly.

The Test

The controller should downshift between each of its gear ratios in response to a ramped
throttle application. The test inputs hold vehicle speed constant while ramping the
throttle. The Test Assessment block includes requirements-based assessments of the
controller performance.

path = fullfile(matlabroot,'examples','simulinktest');
mdl = 'TransmissionDownshiftTestSequence';
harness = 'controller_harness';
open_system(fullfile(path,mdl));

3 Test Sequences and Assessments

3-60



Open the Test Harness

Click the badge on the subsystem shift_controller and open the test harness
controller_harness. shift_controller is connected to a Test Sequence block and a
Test Assessment block.

sltest.harness.open([mdl '/shift_controller'],harness)

The Test Sequence

Double-click the Test Sequence block to open the test sequence editor.

The test sequence begins by ramping speed to 75 to initialize the controller to fourth
gear. Throttle is then ramped at constant speed until a gear change. Subsequent
initialization and downshifts execute. After the change to first gear, the test sequence
stops.

open_system([harness '/Test Sequence']);
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Test Assessments for the Controller

The requirements for the shift controller include conditions which would invalidate the
test.
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• Speed shall never be negative.
• Gear shall always be positive.
• Throttle shall be between 0% and 100%.

In addition, the functional requirement tested is that the shift controller shall keep the
vehicle speed below specified maximums in each of the first three gears.

Open the Test Assessment block. These assertions in the block correspond to the first
three requirements. If the controller violates one of the assertions, the simulation fails.

assert(speed >= 0, 'speed must be >= 0');
assert(throttle >= 0, 'throttle must be >= 0 and <= 100');
assert(throttle <= 100, 'throttle must be >= 0 and <= 100');
assert(gear > 0,'gear must be > 0');

The last requirement has three sub-requirements.

• The controller shall not let the vehicle speed exceed 90 in gear 3.
• The controller shall not let the vehicle speed exceed 50 in gear 2.
• The controller shall not let the vehicle speed exceed 30 in gear 1.

You can model these assessments with a When decomposition sequence. When
decomposition step selection is based on signal conditions defined in the Step column,
with each condition preceded by the when operator. The Transition and Next Step
columns do not affect the transition. The last step Else covers any undefined condition
and does not use a when declaration.

To change a sequence to a When decomposition, right-click a step and select When
decomposition. Sub-steps of this step then operate using the when operator. The
assessments use verify statements so that results are available in the Simulation Data
Inspector, and so that failures do not stop simulation.

OverSpeed3 when gear==3
verify(speed <= 90,'Engine overspeed in gear 3')

OverSpeed2 when gear==2
verify(speed <= 50,'Engine overspeed in gear 2')

OverSpeed1 when gear==1
verify(speed <= 30,'Engine overspeed in gear 1')
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Testing the Controller

Simulate the test harness demonstrates the progressive throttle ramp at each test step,
and the corresponding downshifts. The controller passes all of the assessments in the
Test Assessment block.

open_system([harness '/FloatingScope'])
sim(harness);
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View the Results

Click the Simulation Data Inspector button in the test harness toolstrip to view the
results. You can compare the speed signal to the verify statement outputs.

Simulink.sdi.view
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Simulink.sdi.close
close_system(mdl);
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Reuse Test Assessments
If one test assessment covers many test cases, consider reusing the assessment from a
single source such as a library. Reusing test assessments allows you to update and
manage the source rather than multiple copies of the same assessment. Often, such
assessments are associated with broad requirements such as:

• “The speed signal must never be negative.”
• “The cruise control must never be engaged while the brake is engaged.”
• “The heat pump must wait more than 5 seconds before switching from on to off or off

to on.”
• “The projector temperature must never exceed 65 degrees Celsius.”

Reuse Test Assessments Using a Library

This example shows how to reuse test assessments contained in a test sequence block
using a linked block from a library.

When you create a test harness, you can include a standalone Test Sequence block for
test assessments (a Test Assessment block). Often, assessments cover multiple test cases,
making it convenient to reuse the same Test Assessment block. Test assessment reuse
has these advantages:

• Assessments are stored in a single source. If the requirements change, you update
only the assessments in the library.

• You can link to test requirements from the source. Linking from the source reduces
the number of requirements links to manage.

To reuse a standalone Test Assessment block in multiple test harnesses, create the Test
Assessment block in a library, and reuse the Test Assessment block in multiple test
harnesses by way of linked blocks.

Consider using a library for high-level test assessments that correspond to multiple test
cases.

You can also create reusable assessments in a library using blocks from the Model
Verification library in Simulink.
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Explore the Test Sequence Example Model

1. Open the model. At the command line, enter:

sltestTestSequenceExample

2. Click the badge on the shift_controller subsystem and open the
controller_harness test harness.
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The Test Assessment block contains four assertions that define the assessment criteria:

assert(speed >= 0)
assert(throttle >= 0)
assert(throttle <= 100)
assert(gear > 0)

Create a Library for the Test Assessments

1 In the test harness, select File > New > Library.
2 Save the new library as AssessmentLibrary in a writable location on the

MATLAB® path.
3 Copy the Test Assessment block from the test harness to the library, and then delete

the Test Assessment block from the test harness.
4 Save the library.
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Create a Linked Test Assessment Block in Test Harnesses

Copy the Test Assessment block from the library to the test harness to create a linked
block.

1 In the test harness, enable the library link display. Select Display > Library Links
> All.

2 Copy the Test Assessment block from AssessmentLibrary into
controller_harness. The block displays a library link badge.

3 Connect the signal inputs to the Test Assessment block.
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Edit the Assessment Block in the Library

1 Unlock the library. Select Diagram > Unlock Library.
2 Add a fifth assertion to the Test Sequence block: assert(gear < 5);
3 Save and close the library. Closing locks the library.
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View Graphical Results From Model Verification Library
Simulink® Test™ outputs graphical results of the Model Verification block library so you
can use the Test Manager or Simulation Data Inspector to see when your test
assessments pass and fail.

In addition to warnings or stop-simulation behavior, the graphical results show the block
evaluation results during simulation. Viewing Model Verification block results
graphically helps you to:

• Determine the time step when a failure occurs.
• Debug the model by comparing the verification result with relevant signals.
• Trace failures from the results to the model.

This example shows how to view outputs from Model Verification blocks in the Test
Manager or Simulation Data Inspector.

Open the Model

The model contains a verification subsystem Safety Properties that uses an
Assertion block to check whether the system disengages if the brake has been applied for
three time steps. The verification subsystem also uses Simulink® Design Verifier™
blocks.

open_system(fullfile(matlabroot,'examples','simulinktest',...
    'sltestCruiseControlDefective'))
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Simulate the Model and View Results in SDI

sim('sltestCruiseControlDefective')

After the simulation completes, open SDI. The results show that the assertion failed at
0.23 seconds.

Simulink.sdi.view
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Highlight Assertion Block in the Model

To find the assertion block in the model, right-click BrakeAssertion in SDI and select
Highlight in Model. The block is highlighted in the verification subsystem.
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Test Harness Software- and Processor-
in-the-Loop

• “SIL Verification for a Subsystem” on page 4-2
• “Test Code in S-Functions” on page 4-7
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SIL Verification for a Subsystem
In this section...
“Create a SIL Verification Harness for a Controller” on page 4-3
“Configure and Simulate a SIL Verification Harness” on page 4-5
“Compare the SIL Block and Model Controller Outputs” on page 4-5

This example shows subsystem verification by ensuring the output of software-in-the-
loop (SIL) code matches that of the model subsystem. You generate a SIL verification
harness, collect simulation results, and compare the results using the simulation data
inspector. You can apply a similar process for processor-in-the-loop (PIL) verification.

With SIL simulation, you can verify the behavior of production source code on your host
computer. Additionally, with PIL simulation, you can verify the compiled object code that
you intend to deploy in production. You can run the PIL object code on real target
hardware or on an instruction set simulator.

If you have an Embedded Coder license, you can create a test harness in SIL or PIL mode
for model verification. You can compare the SIL or PIL block results with the model
results and collect metrics, including execution time and code coverage. Using the test
harness to perform SIL and PIL verification, you can:

• Manage the harness with your model. Generating the test harness generates the SIL
block. The test harness is associated with the component under verification. You can
save the test harness with the main model.

• Use built-in tools for these test-design-test workflows:

• Checking the SIL or PIL block equivalence
• Updating the SIL or PIL block to the latest model design

• View and compare logged data and signals using the Test Manager and Simulation
Data Inspector.

For information about running multiple simulations with unchanged generated code,
see .

Also see “Code Generation of Subsystems” (Simulink Coder).

The example models a closed-loop controller-plant system. The controller regulates the
plant output.
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Create a SIL Verification Harness for a Controller

Create a SIL verification harness using data that you log from a controller subsystem
model simulation. You need an Embedded Coder license for this example.

1 Open the example model by entering

rtwdemo_sil_block

at the MATLAB command prompt,

2 Save a copy of the model using the name controller_model in a new folder, in a
writable location on the MATLAB path.

3 Enable signal logging for the model. At the command prompt, enter

set_param(bdroot,'SignalLogging','on','SignalLoggingName',...
'SIL_signals','SignalLoggingSaveFormat','Dataset')
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4 Right-click the signal into Controller port In1, and select Properties. In the Signal
Properties dialog box, for the Signal name, enter controller_model_input.
Select Log signal data and click OK.

5 Right-click the signal out of Controller port Out1, and select Properties. In the
Signal Properties dialog box, for the Signal name, enter
controller_model_output. Select Log signal data and click OK.

6 Simulate the model.
7 Get the logged signals from the simulation output into the workspace. At the

command prompt, enter

out_data = out.get('SIL_signals');
control_in1 = out_data.get('controller_model_input');
control_out1 = out_data.get('controller_model_output');

8 Create the software-in-the-loop test harness. Right-click the Controller subsystem
and select Test Harness > Create Test Harness (Controller).

9 Set the harness properties:

• Name: SIL_harness
• Sources and Sinks: Inport and Outport
• Initial harness configuration: Verification
• Verification Mode: Software-in-the-loop (SIL)
• Select Open harness after creation

Click OK. The resulting test harness has a SIL block.
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Configure and Simulate a SIL Verification Harness

Configure and simulate a SIL verification harness for a controller subsystem.

1 Configure the test harness to import the logged controller input values. From the top
level of the test harness, in the model Configuration Parameters dialog box, in
the Data Import/Export pane, select Input. Enter control_in1.Values as the
input and click OK.

2 Enable signal logging for the test harness. At the command prompt, enter

set_param('SIL_harness','SignalLogging','on','SignalLoggingName',...
'harness_signals','SignalLoggingSaveFormat','Dataset')

3 Right-click the output signal of the SIL block and select Properties. In the Signal
Properties dialog box, for the Signal name, enter SIL_block_out. Select Log
signal data and click OK.

4 Simulate the harness.

Compare the SIL Block and Model Controller Outputs

Compare the outputs for a verification harness and a controller subsystem.

1 In the test harness model, click the Simulation Data Inspector button  to open the
Simulation Data Inspector.

2 In the Simulation Data Inspector, click Import. In the Import dialog box.

• Set Import from to: Base workspace.
• Set Import to to: New Run.
• Under Data to import, select Signal Name to import data from all sources.

3 Click Import.
4 Select the SIL_block_out and controller_model_out signals in the Runs pane

of the data inspector window.

The chart displays the two signals, which overlap. This result suggests equivalence
for the SIL code. You can plot signal differences using the Compare tab in SDI, and
perform more detailed analyses for verification. For more information, see “Compare
Simulation Data” (Simulink).
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5 Close the test harness window. You return to the main model. The badge  on the
Controller block indicates that the SIL harness is associated with the subsystem.
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Test Code in S-Functions

In this section...
“Set Up the Working Environment” on page 4-7
“Create a Test Harness for the Controller” on page 4-9
“Add Inputs and Set Simulation Parameters” on page 4-10
“Create a Test Case and Obtain a Baseline” on page 4-10
“Run the Test Case and View Results” on page 4-11

S-Functions are computer language descriptions of Simulink blocks written in MATLAB,
C, C++ or Fortran. You can test code wrapped in S-Functions using Simulink Test test
harnesses. Testing code in S-Functions can be helpful for regression testing of legacy
code and for testing your code in a system context.

In this example, you test code in an S-Function block using a test harness. The main
model is a controller-plant model of an air conditioning/heat pump unit. Before you
begin, change the default working folder to one with write permissions.

Note This example is set up to work only on a 64–bit Windows® platform.

Set Up the Working Environment

1 Navigate to the model.

cd(fullfile(docroot,'toolbox','sltest','examples'))
2 Copy these files to a writable location on the MATLAB path:

• sltestHeatpumpSfunExample.slx
• sltestHeatpumpBusPostLoadFcn.mat
• PumpDirection.m

3 Open the model.

open_system('sltestHeatpumpSfunExample')
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In the example model:

• The controller is an S-function that accepts room temperature and specified
temperature inputs.

• The controller output is a bus with signals that control the fan, heat pump, and the
direction of the heat pump (heat or cool).

• The plant accepts the control bus. The heat pump and the fan signals are Boolean,
and the heat pump direction is specified by +1 for cooling and -1 for heating.

The test covers four temperature conditions. Each condition corresponds to one operating
state with fan, pump, and pump direction signal outputs.
Temperature Condition System

State
Fan
Comman
d

Pump
Command

Pump
Direction

|Troom_in - Tset| < DeltaT_fan idle 0 0 0
DeltaT_fan <= |Troom_in - Tset| <
DeltaT_pump

fan
only

1 0 0

|Troom_in - Tset| >= DeltaT_pump
and Tset < Troom_in

cooling 1 1 -1

|Troom_in - Tset| >= DeltaT_pump
and Tset > Troom_in

heating 1 1 1
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Create a Test Harness for the Controller

1 Right-click the Controller subsystem and select Test Harness > Create for
‘Controller’.

2 Set the harness properties.

In the Basic Properties tab:

• Set Name to test_harness_1
• Set Sources and Sinks to None and Scope

3 Click OK to create the test harness.
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Add Inputs and Set Simulation Parameters
1 Create a test input for the harness with a constant Tset and a time-varying

Troom_in. Connect a Constant block to the Tset input and set the value to 75.
2 Add a Sine Wave block to the harness model to simulate a temperature signal.

Connect the Sine Wave block to the conversion subsystem input Troom_in_in.
3 Double-click the Sine Wave block and set the parameters:

Parameter Value
Amplitude 15
Bias 75
Frequency 2*pi/3600
Phase (rad) 0
Sample time 1

Select Interpret vector parameters as 1–D.

4 In the Solver pane of the Simulink toolstrip, set Stop time to 3600.

Create a Test Case and Obtain a Baseline
1 In the test harness, select the three output signals from the Output Conversion

Subsystem and right-click one of them. Select Log Selected Signals.
2 Open the Test Manager. Select Analysis > Test Manager.
3 From the Test Manager toolstrip, click New to create a test file. Name and save the

test file.
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4
In the test case, under System Under Test , click the  button to load the current
model into the test case.

5 Expand Test Harness and select test_harness_1 .
6 Under Baseline Criteria, click Capture to record a baseline data set from the

model specified under System Under Test. Save the baseline data set to the
working folder. The model runs and the baseline criteria appear in the table.

Run the Test Case and View Results
1 Run the selected test case.

The Test Manager switches to the Results and Artifacts pane, and the new test
result appears at the top of the table.

2 Expand the results until you see the baseline criteria result.

The overall baseline test passes.
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Introduction to the Test Manager

In this section...
“Start the Test Manager” on page 5-2
“Create Tests and Understand the Test Hierarchy” on page 5-2
“View Test Results” on page 5-4
“Share Results” on page 5-4
“Compare Test Files” on page 5-4

The Test Manager in Simulink Test helps you to automate Simulink model testing and
organize large sets of tests. You perform model tests in the Test Manager using test cases
in which you specify the criteria that determine a pass-fail outcome. After you run a test,
you can view and share the results.

Start the Test Manager

You can start the Test Manager from a model or from the MATLAB command prompt.

• To start the Test Manager from a model, select Analysis > Test Manager.
• To start the Test Manager from the command prompt, enter: sltestmgr.

Create Tests and Understand the Test Hierarchy

In the Test Manager, you create test files, which contain one or more test suites that
each contain one or more test cases.

To create a test file, in the Test Manager, select New > Test File. Name the file and
click Save.

The test files and their contents appear in the Test Browser pane.

Each new test file contains a test suite, New Test Suite 1, which contains a test case,
New Test Case 1. You can rename test suites and test cases in the browser. The figure
shows a test file that contains two test suites that each contain test cases.

5 Simulink Test Manager Introduction

5-2



Add test suites and test cases to the test file hierarchy using the New menu. Use test
suites to group related test cases. For each test case, specify details such as the model
under test, the simulation outputs to capture, and parameter overrides to apply. Run the
test case in the Test Manager, and view results in the Results and Artifacts pane.

For baseline and equivalence test cases, you can specify tolerances for the simulation
outputs that determine pass or fail. For more information on setting tolerances, see
“Apply Tolerances to Test Criteria” on page 6-68.

Using the Test Manager, from the New menu, you can create these types of test cases:

• Baseline — A baseline test is a type comparison test. For a baseline test, you first
generate a baseline set of simulation outputs as the basis for comparison. Running a
baseline test compares the outputs of the comparison simulation to the baseline. With
equivalence tests, you can specify tolerances that determine a range of values that
allow the test to pass. That is, the results are equivalent even if not the same. You
can set absolute, relative, leading, or lagging tolerances in the Baseline Criteria
section of the test case. See “Test Model Output Against a Baseline” on page 6-9.

• Equivalence — An equivalence test in Test Manager compares signal outputs from
two simulations. You can specify tolerances that help the test determine whether the
results are equivalent. Set tolerances in the Equivalence Criteria section of the test
case. See “Test Two Simulations for Equivalence”.

• Simulation — A simulation test checks that a simulation runs without errors,
including model assertions. See “Test a Simulation for Run-Time Errors” on page 6-
13.
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• Real-Time Test — A baseline, equivalence, or simulation test that runs on the target
hardware. See “Test Models in Real Time” on page 8-2.

• Test Manager Generated Tests — Tests that you do not need to configure:

• Test File from Model, which generates a test file and uses signal builders and
test harnesses in the model as the basis for generating test cases. See “Generate
Test Cases from Model Components” on page 6-16.

• Test for Subsystem, which generates a test harness for the subsystem you select
and generates a test case to run on the test harness. See “Generate Test for a
Subsystem” on page 6-20.

View Test Results

Tests can pass or fail. If all the criteria defined in a test case are satisfied, within the
defined tolerances, then a test passes. If any of the criteria are not satisfied, then the test
fails. After the test runs, you can see the results in the Results and Artifacts pane.
Each test result has a summary page that highlights the outcome of the test: passed,
failed, or incomplete. You can also see the simulation output in the results. You can
further inspect the signal data from the simulation output using the data inspector view.
To view a result in the data inspector view, select it.

Share Results

Once you have completed the test execution and analyzed the results, you can share the
test results with others or archive them. If you want to share the results to view later in
the Test Manager, then you can export the results to a file. To archive the results in a
document, generate a report, which can include the test outcome, test summary, and
criteria used for test comparisons. See “Export Test Results and Generate Reports” on
page 7-9.

Compare Test Files

You can use the Compare command in the File section of the MATLAB toolstrip to
compare two test files. Comparing test files is useful for determining the differences
between two similar test files. For example, you can see whether they contain the same
test cases and whether those test cases are configured identically.

1 From the File section of the MATLAB toolstrip, click Compare.
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2 In the First file or folder box, enter the first test file that you want to compare.
Test files are in the .mldatx format.

3 In the Second file or folder box, enter the second test file that you want to
compare.

4 For Comparison type, select Simulink Test File Comparison. Then click
Compare.

The figure shows an example of a comparison between two test files. The highlights
indicate where one file specifies information that the comparison file does not. For
example, newbaseline.mldatx includes a test suite that the other file does not
contain.

See Also

Related Examples
• “Test Model Output Against a Baseline” on page 6-9
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• “Test Two Simulations for Equivalence”
• “Code Generation Verification Workflow with Simulink Test”
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Test Manager Test Cases

• “Manage Test File Dependencies” on page 6-2
• “Test Model Output Against a Baseline” on page 6-9
• “Test a Simulation for Run-Time Errors” on page 6-13
• “Generate Test Cases from Model Components” on page 6-16
• “Specify Microsoft Excel File Format for Signal Data” on page 6-23
• “Use External Inputs in Test Cases” on page 6-30
• “Run Tests in Multiple Releases” on page 6-32
• “Examine Test Failures and Modify Baselines” on page 6-37
• “Automate Tests Programmatically” on page 6-43
• “Run Combinations of Tests Using Iterations” on page 6-50
• “Collect Coverage in Tests” on page 6-61
• “Run Tests Using Parallel Execution” on page 6-66
• “Apply Tolerances to Test Criteria” on page 6-68
• “Test Manager Limitations” on page 6-74
• “Test Sections” on page 6-76
• “Test Models Using Inputs Generated by Simulink Design Verifier” on page 6-86
• “Apply Custom Criteria to Test Cases” on page 6-91
• “Create, Store, and Open MATLAB Figures” on page 6-103
• “Test Models Using MATLAB Unit Test” on page 6-106
• “Filter Test Execution and Results” on page 6-115
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Manage Test File Dependencies
In this section...
“Package a Test File Using Simulink Projects” on page 6-2
“Find Test File Dependencies and Impact” on page 6-4
“Share a Test File with Dependencies” on page 6-8

A test file can be simple and contain only a few test cases. For such a test file, the file
dependencies for models, test requirements, input files, callbacks, and baseline data can
be manageable. When test files become large and complex, it is difficult to track and
manage file dependencies. You can use Simulink projects to help manage these
dependencies. Projects are especially helpful if you want to package and share a test file.

Package a Test File Using Simulink Projects
1 In the Test Browser, right-click the test file.
2 Select Simulink Project > Create Project from Test File.

Simulink Projects opens and identifies the file dependencies of the test file. In this
example, the test file contains a test case with a requirements link, an input file, and
a baseline file.
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3 Specify project name, and verify the list of selected file dependencies.
4 Click Create.
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Find Test File Dependencies and Impact

If you have a test file saved in a Simulink project, then you can find the file
dependencies.

1 Right-click the test file. Select Simulink Project > Find Dependencies.
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Simulink Projects shows a graph of file dependencies.
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6 In the toolstrip, click Run.

The test runs, simulating for each release you selected. For each release, pass-fail
results appear in the Results and Artifacts pane. For results from a release other
than the one you are running Test Manager from, the release number appears in the
name.

See Also
sltest.testmanager.getpref | sltest.testmanager.setpref

More About
• “Select Releases for Testing” on page 6-76
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Examine Test Failures and Modify Baselines
After you run a baseline test in the Test Manager, you can update the baseline. For
example:

• If you changed your model, you can use the new simulation output as the baseline.
You can examine the failures that occurred because of the differences and update the
baseline with part or all of the new output. See “Examine Test Failure Signals and
Update Baseline Test” on page 6-37.

• If your test plan changed and you expect different outputs, you can manually edit the
time points. See “Manually Update Signal Data in a Baseline” on page 6-40.

Examine Test Failure Signals and Update Baseline Test

Suppose that you run a test against a baseline and the result does not match the
baseline, causing test failure. It is possible that the newer simulation better represents
your desired test results or that some of the points of failure are your preferred results.
You can examine the signal and failures in the data inspector view in Test Manager and
decide whether you want to update the baseline or sections of the baseline.

Suppose that your model uses a new solver. When you run the test case, the results do
not match, causing the test to fail.

1 Open the test file that contains the baseline test case you want to run.
2 Select the test case and run it.
3 If the test fails, in the Results and Artifacts pane, expand the Baseline Criteria.

Select a signal that failed that you want to examine.

When you select the signal, the data inspector view opens. The top graph is the
baseline simulation signal overly. The bottom is the difference between those signals
and the tolerance. You can adjust tolerances in the pane in the lower-left corner of
the Test Manager. This example shows an absolute tolerance of .2.
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4 To examine each failure, in the toolstrip, click Next Failure or Previous Failure.
Each contiguous set of failed signal comparison points makes up one region. Data
cursors show the bounds of each region.
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5 You can update the baseline data to use newer simulation results using the Update
Baseline menu.

• To update the entire signal, select Update Baseline Signal.
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• To update only the data in the failure region, select Update Selected Signal
Region.

• To replace all the signal data in the baseline with the new data, select Update
All Signals.

Manually Update Signal Data in a Baseline

If your model changes such that you expect a different simulation output, you can update
all or part of the baseline signal data. If the baseline is a MAT-file, you can edit the data
in the signal editor. Microsoft Excel files open in Excel.

To update signal data in a MAT-file baseline:

1 Open the test file that contains the baseline you want to edit.
2 Select the test case.
3 Under Baseline Criteria, select the baseline whose signal data you want to edit.

Click Edit.

4 The signal editor opens. In the Scenarios and Signals pane, expand the data
node.

5 Select the check box next to the signal whose data you want to edit.
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Tip To see the time and data for points, display a data cursor and drag it along the
signal.

6 Edit the signal data in the table, and then click Apply.
7 To update the baseline with the new expected output data, click Save.

See Also

More About
• “Work with Signal Data” (Simulink)
• “Inspect Simulation Data” (Simulink)
• “Test Model Output Against a Baseline” on page 6-9
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Automate Tests Programmatically
In this section...
“List of Functions and Classes” on page 6-43
“Create and Run a Baseline Test Case” on page 6-45
“Create and Run an Equivalence Test Case” on page 6-46
“Run a Test Case and Collect Coverage” on page 6-47
“Create and Run Test Case Iterations” on page 6-48

List of Functions and Classes
Function Description
sltest.testmanager.view Open the Simulink Test Manager
sltest.testmanager.createTestsFromModel Generate test cases from a model
sltest.import.sldvData Create test cases from Simulink

Design Verifier results
sltest.testmanager.load Load a test file in the Simulink Test

Manager
sltest.testmanager.run Run test in the Simulink Test

Manager
sltest.testmanager.copyTests Copy test cases or test suites to

another location
sltest.testmanager.moveTests Move test cases or test suites to a

new location
sltest.testmanager.report Generate report of test results
sltest.testmanager.clear Clear test files from the Simulink

Test Manager
sltest.testmanager.close Close the Simulink Test Manager
sltest.testmanager.clearResults Clear results from the Simulink

Test Manager
sltest.testmanager.importResults Import Test Manager results file
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Function Description
sltest.testmanager.exportResults Export results set from Test

Manager
sltest.testmanager.getResultSets Returns result set objects in Test

Manager
Class Description
sltest.testmanager.TestFile Create or modify test file
sltest.testmanager.TestSuite Create or modify test suite
sltest.testmanager.TestCase Create or modify test case
sltest.testmanager.TestIteration Create or modify test iteration
sltest.testmanager.ParameterSet Add or modify parameter set
sltest.testmanager.ParameterOverr
ide

Add or modify parameter override

sltest.testmanager.TestInput Add or modify test input
sltest.testmanager.CoverageSettin
gs

Modify coverage settings

sltest.testmanager.BaselineCriter
ia

Add or modify baseline criteria

sltest.testmanager.EquivalenceCri
teria

Add or modify equivalence criteria

sltest.testmanager.SignalCriteria Add or modify signal criteria
sltest.testmanager.Options View or set test file options
sltest.testmanager.ResultSet Access results set data
sltest.testmanager.TestFileResult Access test file results data
sltest.testmanager.TestSuiteResul
t

Access test suite results data

sltest.testmanager.TestCaseResult Access test case results data
sltest.testmanager.TestIterationR
esult

Access test iteration result data

sltest.testmanager.TestResultRepo
rt

Customize generated results report
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Create and Run a Baseline Test Case

This example shows how to use sltest.testmanager functions, classes, and methods
to automate tests and generate reports. You can create a test case, edit the test case
criteria, run the test case, and generate results reports programmatically. The example
compares the simulation output of the model to a baseline.

% Create the test file, test suite, and test case structure
tf = sltest.testmanager.TestFile('API Test File');
ts = createTestSuite(tf,'API Test Suite');
tc = createTestCase(ts,'baseline','Baseline API Test Case');

% Remove the default test suite
tsDel = getTestSuiteByName(tf,'New Test Suite 1');
remove(tsDel);

% Assign the system under test to the test case
setProperty(tc,'Model','sldemo_absbrake');

% Capture the baseline criteria
baseline = captureBaselineCriteria(tc,'baseline_API.mat',true);

% Test a new model parameter by overriding it in the test case
% parameter set
ps = addParameterSet(tc,'Name','API Parameter Set');
po = addParameterOverride(ps,'m',55);

% Set the baseline criteria tolerance for one signal
sc = getSignalCriteria(baseline);
sc(1).AbsTol = 9;

% Run the test case and return an object with results data
ResultsObj = run(tc);

% Open the Test Manager so you can view the simulation
% output and comparison data
sltest.testmanager.view;

% Generate a report from the results data
filePath = 'test_report.pdf';
sltest.testmanager.report(ResultsObj,filePath,...
          'Author','Test Engineer',...
          'IncludeSimulationSignalPlots',true,...
          'IncludeComparisonSignalPlots',true);
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The test case fails because only one of the signal comparisons between the simulation
output and the baseline criteria is within tolerance. The results report is a PDF and
opens when it is completed. For more report generation settings, see the
sltest.testmanager.report function reference page.

Create and Run an Equivalence Test Case

This example compares signal data between two simulations to test for equivalence.

% Create the test file, test suite, and test case structure
tf = sltest.testmanager.TestFile('API Test File');
ts = createTestSuite(tf,'API Test Suite');
tc = createTestCase(ts,'equivalence','Equivalence Test Case');

% Remove the default test suite
tsDel = getTestSuiteByName(tf,'New Test Suite 1');
remove(tsDel);

% Assign the system under test to the test case
% for Simulation 1 and Simulation 2
setProperty(tc,'Model','sldemo_absbrake','SimulationIndex',1);
setProperty(tc,'Model','sldemo_absbrake','SimulationIndex',2);

% Add a parameter override to Simulation 1 and 2
ps1 = addParameterSet(tc,'Name','Parameter Set 1','SimulationIndex',1);
po1 = addParameterOverride(ps1,'Rr',1.20);

ps2 = addParameterSet(tc,'Name','Parameter Set 2','SimulationIndex',2);
po2 = addParameterOverride(ps2,'Rr',1.24);

% Capture equivalence criteria
eq = captureEquivalenceCriteria(tc);

% Set the equivalence criteria tolerance for one signal
sc = getSignalCriteria(eq);
sc(1).AbsTol = 2.2;

% Run the test case and return an object with results data
ResultsObj = run(tc);

% Open the Test Manager so you can view the simulation
% output and comparison data
sltest.testmanager.view;
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In the Equivalence Criteria Result section of the Test Manager results, the yout.Ww
signal passes because of the tolerance value. The other signal comparisons do not pass,
and the overall test case fails.

Run a Test Case and Collect Coverage

This example shows how to use a simulation test case to collect coverage results. To
collect coverage, you need a Simulink Coverage license.

% Create the test file, test suite, and test case structure
tf = sltest.testmanager.TestFile('API Test File');
ts = createTestSuite(tf,'API Test Suite');
tc = createTestCase(ts,'simulation','Coverage Test Case');

% Remove the default test suite
tsDel = getTestSuiteByName(tf,'New Test Suite 1');
remove(tsDel);

% Assign the system under test to the test case
setProperty(tc,'Model','sldemo_autotrans');

% Turn on coverage settings at test-file level
cov = getCoverageSettings(tf);
cov.RecordCoverage = true;

% Enable MCDC and signal range coverage metrics
cov.MetricSettings = 'mr';

% Run the test case and return an object with results data
ro = run(tf);

% Get the coverage results
tfr = getTestFileResults(ro);
tsr = getTestSuiteResults(tfr);
tcs = getTestCaseResults(tsr);
cr = getCoverageResults(tcs);

% Open the Test Manager to view results
sltest.testmanager.view;
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In the Results and Artifacts pane of the Test Manager, you can view the coverage
results in the test case result.

Create and Run Test Case Iterations

This example shows how to create test iterations. You can create table iterations
programmatically that appear in the Iterations section of a test case. The example
creates a simulation test case and assigns a Signal Builder group for each iteration.

% Create test file, test suite, and test case structure
tf = sltest.testmanager.TestFile('Iterations Test File');
ts = getTestSuites(tf);
tc = createTestCase(ts,'simulation','Simulation Iterations');

% Specify model as system under test
setProperty(tc,'Model','sldemo_autotrans');
 
% Set up table iteration
% Create iteration object
testItr1 = sltestiteration;
% Set iteration settings
setTestParam(testItr1,'SignalBuilderGroup','Passing Maneuver');
% Add the iteration to test case
addIteration(tc,testItr1);

% Set up another table iteration
% Create iteration object
testItr2 = sltestiteration;
% Set iteration settings
setTestParam(testItr2,'SignalBuilderGroup','Coasting');
% Add the iteration to test case
addIteration(tc,testItr2);

% Run test case that contains iterations
results = run(tc);

% Get iteration results
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tcResults = getTestCaseResults(results);
iterResults = getIterationResults(tcResults);

See Also
sltest.testmanager.report
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Run Combinations of Tests Using Iterations
In this section...
“Create Table Iterations” on page 6-50
“Create Scripted Iterations” on page 6-53
“Capture Baseline Data from Iterations” on page 6-56
“Sweep Through a Set of Parameters” on page 6-59

Test Manager iterations help you create test cases for multiple sets of data. Use
iterations to test multiple combinations of parameter sets, external inputs, configuration
sets, Signal Builder groups, or baselines. The Iterations section of a test case enables
you to have many iterations in one centralized location.

There are two ways to set up iterations: tabled and scripted. You can use one or both
ways to create iterations in a test case. If you use iterations in a test case where you have
specified coverage settings, then the same coverage settings are applied to all iterations
in the test case.

Create Table Iterations

The Table Iterations section is a quick way to add iterations. The table makes the set of
iterations easy to view at a glance.

1 Add parameter sets, external inputs, configuration sets, Signal Builder groups, or
baselines to a test case if they are applicable to your tests.

2 To add an iteration to the table manually, click Add.
3 By default, the Parameter Set and External Input columns are visible in the

table. To add or remove columns, click the  button, and select a column from the
list.

4 In the iteration row, select the column cell you want to use to change the test setting.
For example, if you want to have an iteration with a parameter set, click the cell
below Parameter Set, and select the parameter set from the list.
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Autogenerated iteration combinations are ordered in lockstep. Lockstep means that each
iteration is formed using sequential pairings of test case settings. For example, the model
sldemo_autotrans has a Signal Builder block with four signal groups, labeled in the
figure as S1, S2, S3, and S4. If you use this model in a test case with three parameter
sets, labeled as P1, P2, and P3, then the Test Manager generates three iterations.
Generated iterations are limited to the minimum number settings between Signal
Builder groups and parameter sets, which is three. Each iteration, labeled as I1, I2, and
I3, contains one Signal Builder group with the corresponding parameter set. The Signal
Builder group and parameter set are matched in the order that they are listed in the
Signal Builder block or parameter set section, respectively.
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In the table iterations, Default [None] means that the iteration does not change the
test case setting. The test iteration setting is the same as what is specified in the test
case.

View Table Iterations

To see a list of iterations from the Table Iterations section, click Show Iterations. The
list includes table iterations and scripted iterations.

Generate Table Iterations

If you have test case settings that you want to transform into test iterations, then you
can use the Auto Generate button. You can select the test case sections to use to
generate iterations. If you select multiple sections, then the Test Manager combines
iterations, and lockstep ordering applies.

When you autogenerate iterations, you can specify the naming rule for each iteration.
Click Auto Generate and select the settings to use as the basis for the iterations. You
can then use a rule to name the iterations to help to identify them. In the Iteration
naming rule box, enter the rule using:

• The name of each setting you want to use in the name, with spaces removed
• An underscore or space to separate each setting

For example, if you want to include the name of the parameter set, configuration set, and
baseline file name, enter ParameterSet_ConfigurationSet_Baseline. When you
generate the iterations, the corresponding names of the test case replace each part of the
rule.
Section Option Purpose
Signal Builder Group Applies to the Inputs section of a

simulation, baseline, or equivalence test
case, for the specified Signal Builder
Group. Each Signal Builder group is used
to generate an iteration.

Parameter Set Applies to the Parameter Overrides
section of a simulation, baseline, or
equivalence test case. Each parameter
override set is used to generate an
iteration.
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Section Option Purpose
External Input Applies to the Inputs section of a

simulation, baseline, or equivalence test
case, for the specified External Inputs
sets. Each external input set is used to
generate an iteration.

Configuration Set Applies to the Configuration Setting
Overrides section of a simulation,
baseline, or equivalence test case. Each
iteration uses the configuration setting
specified.

Baseline Applies only to baseline test case types,
specifically to the Baseline Criteria
section of a baseline test case. Each
baseline criteria set is used to generate an
iteration.

Simulation 1 or 2 Applies only to equivalence test case types.
At the top of the Auto Generate Reports
dialog box, there is a menu for Simulation
1 or Simulation 2. These sections
correspond to the two simulation sections
within the equivalence test case.

Create Scripted Iterations

In the scripted iterations section of the test case, you can customize your own set of
iterations using a programmatic workflow. You can define your own parameter sets,
customize the order of the iterations, create your own Monte Carlo script, and more.
Scripted iterations are generated at run time when a test executes. Enter the script into
the Scripted Iterations section text box.
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Iteration Script Components

An iteration script must have certain components to execute the tests. The basic iteration
script contains three elements: an iteration object, an iteration setting, and the iteration
registration. This script iterates over a single signal builder groups. This example is not
practical, but it is meant to illustrate the anatomy of an iteration script.
%% Iterate Using a Signal Builder Group
 
% Set up a new iteration object
testItr = sltestiteration;

% Set iteration setting using Signal Builder group
setTestParam(testItr,'SignalBuilderGroup',sltest_signalBuilderGroups{1});

% Add the iteration to run in this test case
% The predefined sltest_testCase variable is used here
addIteration(sltest_testCase,testItr);

For more information about the test iteration class, see
sltest.testmanager.TestIteration. In practice, you iterate over numerous
settings, such as multiple Signal Builder groups. If you take the stripped-down iteration
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script and put it into a loop, you can iterate over all Signal Builder groups in the test
case.

%% Iterate Over All Signal Builder Groups
 
% Determine the number of possible iterations
numSteps = length(sltest_signalBuilderGroups);
 
% Create each iteration
for k = 1 : numSteps
    % Set up a new iteration object
    testItr = sltestiteration;
 
    % Set iteration settings
    setTestParam(testItr,'SignalBuilderGroup',sltest_signalBuilderGroups{k});
 
    % Add the iteration to run in this test case
    % You can pass in an optional iteration name
    addIteration(sltest_testCase,testItr);
end

Predefined Variables

You can use predefined variables to write iterations scripts. To see the list of predefined
variables in the Test Manager, expand the Help on creating test iterations section.
You write the iterations script in the script box within the Scripted Iterations section.
The script box is a functional workspace, which means the MATLAB base workspace
cannot access information from the script box. If you define variables in the script box,
then other workspaces cannot use the variable.

The predefined variables are:

• sltest_bdroot — Model simulated by the test case, defined as a string
• sltest_sut — The System Under Test, defined as a string
• sltest_isharness — true if sltest_bdroot is a harness model, defined as a

logical
• sltest_externalInputs — Name of external inputs, defined as a cell array of

strings
• sltest_parameterSets — Name of parameter override sets, defined as a cell array

of strings
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• sltest_configSets — Name of configuration settings, defined as a cell array of
strings

• sltest_tableIterations — Iteration objects created in the iterations table,
defined as a cell array of sltest.testmanager.TestIteration objects

• sltest_testCase — Current test case object, defined as an
sltest.testmanager.TestCase object

Scripted Iteration Templates

You can quickly generate iterations for your test case using templates for Signal Builder
groups, parameter sets, external inputs, configuration sets, and baseline sets, if you are
using a baseline test case. Scripted iteration templates follow lockstep ordering and
pairing of test settings. For more information about lockstep ordering, see “Create Table
Iterations” on page 6-50.

For example, if you want to run all signal builder groups in a scripted iteration:

1 Click Iteration Templates.
2 Select the test case settings you want to iterate through. Click OK.

The script is generated and added to the script box below any existing scripts.
3 To generate a table that gives a preview of the iterations that execute when you run

the test case, click Show Iterations.

Capture Baseline Data from Iterations

This example shows how to create a baseline test by capturing data from a test case with
table iterations. You create the iterations from Signal Builder groups in the model.
Before running the example, navigate to a writable folder on the MATLAB® path.

1. Open the model. At the command line, enter

Model = 'sltestCar';
open_system(fullfile(matlabroot,'examples','simulinktest',Model));
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2. Create a test file that contains iterations, and open the Test Manager. At the
command line, enter

tf = sltest.testmanager.TestFile('IterationBaselineTest');
sltest.testmanager.load(tf.Name);
sltest.testmanager.view;

3. In the Test Manager, right-click the test case and select Rename. Rename the test
case Baseline Test.

4. In the System Under Test section, for Model, enter sltestCar.

5. Select the signals for the baseline data:

1 In the Simulation Outputs section, click Add. The Signal Selection dialog box
appears.

2 In the model canvas, select the output torque and vehicle speed signals. The
signals appear in the Signal Selection dialog box.

3 In the dialog box, select both signals and click Add.
4 The signals appear in the Logged Signals table.
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6. Add iterations for the test case:

1 Expand the Iterations section of the test case.
2 Expand the Table Iterations section and click Auto Generate.
3 In the dialog box, select Signal Builder Group. Click OK.
4 The table lists the iterations corresponding to the four Signal Builder groups.

7. Capture baseline data for the iterations:

1 In the Baseline Criteria section, click the arrow next to Capture, and select
Capture for Iterations.

2 Specify a location for the baseline data files.
3 Click Create.

The model simulates for all Signal Builder groups. The baseline data for
output_torque and vehicle_speed are captured in four MAT files. Also, each
baseline data set is added to its corresponding iterations in the table.
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Sweep Through a Set of Parameters

Scripted iterations can be used to test a model by sweeping through a set of parameters.
In this example of a parameter sweep, the number of Signal Builder groups and
parameter values is the same. Each iteration has one Signal Builder group and one
parameter value for a total of four iterations.

%% Iterate over all Signal Builder Groups and Parameters
 
% Determine the number of possible iterations
numSteps = length(sltest_signalBuilderGroups);

% Set up the parameter values to sweep over
IeiValues = [0.021,0.022,0.022,0.023];

% Create each iteration
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for k = 1 : numSteps
    % Set up a new iteration object
    testItr = sltestiteration;
 
    % Set Signal Builder iteration setting
    setTestParam(testItr,'SignalBuilderGroup',sltest_signalBuilderGroups{k});
    
    % Set value of lei (parameter in model workspace)
    setVariable(testItr,'Name','Iei','Source','model workspace',...
                'Value',IeiValues(k));
 
    % Add the iteration to run in this test case
    addIteration(sltest_testCase,testItr); 
end

See Also
sltest.testmanager.TestIteration

Related Examples
• “Automate Tests Programmatically” on page 6-43
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Collect Coverage in Tests

In this section...
“Considerations for Collecting Coverage in Test Harnesses” on page 6-61
“Enable and Collect Coverage for a Test File” on page 6-62

If you use Simulink Coverage to generate model and code coverage, then you can also
apply coverage collection to your test cases. If you turn on coverage collection in a test
file, test suite, or test case, then the test case runs in the Test Manager, collects coverage,
and generates an aggregated report of the coverage in the test results.

For example, to test a model for coverage, turn on coverage at the test file, test suite, or
the individual test case level. If you set coverage settings at the test file level, then the
test suite and test cases in the test file inherit the coverage settings. At the test case and
test suite level, you can turn coverage collection on or off, but you cannot adjust the
coverage metrics if they are specified at the test file level.

Considerations for Collecting Coverage in Test Harnesses

Loading coverage results to a model, or aggregating coverage results across models,
requires a model consistent with the coverage results. Therefore, to perform aggregated
coverage collection, it is recommended that you use test harnesses configured to
automatically synchronize the component under test. Set SynchronizationMode to
Synchronize on harness open and close. For more information, see “Synchronize
Changes Between Test Harness and Model” on page 2-54.

Coverage results association depends on test harness – main model synchronization:

• If the test harness is configured to synchronize the component under test when you
open or close the harness, coverage results from the test harness are associated with
the main model. When you close the test harness, the coverage results remain active
in memory. You can aggregate coverage with additional results collected from the
main model or another synchronized test harness.

• If the test harness is configured to only synchronize the component under test when
you manually push or rebuild, the coverage results are associated with the test
harness.

• When you close the test harness, the coverage results are removed from memory.
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• If the component under test design differs between test harness and main model,
you cannot aggregate coverage results.

• You can aggregate coverage results with the main model if the component under
test design does not differ, but you must manually load the coverage results into
the main model. See the function cvload.

Enable and Collect Coverage for a Test File

This procedure outlines how to enable coverage collection when you run a test file, view
coverage results in the Test Manager, and trace coverage results from the Test Manager
to the model.

1 Select the test file in the Test Browser pane.

2 Expand the Coverage Settings section in the test file and select Record coverage
for system under test. To collect coverage for referenced models, select Record
coverage for referenced models.

3 Select coverage metrics. For more information about the types of model coverage, see
“Types of Model Coverage” (Simulink Coverage).
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4 Run the test file.
5 To view the collected coverage results, select a test case result in the Results and

Artifacts pane and expand the Coverage Results section of the test case result.

This example shows results for an iteration of a test case.

6 To view the aggregated coverage for a test case, test suite, or test file, select the
corresponding result, then expand the Aggregated Coverage Results section of
the test file result. At the test suite and test file result level, the coverage is grouped
and aggregated by model.
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7 To view the coverage results graphically in the model, click the model name link in
the coverage results table.

Once the model opens, you can select parts of the model to see the coverage data.
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To view the coverage results programmatically, see “Automate Tests Programmatically”
on page 6-43 and the sltest.testmanager.CoverageSettings class.

See Also
“Specify Coverage Options” (Simulink Coverage) | “Perform Functional Testing and
Analyze Test Coverage” on page 9-9

 See Also
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Run Tests Using Parallel Execution

In this section...
“Use Parallel Execution” on page 6-66
“When Do Tests Benefit from Using Parallel Execution?” on page 6-67

If you have a license to Parallel Computing Toolbox, then you can execute tests in
parallel using a parallel pool (parpool). Running tests in parallel can speed up execution
and decrease the amount of time it takes to get test results.

Use Parallel Execution

To run a test file using parallel execution:

1 The Test Manager uses the default Parallel Computing Toolbox cluster. For
information about where to specify or change the cluster, see “Discover Clusters and
Use Cluster Profiles” (Parallel Computing Toolbox).

2 On the Test Manager toolstrip, click the Parallel button.

3 Run a test file. The test file executes using parallel pool.
4 To turn off parallel execution, click the Parallel button to toggle it off.

Starting a parallel pool can take time, which would slow down test execution. To reduce
time:

• Make sure that the parallel pool is already running before you run a test. By default,
the parallel pool shuts down after being idle for a specified number of minutes. To
change the setting, see “Specify Your Parallel Preferences” (Parallel Computing
Toolbox).

• Load Simulink on all the parallel pool workers.
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When Do Tests Benefit from Using Parallel Execution?

In general, parallel execution can help reduce test execution time if you have

• A complex Simulink model that takes a long time to simulate.
• A large number of long-running tests, such as iterations.

See Also
sltest.testmanager.run

Related Examples
• “Clusters and Clouds” (Parallel Computing Toolbox)

 See Also
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Apply Tolerances to Test Criteria
In this section...
“Modify Criteria Tolerances” on page 6-68
“Change Leading Tolerance in a Baseline Comparison Test” on page 6-68

You can specify tolerances in the Baseline Criteria or Equivalence Criteria sections
of baseline and equivalence test cases. You can specify relative, absolute, leading, and
lagging tolerances for a signal comparison.

To learn about how tolerances are calculated, see “How the Simulation Data Inspector
Compares Data” (Simulink).

Modify Criteria Tolerances

To modify a tolerance, select the signal name in the criteria table, double-click the
tolerance value, and enter a new value.

If you modify a tolerance after you run a test case, rerun the test case to apply the new
tolerance value to the pass-fail results.

Change Leading Tolerance in a Baseline Comparison Test

Specify a tolerance when the difference between results falls in a range you consider
acceptable. Suppose that your model under test uses a particular solver. Solvers are
sometimes updated from one release to the next, and new solvers also become available.
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If you use an updated solver or change solvers, you can specify an acceptable tolerance
for differences between your baseline and later tests.

Generate the Baseline

Generate the baseline for the sf_car model, which uses the ode-5 solver.

1 Open the model sf_car.
2 Open the Test Manager and create a test file named Solver Compare. In the test

case, set the system under test to sf_car.
3 Select the signal to log. Under Simulation Outputs, click Add. In the model, select

the shift_logic output signal. In the Signal Selection dialog box, select the check
box next to shift_logic and click Add.

4 Save the baseline. Under Baseline Criteria, click Capture. Set the file format to
MAT. Name the baseline solver_baseline and click Save.

After you save the baseline MAT-file, the model runs and the baseline criteria
appear in the table. Each default tolerance is 0.

Change Solvers and Run the Test Case

Suppose that you want to use a different solver with your model. You run a test to
compare results using the new solver with the baseline.

1 In the model, change the solver to ode-1.
2 In the Test Manager, with the Solver Compare test file selected, click Run.

In the Results and Artifacts pane, notice that the test failed.
3 Expand the results of the failed test. Under Baseline Criteria Result, select the

shift_logic signal.

The Comparison tab shows where the difference occurred.

 Apply Tolerances to Test Criteria

6-69

matlab:open_system('sf_car')


4 Zoom the comparison chart where the results diverged. The comparison signal
changes ahead of the baseline, that is, it leads the baseline signal.
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Preview and Set a Leading Tolerance Value

Suppose that your team determines that a tolerance the size of the simulation step size (.
04 in this case) is acceptable. In the Test Manager, set a leading tolerance value. Use a
leading tolerance for the signal whose change occurs ahead of your baseline. Use a
lagging tolerance for a signal whose change occurs after your baseline.

You can preview how the tolerance value affects the test to see if the test passes with the
specified tolerance. Then set the tolerance on the baseline criteria and rerun the test.

1 Preview whether the tolerance you want to use causes the test to pass. With the
result signal selected, in the property box, set Leading Tolerance to .04.
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When you change this value, the status changes to show that the failed tests pass.
2 When you are satisfied with the tolerance value, enter it in the baseline criteria so

you can rerun the test and save the new pass-fail result. In the Test Browser pane,
select the test case in the Solver Compare test.

3 Under Baseline Criteria, change the LD TOL (leading tolerance) value for the
solver_baseline.mat file to .04.

By default, each signal inherits this value from the baseline file. You can override
the value for each signal.
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4 Run the test again. The test passes.
5 To store the tolerance value and the passed test with the test file, save the test file.

See Also
sltest.testmanager.BaselineCriteria |
sltest.testmanager.SignalCriteria

Related Examples
• “Test Model Output Against a Baseline” on page 6-9

 See Also
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Test Manager Limitations
In this section...
“Simulation Mode” on page 6-74
“Callback Scripts” on page 6-74
“Protected Models” on page 6-74
“Parameter Overrides” on page 6-75
“Breakpoints” on page 6-75
“Highlight in Model” on page 6-75

Simulation Mode
There are some limitations for the simulation mode in test cases:

• The System Under Test cannot be in fast restart or external mode for test
execution.

• A test that is running with the System Under Test simulation mode set to Rapid
Accelerator cannot be stopped using Stop on the Test Manager toolstrip. To stop the
test, enter Ctrl+C in the MATLAB command prompt.

• If you run a test using parallel execution in rapid accelerator mode, streamed signals
do not show up in the Test Manager.

Callback Scripts
The test case callback scripts are not stored with the model and do not override Simulink
model callbacks. Test case callback scripts have some limitations:

• The Test Manager cannot stop the execution of an infinite loop inside a callback
script. To stop execution of an infinite loop from a callback script, press Ctrl+C at the
MATLAB command prompt.

• sltest.testmanager functions are not supported.

Protected Models
You cannot specify a protected model as the model used for a test case in the System
Under Test section.
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Parameter Overrides

The Test Manager displays only top-level system parameters from the system under test.

Breakpoints

Breakpoints in Simulink and Stateflow are not supported and interrupt test execution
without warning.

Highlight in Model

If you use parallel test execution to run your tests, then you cannot use the Highlight in
Model button for verify signals.
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Test Sections

In this section...
“Select Releases for Testing” on page 6-76
“Set Preferences to Display Test Sections” on page 6-77
“Select releases for simulation” on page 6-77
“Tags” on page 6-77
“Description” on page 6-77
“Requirements” on page 6-78
“System Under Test” on page 6-78
“Parameter Overrides” on page 6-79
“Callbacks” on page 6-80
“Inputs” on page 6-81
“Simulation Outputs” on page 6-81
“Configuration Setting Overrides” on page 6-82
“Simulation 1 and Simulation 2” on page 6-82
“Equivalence Criteria” on page 6-82
“Baseline Criteria” on page 6-83
“Custom Criteria” on page 6-84
“Iterations” on page 6-84
“Coverage Settings” on page 6-85
“Test File Options” on page 6-85

To view or edit the test sections, select a test file, suite, or case in the Test Browser
pane. For information on the types of test cases, see “Introduction to the Test Manager”
on page 5-2.

Select Releases for Testing

You can select MATLAB releases installed on your system to create and run tests in. Use
this preference to specify the MATLAB installations that you want to make available for
testing with Test Manager. You can use releases from R2011b forward. The releases you

6 Test Manager Test Cases

6-76



add become available to select from the Select releases for simulation list when you
design the test.

You can add releases to the list and delete them. You cannot delete the release you
started MATLAB in.

To add a release, click Add, navigate to the location of the MATLAB installation you
want to add, and click OK.

For more information, see “Run Tests in Multiple Releases” on page 6-32.

Set Preferences to Display Test Sections
To simplify the Test Manager layout, you can select the sections of the test case, test
suite, or test file that appear in the Test Manager. Test case sections that were modified
appear in the Test Manager, regardless of the preference setting.

1 In the toolstrip, click Preferences.
2 Select the Test File, Test Suite, or Test Case tab.
3 Select sections to show, or clear sections to hide. To show only sections where

settings are set, clear all selections in the Preferences dialog box.
4 Click OK.

Also see sltest.testmanager.getpref and sltest.testmanager.setpref.

Select releases for simulation
Select the releases that you want available for running test cases. Build the list of
releases using the Release pane in the Test Manager Preferences dialog box. For more
information, see “Run Tests in Multiple Releases” on page 6-32.

Tags
Tag your tests with useful categorizations, such as safety, logged-data, or burn-in.
Filter tests using these tags when executing tests or viewing results. See “Filter Test
Execution and Results” on page 6-115.

Description
In this section, add descriptive text to your test case, test suite, or test file.
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Requirements

If you have a Simulink Requirements license, you can create, edit, and delete
requirements traceability links for a test case, test suite, or test file. To add requirements
links:

1 Click Add.
2 In the Link Editor dialog box, click New to add a requirement link to the list.
3 Type the name of the requirement link in the Description box.
4 Click Browse and locate the requirement file. Click Open. For more information on

supported requirements document types, see “Supported Requirements Document
Types” (Simulink Requirements).

5 Click OK. The requirement link appears in the Requirements list if a document is
specified in the Link Editor.

If you have a section of a document open and ready to add as a requirement, then you can
add it quickly. Highlight the section, click the Add arrow, and select the section type.

For more information about the Link Editor, see “Requirements Traceability Link
Editor” (Simulink Requirements).

System Under Test

Specify the model you want to test in the System Under Test section. To use an open
model in the currently active Simulink window, click the Use current model button

.

Note The model must be available on the path to run the test case. You can set the path
programmatically using the preload callback. See “Callbacks” on page 6-80.

Specifying a new model in the System Under Test section can cause the model
information to be out of date. To update the model test harnesses, Signal Builder groups,

and available configuration sets, click the Refresh button .
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Test Harness

If you have a test harness in your system under test, then you can select the test harness
to use for the test case. If you have added or removed testy harnesses in the model, click

the Refresh button  to view the updated test harness list.

For more information about using test harnesses, see “Refine, Test, and Debug a
Subsystem” on page 2-20.

Simulation Settings

You can override the System Under Test simulation settings such as the simulation
mode, start time, stop time, and initial state.

Parameter Overrides

In this section, you can specify parameter values in the test case to override the
parameter values in the model workspace, data dictionary, or base workspace.
Parameters are grouped into sets. You can turn parameter sets and individual parameter
overrides on or off by using the check box next to the set or parameter.

To add a parameter override:

1 Click Add.

A dialog box opens with a list of parameters. If the list of parameters is not current,

click the Refresh button  in the dialog box.
2 Select the parameter you want to override.
3 To add the parameter to the parameter set, click OK.
4 Enter the override value in the parameter Override Value column.

To restore the default value of a parameter, clear the value in the Override Value
column and press Enter.

You can also add a set of parameter overrides from a MAT-file. Click the Add arrow and
select Add File to create a parameter set from a MAT-file.

For an example that uses parameter overrides, see “Overriding Model Parameters in a
Test Case”.
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Callbacks
Test-File Level Callbacks

Two callback scripts are available in each test suite that execute at different times
during a test:

• Setup runs before test file executes.
• Cleanup runs after test file executes.

Test-Suite Level Callbacks

Two callback scripts are available in each test suite that execute at different times
during a test:

• Setup runs before the test suite executes.
• Cleanup runs after the test suite executes.

Test-Case Level Callbacks

Three callback scripts are available in each test case that execute at different times
during a test:

• Pre-load runs before the model loads and before the model callbacks.
• Post-load runs after the model loads and the PostLoadFcn model callback.
• Cleanup runs after simulations and model callbacks.

To run a single callback script, click the Run button  above the corresponding script.

See “Test Manager Limitations” on page 6-74 for the limitations of callback scripts in test
cases. For information on Simulink model callbacks, see “Model Callbacks” (Simulink).

You can use these predefined variables in the test case callbacks:

• sltest_bdroot available in Post-Load: The model simulated by the test case. The
model can be a harness model.

• sltest_sut available in Post-Load: The system under test. For a harness, it is the
component under test.

• sltest_isharness available in Post-Load: Returns true if sltest_bdroot is a
harness model.
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• sltest_simout available in Cleanup: Simulation output produced by simulation.
• sltest_iterationName available in Pre-Load, Post-Load, and Cleanup: Name

of the currently executing test iteration.

Inputs

For test inputs, you can use inputs from signal builder groups in the model, or you can
use external inputs from MAT-files or Microsoft Excel files.

• To use inputs from a Signal Builder block group in the model or test harness, select
the Signal Builder Group check box, and then select the group from the list.

• To select an external input set in the External Inputs table to run when the test
case executes, click Add. Select a MAT-file or Microsoft Excel file to import as inputs
to your test case. Select the file you want to use from the table.

For more information on using external files as inputs, see “Use External Inputs in
Test Cases” on page 6-30. For information about the file format for Microsoft Excel
files in Test Manager, see “Specify Microsoft Excel File Format for Signal Data” on
page 6-23.

Edit Input Data Files in Test Manager

From the Test Manager, you can edit your input data files.

To edit a file, select the file and click Edit. You can then edit the data in the signal editor
for MAT-files or Microsoft Excel for Excel files.

To learn about the syntax for Excel files, see “Specify Microsoft Excel File Format for
Signal Data” on page 6-23.

Simulation Outputs

Use the Simulation Outputs section to add signal outputs to your test results. Signals
logged in your model or test harness show up in the results. You add signals to log or add
a signal set.

Adding signals to log to the test case does not alter the model or test harness.

1 Under Simulation Outputs, click Add.
2 In the system under test, select the signals you want to log.
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3 In the Signal Selection dialog box, select the check box next to the signals whose
output you want to capture, and click Add.

To add a signal set, click the Add arrow and select Signal Set.

Configuration Setting Overrides

In the test case, you can specify configuration settings that differ from the settings in the
model. Setting the configuration settings in the test case enables you to try different
configurations without modifying your model.

Simulation 1 and Simulation 2

These sections appear in equivalence test cases. Use them to specify the details about the
simulations that you want to compare. Enter the system under test, the test harness if
applicable, and simulation setting overrides under Simulation 1. You can then click
Copy settings from Simulation 1 under Simulation 2 to use a starting point for your
second set of simulation settings.

For the test to pass, Simulation 1 and Simulation 2 must log the same signals.

Use these sections with the Equivalence Criteria section to define the premise of your
test case. For an example of an equivalence test, see “Test Two Simulations for
Equivalence”.

Equivalence Criteria

This section appears in equivalence test cases. The equivalence criteria is a set of signal
data to compare in Simulation 1 and Simulation 2. Specify tolerances to regulate pass-
fail criteria of the test. You can specify absolute, relative, leading, and lagging tolerances
for the signals.

To specify tolerances, first click Capture to run the system under test in Simulation 1
and add signals marked for logging to the table. Specify the tolerances in the table.

After you capture the signals, you can select signals from the table to narrow your
results. If you do not select signals under Equivalence Criteria, running the test case
compares all the logged signals in Simulation 1 and Simulation 2.

For an example of an equivalence test case, see “Test Two Simulations for Equivalence”.
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Baseline Criteria

The Baseline Criteria section appears in baseline test cases. When a baseline test case
executes, the Test Manager captures signal data from signals in the model marked for
logging and compares them to the baseline criteria.

Capture Baseline Criteria

To capture logged signal data from the system under test to use as the baseline criteria,
click Capture. Then follow the prompts in the Capture Baseline dialog box. Capturing
the data compiles and simulates the system under test and stores the output from the
logged signals to the baseline. For a baseline test example, see “Test Model Output
Against a Baseline” on page 6-9.

You can save the signal data to a MAT-file.

You can capture the baseline criteria using the current release for simulation or another
release installed on your system. Add the releases you want to use in the Test Manager
preferences. Then select the releases you want available in your test case using the
Select releases for simulation option in the test case. When you run the test, you can
compare the baseline against the release you created the baseline in or against another
release. For more information, see “Run Tests in Multiple Releases” on page 6-32.

Specify Tolerances

You can specify tolerances to determine the pass-fail criteria of the test case. You can
specify absolute, relative, leading, and lagging tolerances for individual signals or the
entire baseline criteria set.

After you capture the baseline, the baseline file and its signals appear in the table. In the
table, you can set the tolerances for the signals. To see tolerances used in an example for
baseline testing, see “Test Model Output Against a Baseline” on page 6-9.

Import File as Baseline

By clicking Add, you can select an existing file as a baseline, either from another test
case or from an external file. You can import MAT-files and Microsoft Excel files as the
baseline. Format Microsoft Excel files as described in “Specify Microsoft Excel File
Format for Signal Data” on page 6-23.

To learn how to import MAT-files and Microsoft Excel files as the baseline, see “Use
External Inputs in Test Cases” on page 6-30.
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Update Signal Data in Baseline

You can edit the signal data in your baseline, for example, if your model changed and you
expect different values. To open the signal editor or the Microsoft Excel file for editing,
select the baseline file from the list and click Edit. See “Manually Update Signal Data in
a Baseline” on page 6-40.

You can also update your baseline when you examine test failures in the data inspector
view. See “Examine Test Failures and Modify Baselines” on page 6-37.

Custom Criteria

This section includes an embedded MATLAB editor to define custom pass/fail criteria for
your test. Select function customCriteria(test) to enable the criteria script in the
editor. Custom criteria operate outside of model run time; the script evaluates after
model simulation.

Common uses of custom criteria include verifying signal characteristics or verifying test
conditions. MATLAB Unit Test qualifications provide a framework for verification
criteria. For example, this custom criteria script gets the last value of the signal PhiRef
and verifies that it equals 0:
% Get the last value of PhiRef from the dataset Signals_Req1_3
lastValue = test.sltest_simout.get('Signals_Req1_3').get('PhiRef').Values.Data(end);

% Verify that the last value equals 0
test.verifyEqual(lastValue,0);

See “Apply Custom Criteria to Test Cases” on page 6-91. For a list of MATLAB Unit
Test qualifications, see “Types of Qualifications” (MATLAB).

You can also define plots in the Custom Criteria section. See “Create, Store, and Open
MATLAB Figures” on page 6-103.

Iterations

Use this test case section to generate test iterations for multiple combinations of test
settings. Iterations are helpful for Monte Carlo or parameter sweep tests. For more
information about test iterations, see “Run Combinations of Tests Using Iterations” on
page 6-50.
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Coverage Settings

Use this test section to configure coverage collection for test files, test suites, and test
cases. For more information about collecting coverage in your test, see “Collect Coverage
in Tests” on page 6-61.

Test File Options

Close open figures at the end of execution

When your tests generate figures, select this option to clear the working environment of
figures after the test execution completes.

Store MATLAB figures

Select this option to store figures generated during the test with the test file. You can
enter MATLAB code that creates figures and plots as a callback or in the test case
Custom Criteria section. See “Create, Store, and Open MATLAB Figures” on page 6-
103.

Generate report after execution

Select Generate report after execution to create a report after the test executes.
Selecting this option displays report options that you can set. The settings are saved with
the test file.

For detailed reporting information, see “Export Test Results and Generate Reports” on
page 7-9 and “Customize Test Reports” on page 7-14.

See Also
sltest.testmanager.getpref | sltest.testmanager.setpref
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Test Models Using Inputs Generated by Simulink Design Verifier

In this section...
“Overall Workflow” on page 6-86
“Test Case Generation Example” on page 6-87

Using Simulink Design Verifier, you can generate tests that replicate design errors,
achieve test objectives, or exercise your model to meet coverage criteria. Over the course
of developing your model and generating code, you repeatedly exercise your model and
code with these test inputs. You can simplify repeated testing using Simulink Test to
automatically create test cases that use inputs generated using Simulink Design Verifier
analysis.

Overall Workflow

Test case generation follows this workflow.

1 Choose an existing Simulink Design Verifier results file, or generate new results by
analyzing your model.

• If you use an existing results file, you can load results by either:

• Using the Simulink Test command sltest.import.sldvData.
• Using Simulink Design Verifier menu items. In the model, select Analysis >

Design Verifier > Results > Load. Select the MAT file with the analysis
results.

• If you run a model analysis, the Simulink Design Verifier Results Summary
window appears after the analysis completes.

2 In the results summary window, click Export test cases to Simulink Test.
3 Enter the name of an existing or new test harness.
4 Select a test harness source for the generated test inputs. You can select

• Inport: The inputs are contained in the Simulink Design Verifier data file and
mapped to Inport blocks in the test harness. The mapping is shown in the Inputs
section of the test case in the Test Manager. Using the Inport option allows you
to map other inputs to the test harness Inport blocks, which can be useful for
running multiple test cases or iterations using the same test harness.
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• Signal Builder: The inputs are contained in groups in a Signal Builder block
inside the test harness. Using the Signal Builder option allows you to easily
view the test inputs in the Signal Builder block editor.

5 Select a new or existing test file, and enter names for the test file and test case.
6 Click OK to export the test cases to Simulink Test. The test files and test cases are

updated in the Test Manager.

Test Case Generation Example

This example shows how to generate test cases for a controller subsystem using Simulink
Design Verifier, and export the test cases to a test file in Simulink Test. The example
requires a Simulink Design Verifier license.

The model is a closed-loop heat pump system. The controller accepts the measured room
temperature and set temperature inputs. The controller outputs a bus of three signals
controlling the fan, heat pump, and the direction of the heat pump (heat or cool). The
model contains a harness that tests heating and cooling scenarios.

1 Open the model.

open_system(fullfile(docroot,'toolbox','sltest','examples',...
'sltestTestCaseFromDVExample.slx'));

2 Set the current working folder to a writable folder.
3 In the model, generate tests for the Controller subsystem. Right-click the

Controller block and select Design Verifier > Generate Tests for Subsystem.

Simulink Design Verifier generates tests for the component.
4 In the results summary window, click Export test cases to Simulink Test.
5 In the Export Design Verifier Test Cases dialog box, enter:

• Test Harness: TestHarness1
• Harness Source: Signal Builder
• Select Use a new test file
• Test File: ./TestFile_GeneratedTests.mldatx
• Test Case: <Create a new test case>

6 Click OK.
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A new test file is created in the working folder, and a test harness is added to the
main model, owned by the Controller subsystem. Click the harness badge to
preview the new test harness.

7 Click the TestHarness1 thumbnail to open the harness, and double-click the Signal
Builder block source to see the generated inputs.

6 Test Manager Test Cases

6-88



8 In the Test Manager, the new test case displays the system under test, and the test
harness containing the generated inputs in the Signal Builder source. Expand the
Iterations section to see the iterations corresponding to the signal builder groups.
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See Also
sltest.import.sldvData
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Apply Custom Criteria to Test Cases

In this section...
“MATLAB Testing Framework” on page 6-91
“Define a Custom Criteria Script” on page 6-92
“Reuse Custom Criteria and Debug Using Breakpoints” on page 6-93
“Assess the Damping Ratio of a Flutter Suppression System” on page 6-95
“Custom Criteria Programmatic Interface Example” on page 6-100

Testing your model often requires assessing conditions that ensure a test is valid, in
addition to verifying model behavior. MATLAB Unit Test provides a framework for such
assessments. In Simulink Test, you can use the test case custom criteria to author
specific assessments, and include MATLAB Unit Test qualifications in your script.

Custom criteria apply as post-simulation criteria to the simulation output. If you require
run-time verifications, use a verify() statement in a Test Assessment or Test Sequence
block. See “Assess Simulation Using Logical Statements” on page 3-32.

MATLAB Testing Framework

A custom criteria script is a method of test, which is a matlab.unittest test case
object. To enable the function, in the test case Custom Criteria section of the Test
Manager, select function customCriteria(test). Inside the function, enter the custom
criteria script in the embedded MATLAB editor.

The embedded MATLAB editor lists properties of test. Create test assessments using
MATLAB Unit Test qualifications. Custom criteria supports verification and assertion
type qualifications. See “Types of Qualifications” (MATLAB). Verifications and assertions
operate differently when custom criteria are evaluated:

• Verifications – Failures appear in the test results and other assessments are
evaluated. Use verifications for general assessments, such as checking simulation
against expected outputs.

Example: test.verifyEqual(lastValue,0)
• Assertions – Use assertions for conditions that render the criteria invalid. Failures

appear in the test results and the custom criteria script evaluation exits.
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Example: test.assertEqual(lastValue,0).

Define a Custom Criteria Script

This example shows how to create a custom criteria script for an autopilot test case.

1 Open the test file.

open AutopilotTestFile.mldatx
2 In the Test Browser, select AutopilotTestFile > Basic Design Test Cases >

Requirement 1.3 Test. In the test case, expand the Custom Criteria section.
3 Enable the custom criteria script by selecting function customCriteria(test).
4 In the embedded MATLAB editor, enter the following script. The script gets the final

value of the signals Phi and APEng, and verifies that the final values equal 0.

% Get the last values
lastPhi = test.sltest_simout.get('Signals_Req1_3').get('Phi').Values.Data(end);
lastAPEng = test.sltest_simout.get('Signals_Req1_3').get('APEng').Values.Data(end);

% Verify the last values equal 0
test.verifyEqual(lastPhi,0,['Final Phi value: ',num2str(lastPhi),'.']);
test.verifyEqual(lastAPEng,false,['Final APEng value: ',num2str(lastAPEng),'.']);

5 Run the test case.
6 In the Results and Artifacts pane, expand the Custom Criteria Result. Both

criteria pass.
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Reuse Custom Criteria and Debug Using Breakpoints

In addition to authoring criteria scripts in the embedded MATLAB editor, you can author
custom criteria in a standalone function, and call the function from the test case. Using a
standalone function allows you

• To reuse the custom criteria in multiple test cases.
• To set breakpoints in the criteria script for debugging.
• To investigate the simulation output using the command line.

In this example, you add a breakpoint to a custom criteria script. You run the test case,
list the properties of the test object at the command line, and call the custom criteria
from the test case.

Call Custom Criteria Script from the Test Case

1 Navigate to the folder containing the criteria function.

cd(fullfile(docroot,'toolbox','sltest','examples'))
2 Open the custom criteria script

open('sltestCheckFinalRollRefValues.m')
% This is a custom criteria function for a Smiulink Test test case.
% The function gets the last values of Phi and APEng from the 
% Requirements 1.3 test case in the test file AutopilotTestFile.

function sltestCheckFinalRollRefValues(test)

% Get the last values
lastPhi = test.sltest_simout.get('Signals_Req1_3').get('Phi').Values.Data(end)
lastAPEng = test.sltest_simout.get('Signals_Req1_3').get('APEng').Values.Data(end)

% Verify the last values equal 0
test.verifyEqual(lastPhi,0,['Final Phi value: ',num2str(lastPhi),'.']);
test.verifyEqual(lastAPEng,false,['Final APEng value: ',num2str(lastAPEng),'.']);

3 Open the test file

open AutopilotTestFile.mldatx
4 In the embedded MATLAB editor under Custom Criteria, enter the function call to

the custom criteria:
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sltestCheckFinalRollRefValues(test)

Set Breakpoints and List test Properties

1 On line 8 of sltestCheckFinalRollRefValues.m, set a breakpoint by clicking the
dash to the right of the line number.

2 In the Test Manager, run the test case.

The command window displays a debugging prompt.
3 Enter test at the command prompt to display the properties of the

STMCustomCriteria object. The properties contain characteristics and simulation
data output of the test case.
test = 

  STMCustomCriteria with properties:

              TestResult: [1×1 sltest.testmanager.TestCaseResult]
                  sltest_simout: [1×1 Simulink.SimulationOutput]
         sltest_testCase: [1×1 sltest.testmanager.TestCase]
           sltest_bdroot: {'RollReference_Requirement1_3'}
              sltest_sut: {'RollAutopilotMdlRef/Roll Reference'}
        sltest_isharness: 1
    sltest_iterationName: ''

The property sltest_simout contains the simulation data. To view the data
PhiRef, enter

test.sltest_simout.get('Signals_Req1_3').get('PhiRef')

ans = 

  Simulink.SimulationData.Signal
  Package: Simulink.SimulationData

  Properties:
  struct with fields:

              Name: 'PhiRef'
    PropagatedName: ''
         BlockPath: [1×1 Simulink.SimulationData.BlockPath]
          PortType: 'outport'
         PortIndex: 1
            Values: [1×1 timeseries]
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4 In the MATLAB editor, click Continue to continue running the custom criteria
script.

5 In the Results and Artifacts pane, expand the Custom Criteria Result. Both
criteria pass.

6 To reuse the script in another test case, call the function from the test case custom
criteria.

Assess the Damping Ratio of a Flutter Suppression System

Use a custom criteria script to verify the damping ratio in a test case that simulates the
flutter suppression system of a wing.

The Simulation and Model

The model uses Simscape™ to simulate a Benchmark Active Controls Technology
(BACT) / Pitch and Plunge Apparatus (PAPA) setup. It uses Aerospace Blockset™ to
simulate arodynamic forces on the wing.

The test iterates over 16 combinations of Mach and Altitude. The test case uses custom
criteria with Curve Fitting Toolbox™ to find the peaks of the wing pitch, and determine
the damping ratio. If the damping ratio is not greater than zero, the assessment fails.

Running this test case requires

• Simulink® Test™
• Simscape Multibody™
• Aerospace Blockset™
• Curve Fitting Toolbox™

Open the model and the test file.

open_system(fullfile(matlabroot,'examples','simulinktest',...
    'sltestFlutterSuppressionSystemExample.slx'))
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open(fullfile(matlabroot,'examples','simulinktest',...
    'sltestFlutterCriteriaTest.mldatx'))

Custom Criteria Script

The test case custom criteria uses this script to verify that the damping ratio is greater
than zero.

% Get time and data for pitch
Time = test.sltest_simout.get('sigsOut').get('pitch').Values.Time(1:15000);
Data = test.sltest_simout.get('sigsOut').get('pitch').Values.Data(1:15000);

% Find peaks
[~, peakIds] = findpeaks(Data,'minpeakheight', 0.002, 'minpeakdistance', 50);
peakTime= Time(peakIds);
peakPos = Data(peakIds);
rn = peakPos(1)./peakPos(2:end);
L = 1:length(rn);
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% Do curve fitting
fittedModel = exponentialFitAndPlot(L, rn);
delta = fittedModel.d;

% Find damping ratio
dRatio = delta/sqrt((2*pi)^2+delta^2);

% Make sure damping ratio is greater than 0
test.verifyGreaterThan(dRatio,0,'Damping ratio must be greater than 0');

Test Results

Running the test case returns two conditions in which the damping ratio is greater than
zero.

results = sltest.testmanager.run

results = 

  ResultSet with properties:

                   Name: 'Results: 2017-Sep-01 17:29:51'
              NumPassed: 14
              NumFailed: 2
            NumDisabled: 0
          NumIncomplete: 0
               NumTotal: 16
     NumTestCaseResults: 0
    NumTestSuiteResults: 0
     NumTestFileResults: 1
                Outcome: Failed
              StartTime: '2017-Sep-01 17:29:51'
               StopTime: '2017-Sep-01 17:32:16'
               Duration: 145
        CoverageResults: []
                Release: ''
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The wing pitch plots from iteration 12 and 13 show the difference between a positive
damping ratio (iteration 12) and a negative damping ratio (iteration 13).
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sltest.testmanager.close
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close_system('sltestFlutterSuppressionSystemExample.slx',0)

Custom Criteria Programmatic Interface Example
This example shows how to set and get custom criteria using the programmatic interface.

Before running this example, temporarily disable warnings that result from verification
failures.

warning off Stateflow:Runtime:TestVerificationFailed;
warning off Stateflow:cdr:VerifyDangerousComparison;

Load a Test File and Get Test Case Object

tf = sltest.testmanager.load('AutopilotTestFile.mldatx');

ts = getTestSuiteByName(tf,'Basic Design Test Cases');

tc = getTestCaseByName(ts,'Requirement 1.3 Test');

Create the Custom Criteria Object and Set Criteria

Create the custom criteria object.

tcCriteria = getCustomCriteria(tc)

tcCriteria = 

  CustomCriteria with properties:

     Enabled: 0
    Callback: '% Return value: customCriteria...'

Create the custom criteria expression. This script gets the last value of the signal Phi
and verifies that it equals 0.

criteria = ...
    sprintf(['lastPhi = test.SimOut.get(''Signals_Req1_3'')',...
    '.get(''Phi'').Values.Data(end);\n',...
    'test.verifyEqual(lastPhi,0,[''Final: '',num2str(lastPhi),''.'']);'])

criteria =
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    'lastPhi = test.SimOut.get('Signals_Req1_3').get('Phi').Values.Data(end);
     test.verifyEqual(lastPhi,0,['Final: ',num2str(lastPhi),'.']);'

Set and enable the criteria.

tcCriteria.Callback = criteria;
tcCriteria.Enabled = true;

Run the Test Case and Get the Results

Run the test case.

tcResultSet = run(tc);

Get the test case results.

tcResult = getTestCaseResults(tcResultSet);

Get the custom criteria result.

ccResult = getCustomCriteriaResult(tcResult)

ccResult = 

  CustomCriteriaResult with properties:

             Outcome: Failed
    DiagnosticRecord: [1x1 sltest.testmanager.DiagnosticRecord]

Restore warnings from verification failures.

warning on Stateflow:Runtime:TestVerificationFailed;
warning on Stateflow:cdr:VerifyDangerousComparison;
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sltest.testmanager.clearResults
sltest.testmanager.clear
sltest.testmanager.close

See Also

Related Examples
• “Test Models Using MATLAB Unit Test” on page 6-106
• “Create, Store, and Open MATLAB Figures” on page 6-103
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Create, Store, and Open MATLAB Figures
In this section...
“Create a Custom Figure for a Test Case” on page 6-103
“Include Figures in a Report” on page 6-105

You can create figures using MATLAB commands to include with test results and
reports. Enter the commands in a test case section that accepts MATLAB code. These
sections include the test case Custom Criteria section, and callbacks that can execute
with your test case.

If you include code that creates figures with your test case, you can:

• Display the figures after the test runs
• Store the figures with your test case
• Include them in a report
• Access stored figures from your test results

To specify this behavior, use the Test File Options section under the Test File settings.

• Select Close all open figures at the end of execution if you do not need to see the
figures right after the test executes, for example, if you are storing the figures or
including them in a report. Clear this check box if you are not storing the figures and
you want to view them after the test executes.

• Select Store MATLAB figures if you want to save the figures with the test results.
This option also enables you to open the figures from the results and to include them
in a report.

After you run the test, the figures appear under MATLAB Figures in the test case
results.

Create a Custom Figure for a Test Case

In this example, add code that creates a figure to the Custom Criteria section of a test
case. To access the figure from the test results, set options on the test file.

1 Open the model sldemo_absbrake.
2 In the Test Manager, create a test file and name it custom_figures.

 Create, Store, and Open MATLAB Figures

6-103

matlab:open_system('sldemo_absbrake')


3 In the default test case, under System Under Test, set the model to
sldemo_absbrake.

4 Under Custom Criteria, select the function customCriteria(test) check box and
paste this code in the text box.

h = findobj(0,'Name','ABS Speeds and Slip');
if isempty(h)
    h=figure('Position',[26   100   452   700],...
        'Name','ABS Speeds and Slip',...
        'NumberTitle','off');
end
figure(h)
set(h,'DefaultAxesFontSize',8)

% Log data in sldemo_absbrake_output
out = test.sltest_simout.get('sldemo_absbrake_output');

% Plot wheel speed and car speed
subplot(3,1,1);
plot(out.get('yout').Values.Vs.Time, ...
    out.get('yout').Values.Vs.Data);
grid on;
title('Vehicle speed'); ylabel('Speed(rad/sec)'); xlabel('Time(sec)');
subplot(3,1,2);
plot(out.get('yout').Values.Ww.Time, ...
    out.get('yout').Values.Ww.Data);
grid on;
title('Wheel speed'); ylabel('Speed(rad/sec)'); xlabel('Time(sec)');
subplot(3,1,3);
plot(out.get('slp').Values.Time, ...
    out.get('slp').Values.Data);
grid on;
title('Slip'); xlabel('Time(sec)'); ylabel('Normalized Relative Slip');

5 Set the figure options for the test file custom_figures. Under Test File Options:

• Select Close all open figures at the end of execution. This option closes
figures created by your Test Manager MATLAB code.

• Select Store MATLAB figures.
6 With the test case or the test file selected, click Run.
7 In the Results and Artifacts pane, select the test case under the results for this

test run. Click the links under MATLAB Figures to see the plots generated when
the test ran. The plot generated by the code you entered appears under Custom
Criteria.
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Include Figures in a Report

You can select the MATLAB Figures option in the Create Test Results Report dialog
box to include custom figures in your report. Alternatively, you can set report options
under Test File Options. The Test File Options settings are saved with the test file.

1 Select the test file custom_figures.
2 Under Test File Options, select Generate report after execution. The section

expands, displaying the same report options you can set using the dialog box.
3 To see the figures regardless of how the tests performed, set Results for to All

Tests.
4 Select the MATLAB figures check box.
5 With the test file selected, run the test. Running the test generates the report and

opens it in the PDF viewer.
6 Examine the report. The plot generated by the code you entered under Custom

Criteria appears in the report section Custom Criteria Plots.

See Also
sltest.testmanager.Options | sltest.testmanager.TestCase.getOptions |
sltest.testmanager.TestFile.getOptions |
sltest.testmanager.TestSuite.getOptions

Related Examples
• “Export Test Results and Generate Reports” on page 7-9
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Test Models Using MATLAB Unit Test
You can use the MATLAB Unit Test framework to run tests authored in Simulink Test.
Using the MATLAB Unit Test framework:

• Allows you to execute model tests together with MATLAB Unit Test scripts,
functions, and classes.

• Enables model and code testing using the same framework.
• Enables integration with continuous integration (CI) systems, such as Jenkins™.

To use MATLAB Unit Test, create a TestSuite from the Simulink Test file. To
customize the test execution, such as for CI, create a TestRunner. Running the test
produces a TestResult object. For CI, running the test can also stream results to a file.

In this section...
“Considerations” on page 6-106
“Basic Workflow Using MATLAB® Unit Test” on page 6-106
“Comparison of Test Nomenclature” on page 6-108
“Test a Model for Continuous Integration Systems” on page 6-109

Considerations

When running tests using MATLAB Unit Test, consider the following:

• Test hierarchy from Simulink Test is not converted to MATLAB Unit Test. A
TestSuite contains tests in a flat hierarchy.

• If you disable a test in the Test Manager, the test is filtered using MATLAB Unit
Test, and the result reflects a failed assumption.

Basic Workflow Using MATLAB® Unit Test

This example shows how to create and run a basic MATLAB® Unit Test for a test file
created in Simulink® Test™. You create a test suite, run the test, and display the
diagnostic report.

Before running this example, temporarily disable warnings that result from verification
failures.
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warning off Stateflow:Runtime:TestVerificationFailed;
warning off Stateflow:cdr:VerifyDangerousComparison;

1. Author a test file in the Test Manager, or start with a preexisting test file. For this
example, AutopilotTestFile tests a component of an autopilot system against several
requirements, using verify statements.

2. Create a TestSuite from the test file.

apsuite = testsuite('AutopilotTestFile.mldatx');

3. Run the test, creating a TestResult object. The command window returns warnings
from the verify statement failures.

apresults = run(apsuite);

Setting up FileCallbacksFixture
Done setting up FileCallbacksFixture: Invoked setup callback of "AutopilotTestFile".
__________

Running AutopilotTestFile > Basic Design Test Cases

================================================================================
Verification failed in AutopilotTestFile > Basic Design Test Cases/Requirement 1.3 Test.

    ---------------------
    Framework Diagnostic:
    ---------------------
    Failed criteria: Verification
    --> Simulink Test Manager Results:
            Results: 2017-Sep-01 17:28:43/Requirement 1.3 Test
================================================================================
.
Done AutopilotTestFile > Basic Design Test Cases
__________

Tearing down FileCallbacksFixture
Done tearing down FileCallbacksFixture: Invoked cleanup callback of "AutopilotTestFile".
__________

Failure Summary:

     Name                                                              Failed  Incomplete  Reason(s)
    ===============================================================================================================
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     AutopilotTestFile > Basic Design Test Cases/Requirement 1.3 Test    X                 Failed by verification.
    

4. To view the details of the test, display the Report property of the DiagnosticRecord
object. The record shows that a verification failed during the test.

apresults.Details.DiagnosticRecord.Report

ans =

    '================================================================================
     Verification failed in AutopilotTestFile > Basic Design Test Cases/Requirement 1.3 Test.
     
         ---------------------
         Framework Diagnostic:
         ---------------------
         Failed criteria: Verification
         --> Simulink Test Manager Results:
                 Results: 2017-Sep-01 17:28:43/Requirement 1.3 Test
     ================================================================================'

Enable warnings.

warning on Stateflow:Runtime:TestVerificationFailed;
warning on Stateflow:cdr:VerifyDangerousComparison;

Comparison of Test Nomenclature

MATLAB Unit Test has analogous properties to the functionality in Simulink Test. For
example,

• If the test case contains iterations, the MATLAB Unit Test contains
parameterizations.

• If the test file or test suite contains callbacks, the MATLAB Unit Test contains one or
more callbacks fixtures.

Test Case Iterations and MATLAB Unit Test Parameterizations

Parameterization details correspond to properties of the iteration.
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Simulink Test MATLAB Unit Test
Iteration type: Scripted Parameterization property:

ScriptedIteration
Iteration type: Table Parameterization property:

TableIteration
Iteration name Parameterization Name
Test case iteration object Parameterization Value

Test Callbacks and MATLAB Unit Test Fixtures

Fixtures depend on callbacks contained in the test file. Fixtures do not include test case
callbacks, which are executed with the test case itself.
Callbacks in Simulink Test Fixtures in MATLAB Unit Test
Test file callbacks FileCallbacksFixture
Test suite callbacks SuiteCallbacksFixture
File and suite callbacks Heterogeneous CallbacksFixture,

containing FileCallbacksFixture and
SuiteCallbacksFixture

No callbacks No fixture

Test a Model for Continuous Integration Systems

This example shows how to use MATLAB® Unit Test to test a model, and use the
TAPPlugin to create TAP results. You can use TAP with CI systems. The model is a
controller-plant system of a flight controller, aircraft model, and environment model.

Create a test suite and a test runner, and customize the runner with the plugin that
creates the TAP file. When you run the test, it fails on several iterations. The results are
written to the TAP file.

Before performing this example, set the working directory to a writable location on the
path.

1. Open the Model

open_system(fullfile(matlabroot,'examples','simulinktest',...
    'sltestF14ParameterSweep.slx'))
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2. Open the Test File

The test case creates a square wave input to the controller, and sweeps through 25
iterations of the parameters a and b. It compares the alpha output to a baseline with a
tolerance of 0.0046 and fails any output which exceeds this tolerance.

sltest.testmanager.view;
sltest.testmanager.load(fullfile(matlabroot,'examples','simulinktest',...
    'f14ParameterSweepTest.mldatx'));

3. Import the TestRunner, TestSuite, TAPPlugin, and ToFile classes.

import matlab.unittest.TestRunner
import matlab.unittest.TestSuite
import matlab.unittest.plugins.TAPPlugin
import matlab.unittest.plugins.ToFile

4. Create the test suite object.

suite = testsuite(fullfile(matlabroot,'examples','simulinktest',...
    'f14ParameterSweepTest.mldatx'))
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suite = 

  1x25 Test array with properties:

    Name
    BaseFolder
    ProcedureName
    SharedTestFixtures
    Parameterization
    Tags

Tests Include:
   25 Unique Parameterizations, 0 Shared Test Fixture Classes, 0 Tags.

5. Create the test runner object, and set it to display output to the command window.

f14runner = TestRunner.withTextOutput;

6. Create a TAP plugin that sends output to the file F14TapOutput.tap.

tapFile = 'F14TapOutput.tap';
plugin = TAPPlugin.producingVersion13(ToFile(tapFile));

7. Add the plugin to the test runner.

addPlugin(f14runner,plugin)

8. Run the test. The test fails several iterations in which the delta between the signal
output and the baseline exceeds the tolerance.

result = run(f14runner,suite);

Running f14ParameterSweepTest > New Test Suite 1
..........
........
================================================================================
Verification failed in f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration19).

    ---------------------
    Framework Diagnostic:
    ---------------------
    Failed criteria: Baseline
    --> Logs:
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            Inputs may not be compatible for simulation. Test results might not be accurate. Click here for more information on external input mapping.
    --> Simulink Test Manager Results:
            Results: 2017-Sep-01 17:33:12/Iterations Parameter Sweep/Scripted_Iteration19
================================================================================
..
...
================================================================================
Verification failed in f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration24).

    ---------------------
    Framework Diagnostic:
    ---------------------
    Failed criteria: Baseline
    --> Logs:
            Inputs may not be compatible for simulation. Test results might not be accurate. Click here for more information on external input mapping.
    --> Simulink Test Manager Results:
            Results: 2017-Sep-01 17:33:19/Iterations Parameter Sweep/Scripted_Iteration24
================================================================================
.
================================================================================
Verification failed in f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration25).

    ---------------------
    Framework Diagnostic:
    ---------------------
    Failed criteria: Baseline
    --> Logs:
            Inputs may not be compatible for simulation. Test results might not be accurate. Click here for more information on external input mapping.
    --> Simulink Test Manager Results:
            Results: 2017-Sep-01 17:33:20/Iterations Parameter Sweep/Scripted_Iteration25
================================================================================
.
Done f14ParameterSweepTest > New Test Suite 1
__________

Failure Summary:

     Name                                                                                                         Failed  Incomplete  Reason(s)
    ==========================================================================================================================================================
     f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration19)    X                 Failed by verification.
    ----------------------------------------------------------------------------------------------------------------------------------------------------------
     f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration24)    X                 Failed by verification.
    ----------------------------------------------------------------------------------------------------------------------------------------------------------
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     f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration25)    X                 Failed by verification.
    

9. Display the results from the TAP file.

disp(fileread(tapFile))

TAP version 13
1..25
ok 1 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration1)
ok 2 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration2)
ok 3 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration3)
ok 4 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration4)
ok 5 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration5)
ok 6 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration6)
ok 7 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration7)
ok 8 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration8)
ok 9 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration9)
ok 10 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration10)
ok 11 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration11)
ok 12 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration12)
ok 13 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration13)
ok 14 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration14)
ok 15 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration15)
ok 16 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration16)
ok 17 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration17)
ok 18 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration18)
not ok 19 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration19)
    ---
    Event:
        Event Name: 'VerificationFailed'
        Event Location: 'f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration19)'
        Framework Diagnostic: |
            Failed criteria: Baseline
            --> Logs:
                    Inputs may not be compatible for simulation. Test results might not be accurate. Click here for more information on external input mapping.
            --> Simulink Test Manager Results:
                    Results: 2017-Sep-01 17:33:12/Iterations Parameter Sweep/Scripted_Iteration19
    ...
ok 20 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration20)
ok 21 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration21)
ok 22 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration22)
ok 23 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration23)
not ok 24 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration24)
    ---
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    Event:
        Event Name: 'VerificationFailed'
        Event Location: 'f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration24)'
        Framework Diagnostic: |
            Failed criteria: Baseline
            --> Logs:
                    Inputs may not be compatible for simulation. Test results might not be accurate. Click here for more information on external input mapping.
            --> Simulink Test Manager Results:
                    Results: 2017-Sep-01 17:33:19/Iterations Parameter Sweep/Scripted_Iteration24
    ...
not ok 25 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration25)
    ---
    Event:
        Event Name: 'VerificationFailed'
        Event Location: 'f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration25)'
        Framework Diagnostic: |
            Failed criteria: Baseline
            --> Logs:
                    Inputs may not be compatible for simulation. Test results might not be accurate. Click here for more information on external input mapping.
            --> Simulink Test Manager Results:
                    Results: 2017-Sep-01 17:33:20/Iterations Parameter Sweep/Scripted_Iteration25
    ...

sltest.testmanager.clearResults
sltest.testmanager.clear
sltest.testmanager.close

close_system('sltestF14ParameterSweep',0)

See Also
Test | TestResult | TestRunner | TestSuite |
matlab.unittest.plugins.TAPPlugin

Related Examples
• “Run Tests for Various Workflows” (MATLAB)
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Filter Test Execution and Results

In this section...
“Add Tags” on page 6-115
“Filter Tests and Results” on page 6-115
“Run Filtered Tests” on page 6-115

You can run a subset of tests or view a subset of test results by filtering test tags. Tags
are a property of the test case, test suite, or test file.

Add Tags

Add comma-separated tags to the Tags section in the Test Browser. Tags cannot contain
spaces; spaces are corrected to commas.

Filter Tests and Results

In the text box at the top of the Test Browser or Results and Artifacts pane, filter
tests by entering tag: id1, id2, ... where id1 and id2 are example test tags.
Enter multiple tags separated by commas to return tests containing any tag in the list.

Run Filtered Tests

To run a subset of tests
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1 Filter the tests using tags.
2 In the toolstrip, click the down arrow below Run and select Run Filtered.
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Test Manager Results and Reports

• “View Test Case Results” on page 7-2
• “Export Test Results and Generate Reports” on page 7-9
• “Customize Test Reports” on page 7-14
• “Append Code to a Test Report” on page 7-20
• “Results Sections” on page 7-23
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View Test Case Results
In this section...
“View Results Summary” on page 7-2
“Visualize Test Case Simulation Output and Criteria” on page 7-4

After a test case has finished running in the Test Manager, the test case result becomes
available in the Results and Artifacts pane. Test results are organized in the same
hierarchy as the test file, test suite, and test cases that were run from the Test Browser
pane. In addition, the Results and Artifacts pane shows the criteria results and
simulation output, if applicable to the test case.

View Results Summary

The test case results tab gives a high-level summary and other information about an
individual test case result. To open the test case results tab:

1 Select the Results and Artifacts pane.

2 Double-click a test case result.
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A tab opens containing the test case results information.
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Visualize Test Case Simulation Output and Criteria

You can view signal data from simulation output or comparisons of signal data used in
baseline or equivalence criteria.

To view simulation output from a test case:
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1 Select the Results and Artifacts pane.
2 Expand the Sim Output section of the test case result.
3 Select the check box of signals you want to plot.

The Visualize tab appears and plots the signals.
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To view equivalence or baseline criteria comparisons:

1 Select the Results and Artifacts pane.
2 Expand the Baseline Criteria Result or Equivalence Criteria Result section of

the test case result.
3 Select the option button of the signal comparison you want to plot.
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The Comparison tab appears and plots the signal comparison.
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To see an example of creating a test case and viewing the results, see “Test Model Output
Against a Baseline” on page 6-9.
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Export Test Results and Generate Reports

In this section...
“Export Results” on page 7-9
“Create a Test Results Report” on page 7-10
“Save Reporting Options with a Test File” on page 7-10
“Generate Reports Using Templates” on page 7-11

Once you have run test cases and generated test results, you can export results and
generate reports. Test case results appear in the Results and Artifacts pane.

Export Results

Test results are saved separately from the test file. To save results, select the result in
the Results and Artifacts pane, and click Export on the toolstrip.

• Select complete result sets to export to a MATLAB data export file (.mldatx).

• Select criteria comparisons or simulation output to export signal data to the base
workspace or to a MAT-file.
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Create a Test Results Report

Result reports contain report overview information, the test environment, results
summaries with test outcomes, comparison criteria plots, and simulation output plots.
You can customize the information included in the report, and you can save the report in
three different file formats: ZIP (HTML), DOCX, and PDF.

1 In the Results and Artifacts pane, select results for a test file, test suite, or test
case.

Note You can create a report from multiple result sets, but you cannot create a
report from multiple test files, test suites, or test cases within results sets.

2 From the toolstrip, click Report.
3 Select the options to specify report contents.
4 Set File Format to the output format you want.
5 Click Create.

Save Reporting Options with a Test File

You can generate a report every time you run a test case in a test file, using the same
report settings each time. To generate a report each time you run the test, set options
under Test File Options. These settings are saved with the test file.

1 In the Test Browser pane, select the test file whose report options you want to set.
2 Under Test File Options, select Generate report after execution. The section

expands, displaying the same report options you can set using the dialog box.
3 Set the options. To include figures generated by callbacks or custom criteria, select

MATLAB figures. For more information, see “Create, Store, and Open MATLAB
Figures” on page 6-103.

4 Store the settings with your test file. Save the test file.
5 If you want to generate a report using these settings, select the test file and run the

test.
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Generate Reports Using Templates

Microsoft Word Format

If you have a MATLAB Report Generator™ license, you can create reports from a
Microsoft Word template. The report can be a Microsoft Word or PDF document.

The report generator in Simulink Test fills information into rich text content controls in
your Microsoft Word template document. For more information on how to use rich text
content controls or customize part templates, see the MATLAB Report Generator
documentation, such as “Add Holes in a Microsoft Word Template” (MATLAB Report
Generator).

For a sample template, go to the path:

cd(matlabroot);
cd('help\toolbox\sltest\examples');

In the examples folder, open the file Template.dotx.

In the Microsoft Word template, you can add rich text content controls. Each Simulink
Test report section can be inserted into the rich text content controls. The control names
are:

• ChapterTitle — report title
• ChapterTestPlatform — version of MATLAB used to execute tests
• ChapterTOC — test results table of contents
• ChapterBody — test results

For example, the chapter title rich text content control appears in the Microsoft Word
template as:

To change the control name, right-click the rich text content control and select
Properties. Specify the control name, ChapterTitle or other name, in the Title and
Tag field.
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To generate a report from the Test Manager using a Microsoft Word template:

1 In the Test Manager, select the Results and Artifacts pane.
2 Select results for a test file, test suite, or test case in the Results and Artifacts

pane.
3 From the toolstrip, click Report.
4 Select the report options.
5 Select DOCX or PDF for the File Format.
6 Specify the full path and file name of your Microsoft Word template.
7 Click Create.

PDF or HTML Formats

If you have a MATLAB Report Generator license, you can create reports from a PDF or
HTML template, using a PDFTX or HTMTX file. To generate a report from the Test
Manager using a PDF or HTML template:
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1 In the Test Manager, select the Results and Artifacts pane.
2 Select results for a test file, test suite, or test case in the Results and Artifacts

pane.
3 From the toolstrip, click Report.
4 Select the report options.
5 Select ZIP or PDF for the File Format. Selecting ZIP generates an HTML report.
6 Specify the full path and file name of your template. For PDF, use a PDFTX file. For

HTML, use an HTMTX file. For more information on creating templates, see “Create
Report Templates” (MATLAB Report Generator).

7 Click Create.

See Also

Related Examples
• “Create Report Templates” (MATLAB Report Generator)
• “Create, Store, and Open MATLAB Figures” on page 6-103
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Customize Test Reports

In this section...
“Inherit the Report Class” on page 7-14
“Method Hierarchy” on page 7-14
“Modify the Class” on page 7-16
“Generate a Report Using the Custom Class” on page 7-18

You can choose how to format and aggregate test results by customizing reports. Use the
sltest.testmanager.TestResultReport class to create a subclass and then use the
properties and methods to customize how the Test Manager generates the results report.
You can change font styles, add plots, organize results into tables, include model images,
and more. Using the custom class, requires a MATLAB Report Generator license.

Inherit the Report Class

To customize the generated report, you must inherit from the
sltest.testmanager.TestResultReport class. After you inherit from the class, you
can modify the properties and methods. To inherit the class, add the class definition
section to a new or existing MATLAB script. The subclass is your custom class name, and
the superclass that you inherit from is sltest.testmanager.TestResultReport. For
more information about creating subclasses, see “Subclass Constructors” (MATLAB).
Then, add code to the inherited class or methods to create your customizations.

% class definition
classdef CustomReport < sltest.testmanager.TestResultReport
    %
    % Report customization code here
    %
end

Method Hierarchy

When you create the subclass, the derived class inherits methods from the
sltest.testmanager.TestResultReport class. The body of the report is separated
into three main groups: the result set block, the test suite result block, and the test case
result block.

7 Test Manager Results and Reports

7-14



The result set block contains the result set table, the coverage table, and links to the
table of contents.

The test suite result block contains the test suite results table, the coverage table,
requirements links, and links to the table of contents.

The test case result block contains the test case and test iterations results table, the
coverage table, requirements links, signal output plots, comparison plots, test case
settings, and links to the table of contents.
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Modify the Class

To insert your own report content or change the layout of the generated report, modify
the inherited class methods. For general information about modifying methods, see
“Modify Superclass Methods” (MATLAB).

A simple modification to the generated report could be to add some text to the title page.
The method used here is addTitlePage.

% class definition
classdef CustomReport < sltest.testmanager.TestResultReport
    methods
        function this = CustomReport(resultObjects, reportFilePath)
            this@sltest.testmanager.TestResultReport(resultObjects, reportFilePath);
        end
    end
    
    methods(Access=protected)
        function addTitlePage(obj)
            import mlreportgen.dom.*;
            
            % Add a custom message
            label = Text('Some custom content can be added here');
            append(obj.TitlePart,label);
            
            % Call the superclass method to get the default behavior
            addTitlePage@sltest.testmanager.TestResultReport(obj);
        end
    end
end

Click here for a code file of this example.

A more complex modification of the generated report is to include a snapshot of the model
that was tested.

% class definition
classdef CustomReport < sltest.testmanager.TestResultReport
    methods
        function this = CustomReport(resultObjects,reportFilePath)
            this@sltest.testmanager.TestResultReport(resultObjects,reportFilePath);
        end
    end
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    methods(Access=protected)
        % Method to customize test case/iteration result section in the report
        function docPart = genTestCaseResultBlock(obj,result)
            % result: A structure containing test case or iteration result
            import mlreportgen.dom.*;
            
            % Call the superclass method to get the default behavior
            docPart = genTestCaseResultBlock@sltest.testmanager.TestResultReport(...
                                                                      obj,result);
            
            % Get the test case result data for putting in the report
            tcrObj = result.Data;
            
            % Insert model screenshot at the test case result level
            if isa(tcrObj, 'sltest.testmanager.TestCaseResult')
                
                % Initialize model name
                modelName = '';
                
                % Check in the test case result if it has model information. If
                % not, it means there were iterations in the test case or a
                % model was not used.
                testSimMetaData = tcrObj.SimulationMetaData;
                
                if (~isempty(testSimMetaData))
                    modelName = testSimMetaData.modelName;
                end
                
                % Get iteration results
                iterResults = getIterationResults(tcrObj);
                
                % Get the model name in case test case had iterations
                if (~isempty(iterResults))
                    modelName = iterResults(1).SimulationMetaData.modelName;
                end
                
                % Insert model snapshot. This will not work for harnesses. With
                % minimal changes we can also open the harness used for
                % testing.
                if (~isempty(modelName))
                    try
                        open_system(modelName);
                        snapObj = SLPrint.Snapshot;
                        snapObj.Target = modelName;
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                        snapObj.Format = 'png';
                        snapObj.FileName = fullfile(tempdir,modelName);
                        if exist(snapObj.FileName, 'file')
                            delete( snapObj.FileName );
                        end
                        snapObj.snap;
                        outputFileName = snapObj.FileName;
                        outputFileName =  [outputFileName '.png'];
                        para = sltest.testmanager.ReportUtility.genImageParagraph(...
                            outputFileName,...
                            '5.2in','3.7in');
                        append(docPart,para);
                    catch
                    end
                end
            end
        end
    end
end

Click here for a code file of this example.

Generate a Report Using the Custom Class

After you customize the class and methods, use the sltest.testmanager.report to
generate the report. You must use the 'CustomReportClass' name-value pair for the
custom class, specified as a string. For example:

% Generate the result set from imported data
result = sltest.testmanager.importResults('demoResults.mldatx');

% Specify the report file name and path
filePath = 'testreport.zip';

% Generate the report using the custom class
sltest.testmanager.report(result,filePath, ...
            'Author','MathWorks',...
            'Title','Test',...
            'IncludeMLVersion',true,...
            'IncludeTestResults',int32(0),...
            'CustomReportClass','CustomReport',...
            'LaunchReport', true);
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Alternatively, you can create your custom report using the Test Manager report dialog
box. Select a test result, click the Report button on the toolstrip, and specify the custom
report class in the Create Test Result Report dialog box. For the Test Manager to use the
custom report class, the class must be on the MATLAB path.

See Also
sltest.testmanager.TestResultReport | sltest.testmanager.report

Related Examples
• “Subclass Constructors” (MATLAB)
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Append Code to a Test Report
This example shows how to use a customization class to include code in your test report.
When testing systems that include handwritten code, reviewing the code itself can be
part of reviewing the test results. Including the code in the test report allows you use a
single document.

The example model includes handwritten C code using an S-Function builder block. The
block is a component of a cruise control system; functionally, it disregards simultaneous
pressing of the Accel/Res switch and the Coast/Set switch.

This example requires Simulink® Report Generator™ and Microsoft® Windows.

Navigate to the Example Folder

Before running this example, navigate to the example folder and set the filenames.

cd(fullfile(matlabroot,'examples','simulinktest'))

className = 'textAppendReport';
resultsFile = 'DoublePressSfcnSimTestResults';
filePath = 'textAppendedReport.zip';

Report Customization Class

The report customization class textAppendReport.m appends the S-Function wrapper
code to the end of the report body.

open(className)

Load the Test Results and Create the Test Report

1. Load the test results file.

result = sltest.testmanager.importResults(resultsFile);

2. Create the test report using the customization.

sltest.testmanager.report(result,filePath,'CustomReportClass',className,...
    'IncludeTestResults',0)

3. The report appends the S-Function wrapper code:
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For more information on report customization, see Customize Generated Reports

sltest.testmanager.clearResults;
sltest.testmanager.close;
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Results Sections
In this section...
“Summary” on page 7-24
“Test Requirements” on page 7-24
“Iteration Settings” on page 7-25
“Errors” on page 7-25
“Logs” on page 7-25
“Description” on page 7-25
“Parameter Overrides” on page 7-25
“Coverage Results” on page 7-25

Double-click a test case results in the Results and Artifacts pane to open a results tab
and view the test case result sections. A baseline test case result is shown as an example.
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Summary
The Summary section includes the basic test information and the test outcome. For
more information about the simulation, toggle the Simulation Metadata arrow to
expand the section.

Test Requirements
A list of test requirements linked to the test case. See “Requirements” on page 6-78 for
more information on linking requirements to test cases.
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Iteration Settings

If you are using iterations to run test cases, then this section appears in the results. For
more information about test iterations, see “Run Combinations of Tests Using Iterations”
on page 6-50.

Errors

This section displays simulation errors captured from the Simulink Diagnostic Viewer.
Errors from incorrect information defined in the test case and callback scripts are also
shown here.

Logs

This section displays simulation warnings captured from the Simulink Diagnostic
Viewer.

Description

You can include notes about the test results here. These notes are saved with the results.

Parameter Overrides

A list of parameter overrides specified in the test case under Parameter Overrides. If
parameter overrides are not specified, then this section is not shown in the results
summary.

Coverage Results

If you collect coverage in your test, then the coverage results appear in this section.
Coverage results are aggregated at the test file, test suite, and test file level. For more
information about coverage, see “Collect Coverage in Tests” on page 6-61.
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Real-Time Testing

• “Test Models in Real Time” on page 8-2
• “Reuse Desktop Test Cases for Real-Time Testing” on page 8-13
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Test Models in Real Time
In this section...
“Overall Workflow” on page 8-2
“Real-Time Testing Considerations” on page 8-3
“Complete Basic Model Testing” on page 8-3
“Set up the Target Computer” on page 8-3
“Configure the Model or Test Harness” on page 8-4
“Add Test Cases for Real-Time Testing” on page 8-6
“Assess Real-Time Execution Using verify Statements” on page 8-11

You can test your system in environments that resemble your application. You begin
with model simulation on a development computer, then use software-in-the-loop (SIL)
and processor-in-the-loop (PIL) simulations. Real-time testing executes an application on
a standalone target computer that can connect to a physical system. Real-time testing
can include effects of timing, signal interfaces, system response, and production
hardware.

Real-time testing includes:

• Rapid prototyping, which tests a system on a standalone target connected to plant
hardware. You verify the real-time tests against requirements and model results.
Using rapid prototyping results, you can change your model and update your
requirements, after which you retest on the standalone target.

• Hardware-in-the-loop (HIL), which tests a system that has passed several stages of
verification, typically SIL and PIL simulations.

Overall Workflow
This example workflow describes the major steps of creating and executing a real-time
test:

1 Create test cases that verify the model against requirements. Run the model
simulation tests and save the baseline data.

2 Set up the real-time target computer.
3 Create test harnesses for real-time testing, or reuse model simulation test harnesses.

In Test Sequence or Test Assessment blocks, verify statements assess the real-
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time execution. In the test harnesses, use target and host scopes to display signals
during execution.

4 In the Test Manager, create real-time test cases.
5 For the real-time test cases, configure target settings, inputs, callbacks, and

iterations. Add baseline or equivalence criteria.
6 Execute the real-time tests.
7 Analyze the results in the Test Manager. Report the results.

Real-Time Testing Considerations
• If real-time test data returned from the target computer is shifted in time or is

missing data points, baseline or equivalence results can consequently display a test
failure. When investigating real-time test failures, look for time shifts or missing data
points.

• You cannot override the real-time execution sample time for applications built from
models containing a Test Sequence block. The code generated for the Test Sequence
block contains a hard-coded sample time. Overriding the target computer sample time
can produce unexpected results.

• Your target computer must have a file system to use verify statements and test case
logging.

Complete Basic Model Testing
Real-time testing often takes longer than comparative model testing, especially if you
execute a suite of real-time tests that cover several scenarios. Before executing real-time
tests, complete requirements-based testing using desktop simulation. Using the desktop
simulation results:

• Debug your model or make design changes that meet requirements.
• Debug your test sequence. Use the debugging features in the test sequence editor. See

“Debug a Test Sequence” on page 3-54.
• Update your requirements and add corresponding test cases.

Set up the Target Computer
Real-time testing requires a standalone target computer. Simulink Test only supports
target computers running Simulink Real-Time™. For more information, see:
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• “Development Computer Setup and Configuration” (Simulink Real-Time)
• “Troubleshooting in Simulink Real-Time” (Simulink Real-Time)

Configure the Model or Test Harness

Real-time applications require specific configuration parameters and signal properties.

Code Generation

A real-time test case requires a real-time system target file. In the model or harness
configuration parameters, in the Code Generation pane, set the System target file to
slrt.tlc to generate system target code.

If your model requires a different system target file, you can set the parameter using a
test case or test suite callback. After the real-time test executes, set the parameter to its
original setting with a cleanup callback. For example, this callback opens the model and
sets the system target file parameter to slrt.tlc for the model
sltestProjectorController.

open_system(fullfile(matlabroot,'toolbox','simulinktest',...
'simulinktestdemos','sltestProjectorController'));
set_param('sltestProjectorController','SystemTargetFile','slrt.tlc');

Data Import/Export Format

Models must use a data format other than dataset. To set the data format:

1 Open the configuration parameters.
2 Select the Data Import/Export pane.
3 Select the Format.

Log Signals from Real-Time Execution

To configure your signals of interest for real-time testing:

• Enable signal logging in the Configuration Parameters, in the Data Import/Export
pane.

• Connect signals to Scope blocks from the Simulink Real-Time block library. Set the
Scope type property to File.

• Name each signal of interest using the signal properties.
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Signal naming is particularly important if you perform baseline or equivalence testing,
because unnamed signals can be assigned a default name, which likely does not match
the name of the baseline or equivalence signal. This test harness demonstrates four
signals configured for real-time testing, using file scopes to return signal data to the Test
Manager, and target scopes to display data on the target computer during execution.

View Signals During Real-Time Execution

To display signals on the target computer during real-time execution, add target scopes
to your test harness. To display signals in the Simulink Real-Time Explorer, add host
scopes. This test harness includes both target and host scopes for signal visualization.
See Scope.
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Add Test Cases for Real-Time Testing

Use the Test Manager to create real-time test cases. In the toolstrip, click New > Real-
Time Test.

Test Type

You can select a baseline, equivalence, or simulation real-time test. For simulation test
types, verify statements serve as pass/fail criteria in the test results. For equivalence
and baseline test types, the equivalence or baseline criteria also serve as pass/fail
criteria.

• Baseline — Compares the signal data returned from the target computer to the
baseline in the test case. To compare a real-time execution result to a model
simulation result, add the model baseline result to the real-time test case and apply
optional tolerances to the signals.

• Equivalence — Compares signal data from a simulation and a real-time test, or two
real-time tests. To run a real-time test on the target computer, then compare results
to a model simulation:

• Select Simulation 1 on target.
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• Clear Simulation 2 on target.

The test case displays two simulation sections, Simulation 1 and Simulation 2.

Comparing two real-time tests is similar, except that you select both simulations on
target. In the Equivalence Criteria section, you can capture logged signals from the
simulation and apply tolerances for pass/fail analysis.

• Simulation: Assesses the test result using only verify statements and real-time
execution. If no verify statements fail, and the real-time test executes, the test case
passes.

Load Application From

Using this option, specify how you want to load the real-time application. The real-time
application is a DLM file built from your model or test harness. You can load the
application from:

• Model — Choose Model if you are running the real-time test for the first time, or
your model changed since the last real-time execution. Model typically takes the
longest because it includes model build and download. Model loads the application
from the model, builds the real-time application, downloads it to the target computer,
and executes it on the target computer.

• Target Application — Choose Target Application to send the target application
from the host to a target computer, and execute the application. Target
Application can be useful if you want to load an already-built application on
multiple targets.

• Target Computer — This option executes an application that is already loaded on
the real-time target computer. You can update the parameters in the test case and
execute using Target Computer.

This table summarizes which steps and callbacks execute for each option.
Test Case Execution

Step (first to last)
Load Application From

Model Target Application Target Computer
Executes pre-load
callback

Yes Yes Yes

Loads Simulink
model

Yes No No
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Test Case Execution
Step (first to last)

Load Application From
Model Target Application Target Computer

Executes post-load
callback

Yes No No

Sets Signal Builder
group

Yes No No

Builds DLM from
model

Yes No No

Downloads DLM to
target computer

Yes Yes No

Sets runtime
parameters

Yes Yes Yes

Executes pre-start
real-time callback

Yes Yes Yes

Executes real-time
application

Yes Yes Yes

Executes cleanup
callback

Yes Yes Yes

Model

Select the model from which to generate the real-time application.

Test Harness

If you use a test harness to generate the real-time application, select the test harness.

Simulation Settings Overrides

For real-time tests, you can override the simulation stop time, which can be useful in
debugging a real-time test failure. Consider a 60-second test that returns a verify
statement failure at 15 seconds due to a bug in the model. After debugging your model,
you execute the real-time test to verify the fix. You can override the stop time to
terminate the execution at 20 seconds, which reduces the time it takes to verify the fix.

Callbacks

Real-time tests offer a Pre-start real-time application callback which executes
commands just before the application executes on the target computer. Real-time test
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callbacks execute in a sequence along with the model load, build, download, and execute
steps. Callbacks and step execution depends on how the test case loads the application.

Sequence
Load application from:

Model

Load application from:

Target application

Load application from:

Target computer
Executes first Preload callback Preload callback Preload callback

 Post-load callback — —
 Pre-start real-time

callback
Pre-start real-time
callback

Pre-start real-time
callback

Executes last Cleanup callback Cleanup callback Cleanup callback

Iterations

You can execute iterations in real-time tests. Iterations are convenient for executing real-
time tests that sweep through parameter values or Signal Builder groups. Results appear
grouped by iteration. For more information on setting up iterations, see “Run
Combinations of Tests Using Iterations” on page 6-50. You can create:

• Tabled iterations from a parameter set — Define several parameter sets in the
Parameter Overrides section of the test case. Under Iterations > Table
Iterations, click Auto Generate and select Parameter Set.

• Tabled iterations from signal builder groups — If your model or test harness uses a
signal builder input, under Iterations > Table Iterations, click Auto Generate
and select Signal Builder Group. If you use a signal builder group, load the
application from the model.

• Scripted iterations — Use scripts to iterate using model variables or parameters. For
example, in the model sltestRealTimeOscillatorTestExample, the
SettlingTest harness uses a Test Sequence block to create a square wave test
signal for the oscillator system using the parameter frequency.
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In the test file SettlingTestCases, the real-time test scripted iterations cover a
frequency sweep from 5 Hz to 35 Hz. The script iterates the value of frequency in
the Test Sequence block.
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%% Iterate over frequencies to determine best oscillator settings

% Create parameter sets
freq = 5.0:1.0:35.0;

for i_iter = 1:length(freq)
    % Create iteration object
    testItr = sltestiteration();
    
    % Set parameters
    setVariable(testItr,'Name','frequency','Source','Test Sequence',...
    'Value',freq(i_iter));
    
    % Register iteration
    addIteration(sltest_testCase, testItr);
end

Assess Real-Time Execution Using verify Statements

In addition to baseline and equivalence signal comparisons, you can assess real-time test
execution using verify statements. A verify statement assesses a logical expression
and returns results to the Test Manager. Use verify inside a Test Sequence or Test
Assessment block. See “Assess Simulation Using Logical Statements” on page 3-32.
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See Also

Related Examples
• “Test Real-Time Application” (Simulink Real-Time)
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Reuse Desktop Test Cases for Real-Time Testing

Convert Desktop Test Cases to Real-Time
In the Test Manager, you can reuse test cases for real-time testing by converting desktop
test cases to real-time test cases. For convenience, data can be stored externally so that
each test case accesses common inputs and baseline data. The overall workflow is as
follows:

1 Create a baseline, equivalence, or simulation test case with external inputs. For
baseline tests, add baseline data from external files.

2 In the Test Manager, select the test case in the Test Browser.
3 Copy the test case. Right-click the test case and select Copy.
4 Paste the new test case into a test suite.
5 Rename the new test case.
6 Right-click the new test case, and select Convert to > Real-Time Test. For

equivalence tests, select which simulation (simulation 1 or simulation 2) should be
run in real time.

7 Select the Target Computer and Load Application From options.
8 Ensure that the model settings are compatible with real-time test execution. For

more information, see “Development Computer Setup and Configuration” (Simulink
Real-Time).

Use External Data for Real-Time Tests
You can simplify test input data management by defining the input data in an external
MAT or Excel file. Map the data to root inports in your model or test harness for desktop
simulation. When you convert the desktop simulation test case into a real-time test, the
test case uses the same inport mapping.

Options for using external data in real-time tests depend on how your test case loads the
application:

Load Real Time Application from Model

If you are using external data for a real-time test, you should load the test case from the
model before running it from the target application or the target computer. Loading the
real-time application from a model gives you the most external file options for test
inputs. The external data is built into the application, and you can re-run the applicaton
from the target application or target computer.
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In the System Under Test section, set the application to load from Model. In the
Inputs section of the test case, click Add, and select an Excel file, MAT file, or CSV file.
Map the data to your model inports. For more information on input mapping, see “Use
External Inputs in Test Cases” on page 6-30.

Load Real Time Application from Target Application or Target Computer

After running the test from the model, you can avoid recompiling the model by running
the test from the target application or target computer. The application uses the input
mapping built when the test ran from the model.

You can map external data to a test case loaded from the target application or target
computer, without first running from the model. The external data must be in a MAT
file, in the same format used if the test is loaded from the model. In the System Under
Test section, select to load the application from the Target Application or Target
Computer. In the Inpus section, click Add and select a MAT file. The Input string is not
editable.

Example

This example shows a basic desktop test case reuse workflow using external input data
defined in an Excel file. You run the baseline test case on the desktop, update the
baseline data, convert a copy of the test case to a real-time test, then run the test case on
a target computer. This example runs only on Windows systems.

1 Open the test file.

tf = sltest.testmanager.TestFile(fullfile(matlabroot,'examples',...
'simulinktest','sltestTestCaseRealTimeReuseExample.mldatx'));
sltest.testmanager.load(tf.Name);
sltest.testmanager.view;

The test file runs a transmission shift controller algorithm through four iterations,
each corresponding to a different test scenario: passing, gradual acceleration, hard
braking, and coasting. There is baseline data associated with each scenario for the
signals vehicle speed and output torque.
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2 Run the baseline test.
3 Under the Baseline Criteria result, select output torque under the Passing

result to view the comparison. The Passing result fails due to transient signals that
fall outside the relative tolerance.

4 Assume these transient signals are not significant, and update the baseline data:

1 Click Next Failure. The first failure region is bounded by data cursors.
2 Click Update Baseline + Update selected signal region, and confirm you

want to overwrite the data.
3 Repeat this process for the other two failure regions.
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5 Copy and convert the baseline test case to a real time test:

1 In the Test Browser, right-click Baseline Test and select Copy.
2 Paste the new test case under the test suite.
3 Rename the new tests case RT Baseline Test.
4 Right-click RT Baseline Test and select Convert to > Real-Time Test.

6 Run the real time test case:

1 Set the Target Computer.
2 Set the system under test to load from Model.

3 Run the RT Baseline Test test case.
7 In this example, several of the scenarios fail due to timing impacts on the data

output. For example, in the HardBrake iteration, the vehicle speed output falls
outside the relative tolerance after the brake is applied. To resolve this failure, you
could:

• Increase the relative tolerance for the real-time test.
• Create a separate set of baseline data for the real-time test.
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See Also

Related Examples
• “Test Real-Time Application” (Simulink Real-Time)
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Verification and Validation

• “Test Model Against Requirements and Report Results” on page 9-2
• “Analyze a Model for Standards Compliance and Design Errors” on page 9-6
• “Perform Functional Testing and Analyze Test Coverage” on page 9-9
• “Analyze Code and Test Software-in-the-Loop” on page 9-13
• “Module Verification and Testing Processor-in-the-Loop” on page 9-22
• “Test a Model in Real Time” on page 9-23
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Test Model Against Requirements and Report Results

Requirements Overview
Requirements are the basis for your system architecture, algorithm, and test plan.
Traceability between requirements documents, model, code, and tests helps you
document relationships, manage design changes, and interpret test results. Required
model properties and test objectives enable targeted design analysis and test case
generation for specific scenarios. You can evaluate your design and identify incomplete or
missing requirements with ad-hoc testing, using simulated user interfaces for your
model. Also, you can use rapid prototyping to validate requirements, and connect to
physical or simulated environments to test your algorithm. Update the design, adding
requirements and requirements links as necessary.

Test a Cruise Control Safety Requirement
This example shows a requirements-based testing workflow for a cruise control model.
You start with a model that has traceability to an external requirements document. You
add a test to evaluate two safety requirements, checking that the cruise control
disengages when the system reaches certain conditions. You add traceability to this test,
run the test, and report the results.

1 Create a copy of the project in a working folder. Enter

slVerificationCruiseStart

9 Verification and Validation

9-2



2 Open the model and the test harness. On the command line, enter

open_system simulinkCruiseAddReqExample
sltest.harness.open('simulinkCruiseAddReqExample','SafetyTest_Harness1')

3 Open the Test Sequence block.

• The BrakeTest sequence tests that the system disengages when the brake pedal
is pressed. It includes a verify statement

verify(engaged == false,...
    'verify:brake',...
    'system must disengage when brake applied')

• The LimitTest sequence tests that the system disengages when the speed
exceeds a limit. It includes a verify statement

verify(engaged == false,...
    'verify:limit',...
    'system must disengage when limit exceeded')

4 Open the requirements document. In the Simulink Project window, expand the
documents folder and open simulinkCruiseChartReqs.docx.

5 Add links between the test steps and the requirements document.

1 In the requirements document, highlight item 3.1, “Vehicle braking will
transition system to disengaged (inactive) when engaged (active)”

2 With item 3.1 highlighted, in the test sequence, right-click the BrakeTest step.
Select Requirements traceability > Link to Selection in Word.

3 In the requirements document, highlight item 3.4, “Transition to disengaged
(inactive) when vehicle speed is outside the limits of 20 mph to 90 mph”

4 With item 3.4 highlighted, in the test sequence, right-click the LimitTest step.
Select Requirements traceability > Link to Selection in Word.

5 Save the requirements document and the model.
6 Create a test case in the Test Manager, and link the test case to the requirements

section.

1 Open the Test Manager. In the Simulink menu, select Analysis > Test
Manager.

2 In the Test Manager toolstrip, click New > Test File. Select the tests folder in
the project, and enter a name for the test file. Click Save.

A new baseline test is created.
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3 Under System Under Test, in the Model field, click the button  to use the
current model. The field displays the model name.

4 Expand the Test Harness section. From the drop-down menu, select the test
harness name.

5 In the requirements document, highlight section 3.1.
6 In the test case, expand the Requirements section. Click the arrow next to the

Add button and select Link to Selection in Word.
7 Use the same process to link the test case to section 3.4 in the requirements

document.
7 Highlight the test case. In the Test Manager toolstrip, click Run.
8 When the test finishes, expand the Verify Statements results. The results show

that both assessments pass, and the plot shows the detailed results of each
statement.

9 Create a report using a custom Microsoft Word template.

1 In the Test Manager, right-click the test case name. Select Results: > Create
Report.

2 In the Create Test Result Report dialog box, set the options:

• Title: SafetyTest
• Results for: All Tests
• File Format: DOCX
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• For the other options, keep the default selections.
3 For the Template File, select the ReportTemplate.dotx file in the

documents project folder.
4 Enter a file name and select a location for the report.
5 Click Create.

10 Review the report.

1 In the Test Case Requirements section, click the link to trace to the
requirements document.

2 The Verify Result section contains details of the two assessments in the test,
and links to the simulation output.

See Also

Related Examples
• “Link Tests to Requirements” on page 1-2
• “Validate Requirements Links in a Model” (Simulink Requirements)
• “Customize Requirements Traceability Report for Model” (Simulink Requirements)

 See Also

9-5



Analyze a Model for Standards Compliance and Design Errors

Standards and Analysis Overview

During model development, check and analyze your model to increase confidence in its
quality. Check your model against standards such as MAAB style guidelines and high-
integrity system design guidelines such as DO-178 and ISO 26262. Analyze your model
for errors, dead logic, and conditions that violate required properties. Using the analysis
results, update your model and document exceptions. Report the results using
customizable templates.

Check Model for Style Guideline Violations and Design Errors

This example shows how to use the Model Advisor to check a cruise control model for
MathWorks® Automotive Advisory Board (MAAB) style guideline violations and design
errors. Select checks and run the analysis on the model. Iteratively debug issues using
the Model Advisor and rerun checks to verify that it is in compliance. After passing your
selected checks, report results.

Check Model for MAAB Style Guideline Violations

In Model Advisor, you can check that your model complies with MAAB modeling
guidelines.
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1 Create a copy of the project in a working folder. On the command line, enter

slVerificationCruiseStart
2 Open the model. On the command line, enter

open_system simulinkCruiseErrorAndStandardsExample
3 In the model window, select Analysis > Model Advisor > Model Advisor.
4 Click OK to choose simulinkCruiseErrorAndStandardsExample from the

System Hierarchy.
5 Check your model for MAAB style guideline violations using Simulink Check.

a In the left pane, in the By Product > Simulink Check > Modeling
Standards > MathWorks Automotive Advisory Board Checks folder,
select:

• Check for indexing in blocks
• Check for prohibited blocks in discrete controllers
• Check model diagnostic parameters

b Right-click the MathWorks Automotive Advisory Board Checks node, and
then select Run Selected Checks.

c Click Check model diagnostic parameters to review the configuration
parameter settings that violate MAAB style guidelines.

d In the right pane, click the parameter links to update the values in the
Configuration Parameters dialog box.

e To verify that your model passes, rerun the check. Repeat steps c and d, if
necessary, to reach compliance.

f To generate a results report of the Simulink Check checks, select the
MathWorks Automotive Advisory Board Checks node, and then, in the
right pane click Generate Report....

Check Model for Design Errors

While in Model Advisor, you can also check your model for hidden design errors using
Simulink Design Verifier.

1 In the left pane, in the By Product > Simulink Design Verifier folder, select
Design Error Detection.
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2 In the right pane, click Run Selected Checks.
3 After the analysis is complete, expand the Design Error Detection folder, then

select checks to review warnings or errors.
4 In the right pane, click Simulink Design Verifier Results Summary. The dialog

box provides tools to help you diagnose errors and warnings in your model.

a Review the results on the model. Click Highlight analysis results on model.
Click the Compute target speed subsystem, outlined in red. The Simulink
Design Verifier Results Inspector window provides derived ranges that can help
you understand the source of an error by identifying the possible signal values.

b Review the harness model. The Simulink Design Verifier Results Inspector
window displays information that an overflow error occurred. To see the test
cases that demonstrate the errors, click View test case.

c Review the analysis report. In the Simulink Design Verifier Results Inspector
window, click Back to summary. To see a detailed analysis report, click HTML
or PDF.

See Also

Related Examples
• “Check for Compliance Using the Model Advisor and Edit-Time Checking”

(Simulink Check)
• “Collect Model Metrics Using the Model Advisor” (Simulink Check)
• “Run a Design Error Detection Analysis” (Simulink Design Verifier)
• “Prove Properties in a Model” (Simulink Design Verifier)
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Perform Functional Testing and Analyze Test Coverage

Functional Testing and Coverage Analysis Overview

Functional testing starts with building test cases based on requirements. These tests can
cover key aspects of your design and verify that individual model components meet
requirements. Test cases include inputs, expected outputs, and acceptance criteria.

By collecting individual test cases within test suites, you can run functional tests
systematically. To check for regression, add baseline criteria to the test cases and test the
model regularly. Coverage measurement reflects the extent to which these tests have
fully exercised the model. Coverage measurement also helps you to add tests and
requirements to meet coverage targets.

Incrementally Increase Test Coverage Using Test Case Generation

This example shows a functional testing-based testing workflow for a cruise control
model. You start with a model that has tests linked to an external requirements
document, analyze the model for coverage in Simulink Coverage, incrementally increase
coverage with Simulink Design Verifier, and report the results.

 Perform Functional Testing and Analyze Test Coverage

9-9



Explore the Test Harness and the Model

1 Create a copy of the project in a working folder. At the command line, enter:

slVerificationCruiseStart
2 Open the model and the test harness. At the command line, enter:

open_system simulinkCruiseAddReqExample
sltest.harness.open('simulinkCruiseAddReqExample','SafetyTest_Harness1')

3 Load the test suite from “Test Model Against Requirements and Report Results” on
page 9-2. At the command line, enter:

open slReqTests.mldatx
4 Open the test sequence block. The sequence tests:

• That the system disengages when the brake pedal is pressed
• That the system disengages when the speed exceeds a limit

Some test sequence steps are linked to a requirements document
simulinkCruiseChartReqs.docx.

Measure Model Coverage

1 In the test manager, enable coverage collection for the test case.

a Open the test manager. In the Simulink menu, click Analysis > Test Manager.
b In the Test Browser, click the slReqTests test file.
c Expand Coverage Settings.
d Under COVERAGE TO COLLECT, select Record coverage for referenced

models.
e Under COVERAGE METRICS, select Decision, Condition, and MCDC.

9 Verification and Validation

9-10



2 Run the test. On the test manager toolstrip, click Run.
3 When the test finishes, in the Test Manager, navigate to the test case. The

aggregated coverage results show that the example model achieves 50% decision
coverage, 41% condition coverage, and 25% MCDC coverage.
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Generate Tests to Increase Model Coverage

1 Use Simulink Design Verifier to generate additional tests to increase model
coverage. Select the test case in the Results and Artifacts and open the aggregated
coverage results section.

2 Select the test results from the previous section and then click Add Tests for
Missing Coverage.

The Add Tests for Missing Coverage options open.
3 Under Harness, choose Create a new harness.
4 Click OK to add tests to the test suite using Simulink Design Verifier.
5 Run the updated test suite. On the test manager toolstrip, click Run. The test

results include coverage for the combined test case inputs, achieving increased model
coverage.

See Also

Related Examples
• “Link Tests to Requirements” on page 1-2
• “Assess Simulation Using Logical Statements” on page 3-32
• “Test Model Output Against a Baseline” on page 6-9
• “Highlight Functional Dependencies” (Simulink Design Verifier)
• “Generate Test Cases for Model Decision Coverage” (Simulink Design Verifier)
• “Extend Model Coverage of a Test Case”
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Analyze Code and Test Software-in-the-Loop

Code Analysis and Testing Software-in-the-Loop Overview

Analyze code to detect errors, check standards compliance, and evaluate key metrics such
as length and cyclomatic complexity. Typically for handwritten code, you check for run-
time errors with static code analysis and run test cases that evaluate the code against
requirements and evaluate code coverage. Based on the results, refine the code and add
tests. For generated code, demonstrate that code execution produces equivalent results to
the model by using the same test cases and baseline results. Compare the code coverage
to the model coverage. Based on test results, add tests and modify the model to
regenerate code.

Analyze Code for Defects, Metrics, and MISRA C:2012

This workflow describes how to check if your model produces MISRA® C:2012 compliant
code and how to check your generated code for code metrics, code defects, and MISRA
compliance. To produce more MISRA compliant code from your model, you use the code
generation and model advisors. To check whether the code is MISRA compliant, you use
the Polyspace MISRA C:2012 checker and report generation capabilities. For this
example, you use the model simulinkCruiseErrorAndStandardsExample. To open
the model:

1 Open the Simulink project:

slVerificationCruiseStart
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2 From the Simulink project, open the model
simulinkCruiseErrorAndStandardsExample.

Run Code Generator Checks

Before you generate code from your model, there are steps that you can take to generate
code more compliant with MISRA C and more compatible with Polyspace. This example
shows how to use the Code Generation Advisor to check your model before generating
code.

1 Right-click Compute target speed and select C/C++ > Code Generation Advisor.
2 Select the Code Generation Advisor folder. Add the Polyspace objective. The MISRA

C:2012 guidelines objective is already selected.
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3 Click Run Selected Checks.

The Code Generation Advisor checks whether there are any blocks or configuration
settings that are not recommended for MISRA C:2012 compliance and Polyspace
code analysis. For this mode, the check for incompatible blocks passes, but there are
some configuration settings that are incompatible with MISRA compliance and
Polyspace checking.

4 Click on check that was not passed. Accept the parameter changes by selecting
Modify Parameters.

5 Rerun the check by selecting Run This Check.

For your own model, you might not want to use all the recommended configuration
settings. Using nonrecommended settings can generate less MISRA compliant code.

Run Model Advisor Checks

Before you generate code from your model, there are steps you can take to generate code
more compliant with MISRA C and more compatible with Polyspace. This example shows
you how to use the Model Advisor to check your model further before generating code.
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For more checking before generating code, you can also run the Modeling Guidelines for
MISRA C:2012.

1 At the bottom of the Code Generation Advisor window, select Model Advisor.
2 Under the By Task folder, select the Modeling Guidelines for MISRA C:2012

advisor checks.

3 Click Run Selected Checks and review the results.
4 If any of the tasks fail, make the suggested modifications and rerun the checks until

the MISRA modeling guidelines pass.

For your own model, you might not want to use all the recommendations. Using
nonrecommended settings or blocks can generate less MISRA compliant code.

Generate and Analyze Code

After you have done the model compliance checking, you can now generate code. With
Polyspace, you can check your code for compliance with MISRA C:2012 and generate
reports to demonstrate compliance with MISRA C:2012.
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1 In the Simulink editor, right-click Compute target speed and select C/C++ > Build
This Subsystem.

2 Use the default settings for the tunable parameters and select Build.
3 After the code is generated, right-click Compute target speed and select Polyspace

> Options.

4 Click the Configure (Polyspace Bug Finder) button. This option allows you to
choose more advanced Polyspace analysis options in the Polyspace configuration
window.
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5 On the same pane, select Calculate Code Metrics. This option turns on code
metric calculations for your generated code.

6 Save and close the Polyspace configuration window.
7 From your model, right-click Compute target speed and select Polyspace > Verify

Code Generated For > Selected Subsystem.

Polyspace Bug Finder analyzes the generated code for a subset of MISRA checks and
defect checks. You can see the progress of the analysis in the MATLAB Command
Window. Once the analysis is finished, the Polyspace environment opens.

Review Results

After you run a Polyspace analysis of your generated code, the Polyspace environment
shows you the results of the static code analysis. There are 50 MISRA C:2012 coding rule
violations in your generated code.
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1 Expand the tree for rule 8.7 and click through the different results.

Rule 8.7 states that functions and objects should not be global if the function or
object is local. As you click through the 8.7 violations, you can see that these results
refer to variables that other components also use, such as CruiseOnOff. You can
annotate your code or your model to justify every result. But, because this model is a
unit in a larger program, you can also change the configuration of the analysis to
check only a subset of MISRA rules.

2 In your model, right-click Compute target speed and select Polyspace > Options.
3 Set the Settings from (Polyspace Bug Finder) option to Project configuration.

This option allow you to choose a subset of MISRA rules in the Polyspace
configuration.

4 Click the Configure button.
5 In the Polyspace Configuration window, on the Coding Rules & Code Metrics

pane, select the check box Check MISRA C:2012 and from the drop-down list, select

 Analyze Code and Test Software-in-the-Loop

9-19



single-unit-rules. Now, Polyspace checks only the MISRA C:2012 rules that are
applicable to a single unit.

6 Save and close the Polyspace configuration window.
7 Rerun the analysis with the new configuration.

When the Polyspace environment reopens, there are no MISRA results, only code
metric results. The rules Polyspace showed previously were found because the model
was analyzed by itself. When you limited the rules Polyspace checked to the single-
unit subset, no violations were found.
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When this model is integrated with its parent model, you can add the rest of the MISRA
C:2012 rules.

Generate Report

To demonstrate compliance with MISRA C:2012 and report on your generated code
metrics, you must export your results. This section shows you how to generate a report
after the analysis. If you want to generate a report every time you run an analysis, see
Generate report.

1 If they are not open already, open your results in the Polyspace environment.
2 From the toolbar, select Reporting > Run Report.
3 Select BugFinderSummary as your report type.
4 Click Run Report.

The report is saved in the same folder as your results.
5 To open the report, select Reporting > Open Report.

See Also

Related Examples
• “Analyze Generated Code Using Polyspace Bug Finder” (Polyspace Bug Finder)
• “Test Two Simulations for Equivalence”
• “Export Test Results and Generate Reports” on page 7-9
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Module Verification and Testing Processor-in-the-Loop

Module Verification and Testing Processor-in-the-Loop Overview

Module verification involves testing and analyzing code at a system level, integrating
generated code from your model, handwritten code, and legacy code. Module verification
often includes generating code that executes on a target object, rather than the desktop
environment. Analyze the code to resolve errors and evaluate key metrics. Test the
integrated system using new requirements-based tests and system-level tests from your
model. Collect coverage on these tests and add tests to meet coverage targets.

See Also

Related Examples
• “Test Two Simulations for Equivalence”
• “Analyze Generated Code Using Polyspace Bug Finder” (Polyspace Bug Finder)
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Test a Model in Real Time

Real-Time Testing and Testing Production Models Overview

Real-time testing assesses the system while including the effects of timers, physical
signals, and target hardware. Sweep through parameter values on the target, verify
system operation during execution, and verify expected results in the desktop
environment. Systems that have been verified on target hardware often exist in a
change-controlled state. You can test these systems without modifying them by using
isolated simulation and analysis environments.

See Also

Related Examples
• “Create and Run Real-Time Application from Simulink Model” (Simulink Real-

Time)
• “Test Models in Real Time” on page 8-2
• “Assess Simulation Using Logical Statements” on page 3-32
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